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Safety

This chapter contains:

NOICES AN SAFOLY .. et 12
ELECEMICAL SAFOLY ..ot 13
OPErAtiONAL SAFELY ... e e 15
MAINEENANCE SAFELY ... e e 17
PIINEET SYMIDOLS. . ...t 18
Environmental, Health, and Safety Contact Information............ccoouiiiiiiiii e 20

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements.
Attention to the following information ensures the continued safe operation of your Xerox printer.
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Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the
continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety
agency evaluation and certification, and compliance with electromagnetic regulations and established
environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials
only.

j’ Note: Unauthorized alterations, which can include the addition of new functions or connection of external
devices, can affect the product certification. For more information, contact your Xerox representative.
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Electrical Safety

GENERAL GUIDELINES

& Warning:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a
part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing optional
equipment and are instructed to do so. Power off the printer when performing these installations.
Disconnect the power cord when removing covers and guards for installing optional equipment. Except
for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.
If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

POWER CORD SAFETY INFORMATION

Carefully read the following instructions before operating your printer. For details, contact your Xerox representative.

A\ Warning:

e The electrical supply for the device must meet the requirements stated on the data plate on the rear
of the device. If you are not sure that your electrical supply meets the requirements, consult your local
electricity provider or a licensed electrician.

e Do not use an extension cord.

e Do not remove or modify the power cord.

Refer to these instructions to ensure the continued safe operation of your printer.
e Use the power cord supplied with your printer.

e Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is
connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
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e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground
connection terminal.

Warning: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

o Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the
electrical specification of the printer with an electrician if necessary.

e Do not place the printer in an area where people can step on the power cord.

e Do not place objects on the power cord.

e Replace the power cord if it becomes frayed or worn.

e Do not unplug or plug the power cord while the printer is turned on.

e To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.
e The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. For details, refer
to the User Guide.

EMERGENCY POWER OFF

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the
electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

e The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e Awall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

TELEPHONE LINE CORD

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency
examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

OPERATIONAL GUIDELINES

e Do not remove any paper trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the
protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the product. Power off the printer promptly and
contact your local Xerox representative.

e Ensure that the rear right cover is attached. Open this cover to connecting an interface cable.

OZONE RELEASE

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume.
Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-
ventilated room.

For more information in the United States and Canada, go to www.xerox.com/about-xerox/environment/enus.html.
In other markets, please contact your local Xerox representative or go to www.xerox.co.uk/about-xerox/
environment/engb.html.

PRINTER LOCATION

o Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the
weight for your printer configuration, refer to the User Guide.

e Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to
prevent overheating of the printer.

e Place the printer in an area where there is adequate space for operation and servicing.

e Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

» Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.

e Do not place the printer in locations susceptible to vibrations.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide 15


https://www.xerox.com/en-us/about/ehs
https://www.xerox.co.uk/en-gb/about/ehs
https://www.xerox.co.uk/en-gb/about/ehs

Safety

e For optimum performance, use the printer at the elevations specified in the User Guide.

PRINTER SUPPLIES

e Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a
possible safety hazard.

e Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
e Store all consumables in accordance with the instructions given on the package or container.

e Keep all consumables away from the reach of children.

e Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

e When handling cartridges, for example toner cartridges, avoid skin and eye contact. Eye contact with toner can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of
skin or eye contact.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service Agreement do
not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or
the use of Xerox supplies not specified for this printer.
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Maintenance Safety

Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with
your printer.

e Clean the device with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling
programs, go to www.xerox.com/recycling

& Warning: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on
electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can apply. Ensure
that you comply with all workspace safety regulations, building codes, and fire codes for your area.
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Safety

Printer Symbols

DESCRIPTION

w
=<
<
o
o
=

Warning:

Indicates a serious hazard that can result in death or serious injury if not
avoided.

Hot Warning:

Hot surface on or in the printer. Use caution to avoid personal injury.

Warning:

Moving parts. To avoid personal injury, use caution.

Caution:

T

Indicates a mandatory action to take in order to avoid damage to the
property.

Caution:

To avoid damage to the property, be careful not to spill toner when handling
the waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

DAV PB

1

o]
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SYMBOL DESCRIPTION
i' Do not use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.
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Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact in
the United States and Canada: 1-800-ASK-XEROX (1-800-275-9376).

For product safety information in the United States and Canada, go to www.xerox.com/about-xerox/environment/
enus.html.
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Parts of the Printer

FRONT VIEW

22
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Leveler Foot

Tray 5

Left Tray

USB Port
Document Cover
Document Glass

Power/Wake Button

10.
11.
12.
13.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide

Control Panel

Center Output Tray

Center Bottom Tray

Main Power Switch behind Front Door
Trays 1-4

Locking Casters



Getting Started

DUPLEX AUTOMATIC DOCUMENT FEEDER

5
1. Confirmation Indicator 5. Document Output Tray
2. Top Cover 6. Constant Velocity Transport (CVT) Glass
3. Document Guides 7. Document Glass
4. Document Feeder Tray
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Duplex Automatic Document Feeder Guidelines

The duplex automatic document feeder scans both sides of 2-sided documents at the same time. The confirmation
indicator illuminates when you load the original documents correctly. The duplex automatic document feeder
automatically detects standard paper sizes.

The duplex automatic document feeder accommodates the following paper sizes and weights:

e Original document weights: 38-128 g/m?=.

e Original document sizes: 85 x 125 mm (3.3 x 4.9 in.) through 297 x 432 mm (11.7 x 17 in.).

e Original document quantity: 130 sheets of 80 g/m? paper.

Follow these guidelines when loading original documents into the duplex automatic document feeder:
e Load original documents face up so that the top of the document enters the feeder first.

e Place only loose sheets of undamaged paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the original documents.

e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

e Do not load original documents above the MAX fill line.

Document Glass Guidelines

Lift the document feeder cover and place the first page face down in the upper-left corner of the document glass.
Align the original documents to the matching paper size printed on the edge of the glass.

e The document glass accepts paper sizes up to 297 x 432mm (11.7 x 17in.).
e The document glass automatically detects standard paper sizes.

Use the document glass rather than the duplex automatic document feeder to copy or scan the following types of
original documents:

e Paper with paper clips or staples attached

e Paper with wrinkles, curls, folds, tears, or notches

o Coated or carbonless paper or items other than paper, such as cloth or metal
e Envelopes

e Books

CONTROL PANEL

The control panel consists of a touch screen and buttons you press to control the functions available on the printer.
The control panel:

e Displays the current operating status of the printer.
o Provides access to print, copy, and scan features.
e Provides access to reference materials.

e Provides access to Tools and Setup menus.
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Prompts you to load paper, replace supplies, and clear jams.

Displays errors and warnings.

Provides the Power/Wake button used for powering on or off the printer. This button also supports the power-
saver modes, and blinks to indicate the power status of the printer.

a7 8
I I

5
ITEM NAME DESCRIPTION
1 NFC Area Near Field Communication (NFC), is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of each
other. Use the NFC area to obtain a network interface or to establish
a TCP/IP connection between your device and the printer.
2 Touch Screen Display The screen displays information and provides access to printer

functions.

Home Button

This button provides access to the Home menu for access to printer
features, such as copy, scan, and fax.

Power/Wake

This button serves several power-related functions.

e When the printer is powered off, this button powers on the
printer.

e When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep mode, restart, or power off the printer.

e When the printer is powered on, but in Sleep mode, pressing this
button wakes the printer.

e When the printer is powered on, holding this button for 10
seconds turns off the printer.

This button blinks to indicate the power status of the printer.

e When the light blinks slowly, the printer is in Sleep mode.
e When the light blinks rapidly, the printer is powering down.

Status LED

This light blinks blue or amber to indicate printer status.

Blue
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ITEM NAME DESCRIPTION
e Blinks blue once to acknowledge a successful Authentication
request.
e Blinks blue once slowly for a copy or print job initiated at the
control panel.
e Blinks blue twice slowly for fax or print job received from the
network.
e Blinks blue rapidly while the printer is powering up, or to signal
detection of a Wi-Fi Direct connection request.
Amber
e Blinks amber to indicate an error condition or warning that
requires your attention. For example, an out-of-toner condition, a
paper jam, or out of paper for the current job.
e Blinks amber to indicate a system error, which typically is
associated with an error code.
6 Notification Area Notifications are displayed above the Apps area. To view the full
notification, touch the notification area. After you have reviewed the
information, touch X.
7 Interrupt Button This button pauses the current job to run a more urgent job.
f Note: This option may be hidden from view. To enable
Interrupt, refer to the System Administrator Guide at www.
support.xerox.com.
8 Pause Button Use this button to pause the current job. The job pauses with the
option to resume printing or delete the job.
9 Language Button The Language button allows you to set the language that appears
temporarily on the control panel display.
f Note: This option may be hidden from view. For details, see
the System Administrator Guide at www.support.xerox.com.
10 Reset

f Note: Use the Reset button to reset all the apps to their
default settings.
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INTERNAL PARTS

1. Second Bias Transfer Roller

2.
3.
1.
5.
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REAR VIEW

1. Circuit Breaker 9. Ethernet Connection

2. Rear Right Cover 10. Foreign Device Interface (optional)
3. USB Memory Card Connections and SIM Slot 11.  Fax Connections (optional)

4. USB Port, Type A 12. Door D Release Lever

5. USB Port, Type B 13. Door A Release Lever

6. Status Indicator 14. Door B Release Lever

7. Side 2 Scan Cable 15. Door C Release Lever

8. Data Port, for service only

N

Note: Ensure that the rear right cover is attached. To connect an interface cable, open this cover.
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CONFIGURATIONS AND OPTIONS

1. Tray 6 - High Capacity Feeder 5. Trays 1 and 2

2. Work Surface 6. Trays 2-4 of the 3-Tray Module

3. Convenience Stapler 7. Trays 3 and 4 of the High-Capacity Tandem Tray
4. RFID Kit Module
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Finishing Options

Integrated Office Finisher

1. Staple Cartridge 4. Center Tray
2. Finisher Front Door 5. Integrated Office Finisher

3. Finisher Top Cover
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Office Finisher LX
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1. Front Transport Cover 8. Booklet Maker Staple Cartridge (optional)
2. Hole Punch Waste Container (optional) 9. Finisher Top Cover
3. Hole Punch Unit (optional) 10. Right Tray
4. Center Tray 11.  Creaser Unit (optional)
5. Right Tray Attachment 12. Staple Cartridge
6. Booklet Maker (optional) 13. Finisher Front Cover
7. Booklet Maker Side Cover (optional) 14. Office Finisher LX
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Business Ready Finisher with Optional Booklet Maker

1. Horizontal Transport Unit
2. Finisher Front Cover

3. Right Top Tray

4. Right Middle Tray

32

Staple Cartridge
Booklet Maker Tray
Booklet Staple Unit

© N o U

Booklet Maker Unit
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Business Ready Finisher with Optional C/Z Folder
1 23

1. Folder Front Cover 3. Folder Bin

2. Folder Bin Release Button
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Paper Tray Options

Configuring Dedicated Paper Trays

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on the configuration.
e High-Capacity Trays are configured as Dedicated trays.

e Trays 3 and 4 in the Tandem Module, and High Capacity Tray 6 hold A4-size (210 x 297 mm), Letter-size (8.5 x
11in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper.

e High-Capacity Trays are designed to hold larger amounts of paper for fewer printing interruptions.

j’ Note: To configure tray settings, refer to the System Administrator Guide at www.support.xerox.com.

Configuring Trays 3 and 4 of the Tandem Tray Module

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to support the
paper in use.

If you are configuring the trays for the first time, configure them for the paper size that you need. If you change
the paper size, reconfigure the tray for the new paper size. For details on supported paper sizes, refer to Supported
Standard Paper Sizes.

To configure Trays 3 and 4 in the Tandem Tray Module:

j’ Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and 4
configurations. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove any paper from the tray.
2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper size.

3. To lock the paper guides into place, release the guide lock.

j’ Note: The paper guides lock into place only at the designated standard paper sizes.

Configuring Tray 6

Tray 6 is a dedicated High-Capacity Tray. You can configure Tray 6 to support the paper size that you need. For
details on supported paper sizes, refer to Supported Standard Paper Sizes.

To configure Tray 6:

j’ Note: Before you make any tray adjustments, compare the paper size to the current Tray 6 configuration. If
the paper size matches the tray configuration, no tray adjustment is needed.
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1. Remove the screw that holds the spacer plate at the back of the tray.

3. Place the tabs at the bottom of the spacer plate into the slots in the bottom of Tray 6 that correspond with the
paper size.

4. Slide down the top of the spacer plate to engage the peg on the back of the tray into the matching hole in the
spacer plate.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide 35



Getting Started

5. Install the screw to secure the spacer plate.

6.

7. On the top of the side gate, locate the pin.
8. Lift the pin, then guide it into the desired paper size in the slot.

9. To lock the side gate into place, release the pin.

N

%
==

Wireless Network Adapter

The wireless network adapter is a USB device that transfers data between the printer and a wireless local area
network (LAN). The wireless network adapter supports common wireless security protocols, such as WEP, WPA,
WPA2, and 802.1X standard port-based network access control.
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The wireless network adapter allows multiple users on a wireless LAN to print to and scan from Xerox® printers. The
wireless network adapter also supports printers that include network scan and fax features.
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Power Options

POWERING ON THE PRINTER OR EXITING SLEEP MODE

The printer has two power switches. The main power switch, located behind the front door, controls the main power
to the printer. The secondary power switch is the Power/Wake button on the control panel. The Power/Wake button
controls power to the printer electronic components, and when powered off, initiates a software-controlled
shutdown procedure. The preferred method to power on and off the printer is to use the Power/Wake button.

e To power on the printer, open the front door, then power on the main power switch. On the control panel, press
the Power/Wake button.

e To enter Sleep mode, press the Power/Wake button.

f Note:

e When in Sleep mode, the touch screen and scanner are powered off and unresponsive during a print job
execution. To wake the printer manually, press the Power/Wake button.

e If Auto Power Off is enabled, the printer powers off automatically after the specified conditions are met.
To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.support.xerox.com.

@ Caution: Do not plug or unplug the power cord while the printer is powered on.

RESTARTING, PLACING IN SLEEP MODE, OR POWERING OFF THE PRINTER

To restart the printer, place the printer in Sleep Mode, or power off the printer:
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1. At the printer control panel, press the Power/Wake button.

2. Select an option.
e To restart the printer, touch Restart.
e To place the printer in Sleep Mode, touch Sleep.
In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.
e To power off the printer, touch Power Off.

e If the printer does not respond to a single press of the Power/Wake button, then press and hold the button
for 5 seconds. A Please Wait message appears as the printer powers down.

After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer powers
down.

3. If you are powering off the printer for an extended period, open the printer front door, then power off the main
power switch.

® Caution: Do not unplug the power cord while the printer powers down.
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Accessing the Printer

AUTHENTICATION

Authentication is the process of confirming your identity. When the system administrator enables authentication,
the printer compares the information that you provide to another source of information, such as an LDAP directory.
The information can be a user name and password, or the information stored on a magnetic, proximity, RFID, or
smart card. If the information is valid, you are considered an authenticated user.

There are several ways to authenticate a user:

e User Name/Password - Validate on the Device: This option enables local authentication. Users prove their
identity by typing a user name and password at the control panel or in the Embedded Web Server. The printer
compares the user credentials to the information stored in the user database. If there are a limited number of
users, or you do not have access to an authentication server, use this authentication method.

e User Name/Password - Validate on the Network: This option enables network authentication. Users prove
their identity by typing a user name and password at the control panel or in the Embedded Web Server. The
printer compares the user credentials to the information stored on an authentication server.

o Convenience Authentication: If this option is enabled, a card with a magnetic strip or a Radio Frequency
Identification (RFID) card is used. A convenience authentication card is different from a Smart Card, which uses
an embedded chip and typically requires a login and password. If the optional integrated RFID reader is
installed, for authentication, users place a pre-programmed card over the RFID reader at the control panel.

e Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox Secure Access
Unified ID System. Users present a pre-programmed identification card to a card reader at the control panel.
The printer compares the user credentials to the information stored on the Xerox® Secure Access server.

¢ Smart Cards: This option enables authentication for a Smart Card Reader. Users insert a pre-programmed
identification card in a card reader at the control panel.

j’ Note: The system administrator can allow you to type your user name and password when Convenience
Authentication or Smart Card is the primary authentication method. If the administrator configures an
alternative authentication method, and you misplace your card, you can still access the printer.

For information about configuring Authentication settings, refer to the System Administrator Guide at www.support.
Xerox.com.

AUTHORIZATION

Authorization is the function of specifying the features that users are allowed to access, and the process of
approving or disapproving access. You can configure the printer to allow users to access the printer, but restrict
access to certain features, tools, and apps. For example, you can allow users to access copying but restrict access to
scanning. You can also control access to features at specific times of the day. For example, you can restrict a group
of users from printing during peak business hours.

There are two types of authorization:

e Local Authorization verifies user information on the printer to approve access.

o Network Authorization verifies user information stored externally in a network database, such as an LDAP
directory, to approve access.
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For information about configuring Authorization settings, refer to the System Administrator Guide at www.support.
Xerox.com.

PERSONALIZATION

Personalization is the process of customizing apps for a specific user. When a user logs in to the device and
personalized information is required, the device searches an LDAP directory for the information. Personalized
information examples are a Home destination or email address. The device uses the personalized information to
complete the task.

For information about configuring settings, refer to the System Administrator Guide at www.support.xerox.com.

ACCOUNTING

Accounting is used to track and record the numbers of Copy, Print, Workflow Scanning, Server Fax, and Fax jobs that
the device produces for each user. The system administrator must create user accounts and enable the accounting
feature. After Accounting is enabled, log in to the printer to access restricted apps. Before printing documents from
a computer, provide your account details in the print driver.

The system administrator can set limits to restrict the total number of jobs by type that a user can send to the
printer. The administrator can generate reports listing usage data for individual users and groups.

For details, refer to the System Administrator Guide at www.support.xerox.com.

LOGGING IN

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to
access printer features, you log in with your user credentials.

Logging In at the Control Panel

& Note:
e Before logging in for the first time at the Xerox device control panel, log in to the Embedded Web Server,
then update your password. For details, refer to Logging In Using the Embedded Web Server.
e If you do not know your user name or password, contact your system administrator.
1. At the printer control panel, press the Home button.
Touch Log In.

For User Name, use the keypad and enter your name, then touch Next.

S

If prompted, enter the password, then touch Done.

j’ Note: To access each app that is password-protected, repeat steps 3 and 4.
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Introduction to Xerox® Apps

Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
WWW.SUPPOTt.Xerox.com.

A range of Apps are available for download and installation from the Xerox ® App Gallery. These include Xerox
®Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox ® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and font
information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

NAME DESCRIPTION

Configuration Report The Configuration Report provides printer information
including the serial number, installed options, network
settings, port setup, tray information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

CONFIGURATION REPORT

The Configuration Report provides product information including installed options, network settings, port setup, tray
information, and more.

Printing the Configuration Report
1. At the printer control panel, press the Home button.
Touch Device > Information Pages.

Touch Configuration Report, then touch Print.

s owWN

To return to the Home screen, press the Home button.
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The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:
e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ACCESSING THE EMBEDDED WEB SERVER

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or
Return.

To use the Embedded Web Server, click the page required:

e Home: This page provides a description of the printer and current notifications, the status of the paper trays,
and supplies and billing information. There is a Quick Links area at the bottom of the page that provides direct
access to key functions and pages.

e Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete saved jobs, and
create and manage saved job folders.

e Print: This page enables you to submit print-ready files to the printer for printing. You can select options for
print jobs using this page. Only print-ready files can be submitted, for example PDF, PS, PCL, and XPS file
formats.

e Scan: The Scan page enables you to create distribution workflows and mailboxes for scanned documents.

e Address Book: Use the Address Book page to create a Device Address Book containing contacts for use with
the fax, email, and scanning apps. You can configure the printer to use a Network Address book that looks up
addresses from an LDAP directory. The printer can also be configured to use a Network Address Book, which
looks up addresses from an LDAP directory. If both the Address Book and Device Address Book are configured,
users are presented with a choice when they use a compatible app.

e Properties: You can use the Properties tab to access and configure settings for your device. System
administrator login credentials are required to change most settings.

e Support: This page provides access to general support information and telephone numbers. You can use the
Support page to access the Remote Control Panel and send diagnostic information to Xerox.

The Embedded Web Server has a Help option that provides information about all available device features and
functions. To access Help, click the Help link displayed at the bottom of each page. Navigate to the topic required,
or use the Search function to find specific information.

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer to the System
Administrator Guide at www.support.xerox.com.
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LOGGING IN USING THE EMBEDDED WEB SERVER

To access certain features, tools, and apps, log in to the Embedded Web Server for your device.

j’ Note: Access to some restricted functions requires administrator rights. For more information, refer to the
System Administrator Guide atwww.support.xerox.com.

To log in to the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe top right area of the page, click Login.

3. Enter your User ID and password, then click Login.

4. If you are logging in for the first time, set up a password.
Type the old password.

a
b. Type anew password. To verify the password, retype it.

j’ Note: The new password must adhere to all minimum password requirements. For details, contact your
system administrator, or refer to the System Administrator Guide atwww.support.xerox.com.

c. Click Save. The new password is stored.

FINDING THE IP ADDRESS OF YOUR PRINTER

To install the print driver for a network-connected printer, it is often necessary to know the IP address of your
printer. Also, the IP address is used to access the settings of your printer through the Embedded Web Server. You
can view the IP address of your printer on the control panel or on the Configuration Report.

j’ Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If
the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity issue. However, if Wi-Fi
is set as the primary Ethernet connection, 0.0.0.0 is displayed as the IP address for the printer.

Viewing the IP Printer Address on the Control Panel
To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
Touch Device > About.

Record the IP address from the display.

&N

To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from the Configuration Report
To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.
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3. Touch Configuration Report.
The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPvé.

4, To return to the Home screen, press the Home button.

DOWNLOADING THE CONFIGURATION REPORT FROM THE EMBEDDED WEB SERVER

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer
hard drive. Use Configuration Reports from multiple devices to compare software versions, configurations, and
compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. To download the Configuration Report, scroll to the bottom of the page. In the Quick Links section, click
Download Configuration Report.

j’ Note: If the Download Configuration Report feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard
drive. To open the Configuration Report, use an XML viewer.
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Installation and Setup
For reference:
e Installation Guide packaged with your printer

e Online Support Assistant at www.support.xerox.com

INSTALLATION AND SETUP OVERVIEW

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure
the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet
cable or wireless connection. Hardware and cabling requirements vary for the different connection methods.
Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer
and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a
USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.support.xerox.com.

SELECTING A LOCATION FOR THE PRINTER

1. Select a dust-free area with temperatures from 10-28°C (50-83°F), and relative humidity 15-85%.

j’ Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause
condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the
printer. The printer must be horizontal with all four castors in solid contact with the surface. To find the weight
for your printer configuration, refer to Physical Specifications. Select a location with adequate clearance to
access supplies and to provide proper ventilation. To find the clearance requirements for your printer, refer to
Clearance Requirements.

3. After positioning the printer, you are ready to connect it to the power source and computer or network.
CONNECTING THE PRINTER

Connecting to a Wired Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for
one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides
direct access to printer settings using the Embedded Web Server.

To connect the printer:
1. Connect the power cord to the printer, then plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the printer.
Connect the other end of the cable to a correctly-configured network port.

3. Power on the printer.

For details on configuring connection settings, refer to the System Administrator Guide at www.support.xerox.com.
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Connecting to a Wireless Network

If you have purchased the Wireless Network Adapter, you can use the Wireless Wizard to connect the device to a

wireless network. If the device is connected to a wired network, you can configure wireless settings in the
Embedded Web Server.

f Note:

e For more information, refer to the Xerox® Wireless Network Adapter Kit Hardware Install and Setup
instructions that are included with the kit.

e The device uses either the wireless or the wired network connection. Activating one network connection
deactivates the other network connection.

For details on configuring wireless network settings, refer to the System Administrator Guide at www.support.xerox.
com.

Connecting with Wi-Fi Direct

You can connect to your printer from any Wi-Fi-enabled mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct or Soft AP features. The Wi-Fi Direct feature is disabled by default on the Xerox device.

j’ Note: The Wi-Fi Direct feature is available only on printers with the optional Wireless Network Adapter
installed. After you install the Wireless Network Adapter, the Wi-Fi Direct feature is enabled by default.

Wi-Fi Direct Overview

The Wi-Fi Direct feature allows you to print from a mobile device to your printer, using one of the following
methods.

e WPS push button, for Wi-Fi Direct-enabled Android devices with the Mopria print plug-in installed.
e Soft Access Point (AP), for Apple iPhones and other mobile devices that do not support the Wi-Fi Direct function.

For information about using the Wi-Fi Direct feature on your mobile device, or connecting to the printer using the
Soft AP feature, refer the mobile device documentation from the manufacturer.

For information about configuring the Wi-Fi Direct feature on your printer, refer to the System Administrator Guide
at www.support.xerox.com.

Using Wi-Fi Direct on Your Mobile Device

The Wi-Fi Direct WPS Push Button feature requires the Mopria Print Service App installed on your mobile device. The
printer does not require a wireless connection.

Installing Mopria Print Service

1. On your mobile device, go to the Google Play Store, then search for Mopria Print Service.
Install the Mopria Print Service App.

Go to Settings, then touch Printing.

Go to the notification area, then touch Mopria Print Service.

To enable Mopria Print Service, touch On.

o v &~ W N

Exit Settings.
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Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device.

Using Wi-Fi Direct on your Printer

Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct feature is
enabled by default when the Wi-Fi hardware is installed.

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact your System
Administrator to connect your printer to a wired or wireless network.

Printing Using Wi-Fi Direct

To print a document from a Wi-Fi-enabled mobile device:

1. On the mobile device, open the document that you want to print.

In the device application, select the Print button.

If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer from the list.

Select the print settings required for the job.
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Submit the job for printing.
A message appears on the mobile device.
6. Select Connect.
When the connection is made, a message appears on the printer.
7. At the printer control panel, touch OK.

The job prints.

Connecting to a Computer Using USB
Ensure that you have one of the following operating systems installed on your computer.

e Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, Windows Server 2012,
Windows Server 2016, and Windows Server 2019.

e macOS 10.14 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.
To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, cancel it.

4. Install the print driver.

For more information, refer to Installing the Print Driver Software.
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Connecting with Near Field Communication (NFC)

NFC Overview

when they are in close range. NFC allows you to add a printer to your Android mobile
device easily. After you add the printer, there is no need to use NFC on that printer. You
can use NFC to obtain the network interface to establish a TCP/IP connection between
your device and the printer.

ff@ Near field communication (NFC) is a technology that enables devices to communicate

Devices can communicate using NFC when they are within the following ranges:
e Device with case: 17-20 mm (0.7 x 0.8 in.)

e Device without case: 20-25 mm (0.8 x 1 in.)

f Note: The range can vary depending on the device manufacturer. For information about the required
settings for individual mobile devices, refer the documentation supplied by the manufacturer of your mobile
device.

For details about configuring NFC on your printer, refer to the System Administrator Guide at www.support.xerox.
com.

Using NFC on your Mobile Device
The NFC feature requires installation of the Xerox Print Service app on the mobile device.

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not need to have
a wireless connection.

f Note: NFC supports Android 4.4 or greater devices.

Installing the Xerox Print Service Plugin

1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin.
Install the Xerox Print Service Plugin app.

Go to Settings, then touch Printing.

Go to the notification pull-down bar, then touch Xerox Print Service.

To enable Xerox Print Service, touch On.

o v &~ W N

Exit Settings.

Enabling NFC on the Mobile Device

Most mobile devices have NFC disabled by default.
To enable NFC:

1. Go to Settings.

2. Go to the NFC setting, then touch On.

3. Exit Settings.
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Using NFC on your Printer

The NFC chip is on the bottom right of the control panel. When NFC is enabled, the NFC icon is lighted, and you
can use the NFC function.

cee e @

Refer to your mobile device user documentation for the mobile device NFC chip location.

f Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the System
Administrator Guide at www.support.xerox.com.

Mapping the Printer to your Mobile Device

1. Open the Xerox Print Service Plugin.

At the top right side of the screen, touch the selection button, then select Add Printer.
Touch the NFC option.
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Hold the mobile device over the NFC icon on the control panel.

|
e 1
SN
The mobile device and the printer communicate with each other. The mobile device searches the network for the
printer. When the printer is located, it is added to the list as a mapped printer.

You can submit print jobs from your mobile device to the printer.

Printing using Mopria

1. Open the document that you want to print.

At the top of the screen, select the Print button.

If there is more than one printer mapped for use with NFC, select the printer required.

Select the print settings required for the job.

voBw N

Submit the job for printing.
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Configuring AirPrint

AirPrint is a software feature that allows you to print documents from Apple iOS-based mobile devices and Mac OS-
based devices without a print driver. AirPrint-enabled printers allow you to print or fax directly from a Mac or from
an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired or wireless device directly without using a
print driver. You can also use AirPrint to scan from a printer to supported Apple devices.

AirPrint

f Note:

e Not all applications support AirPrint.
e When AirPrint is enabled, HTTP, IPP, and Multicast DNS are enabled automatically.
e [PPenablement requires a Web server reset.

e The device that submits the AirPrint job must be on the same subnet as the printer. To allow devices to
print from different subnets, configure your network to pass multicast DNS traffic across subnets.

e Supported mobile devices: all models of iPad, iPhone 3GS or later, and iPod touch third generation or
later, running the latest version of iOS.

e If AirPrint is not available on your device, contact your Xerox representative.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Inthe Embedded Web Server, click Properties > Connectivity > Setup.

j’ Note: If this feature does not appear, log in as a system administrator. For details, refer to the System
Administrator Guide at www.support.xerox.com.

3. For Mobile Workflows, for AirPrint, click Edit.
4. Configure HTTP, IPP, and Multicast DNS Registration as required. To configure a protocol, click Edit.
5. To enable AirPrint, for Enablement, select one or both options:

e Allow Printing/Faxing to be initiated From AirPrint Supported Devices

e Allow Scanning to be initiated From AirPrint (or Mopria) Supported Devices
& Note:

e AirPrint Faxing is supported only on devices that have embedded fax enabled and are configured to
allow sending.

e AirPrint Printing/Faxing is enabled by default.
e To require authentication for AirPrint Printing and Faxing, configure IPP authentication.

e Enabling scanning for AirPrint also enables scanning for Mopria.
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6. For Require Authentication for Scanning, select an option:
e Off: This option allows the device to scan without requiring authentication.

e HTTP Basic: This option authenticates with user accounts that are configured in the device user database
or in the network database.

f Note: HTTP Basic sends user login credentials as plain, unencrypted text over HTTP. To send encrypted login
credentials, use HTTPS.

e HTTP Digest: This option authenticates with user accounts that are configured in the device user database.
7. If you selected HTTP Basic authentication, for Validation Location, select an option:

e Validation on the Device: This option enables IPP authentication of user accounts that are configured in
the device user database.

e Validation on the Network: This option enables IPP authentication of user accounts that are configured
on the network authentication server for the device.

f Note: The same network authentication configuration is used on the printer for each login method that is
configured for Network Authentication.

8. To edit the device name or location, for Device Name, Device Location, or Geographic Location, click Edit.
j’ Note: Providing a device name can help users identify the device.

9. Click Save.

For additional information about AirPrint configuration and settings, refer to the System Administrator Guide at
www.support.xerox.com.

Configuring Google Cloud Print

Google Cloud Print allows you to print documents from an Internet-connected device without using a print driver.
Documents stored in the cloud, a personal computer, tablet, or smartphone can be sent to the printer from
anywhere.

For more information on Google Cloud Print, including procedures for managing accounts, sharing printers, and
printing, refer to the Google Cloud Print Help Center.

Before you begin:

e Set up a Google email account.

e Configure the printer to use IPv4.

e Configure Proxy Server settings as needed.
To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
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2.

In the Embedded Web Server, click Properties > Connectivity > Setup.

j’ Note: If this feature does not appear, log in as a system administrator. For details, refer to the System

3.
4,
5.

Administrator Guide at www.support.xerox.com.
For Mobile Workflows, for Google Cloud Print Service, click Edit.
For Status, for Registration Status, click Register Printer. The Printer Registration Options page opens.

To give the printer a user-friendly name, click Edit.

j’ Note: Xerox recommends that you choose a user-friendly name that includes the printer location and

department.
Click Continue to Register. The Options for Registering Your Printer page opens.
To change enablement settings, for Enablement, select options as needed.

Click Register Printer. The Google Cloud Print Service page reappears with a link that allows you to complete
the device registration.

j’ Note: If printer registration does not continue, to troubleshoot the problem, refer to the System

9.

Administrator Guide at www.support.xerox.com.

Within 15 minutes, click the link for Enabled - Finish device registration. The Google Cloud Print Printer
confirmation page opens in a new browser tab.

¢ Note:

10.

11.

e If prompted, log in to your Google account.
e If you do not click the link within 15 minutes, begin the registration process again.

Click Finish printer registration. A message confirms that the printer is registered. The Cloud Printer is now
ready to print.

To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

j’ Note: The default printer name appears in this format: Model name (MAC address).

For additional information about Google Cloud Print configuration and settings, refer to the System Administrator
Guide at www.support.xerox.com.

Connecting to a Telephone Line

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

54

Ensure that the printer is powered off.

Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the back of
the printer.

Connect the other end of the RJ11 cable to an operating telephone line.
Power on the printer.

Enable and configure the Fax functions.
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OPTIMIZING PRINTER PERFORMANCE

Several factors influence printer performance, including temperature, humidity, air pressure, and the chemical
characteristics of the paper and coatings. The printer must form an electrostatic image on the paper, which
depends on the ability of the air to hold and transfer electrical charges. The paper and coatings must hold an
electrical charge in the areas where the toner must adhere.

To optimize the performance of your printer:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Tools.

Touch Troubleshooting > Calibration > Print Calibration > Next.
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Follow the onscreen instructions to run the Print Calibration procedure.

INITIAL PRINTER SETUP

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling the optional
features and assigning an IP address for the Ethernet network connection. Printer settings can be configured at the
printer control panel or by using the Embedded Web Server. To configure settings at the printer control panel, the
Installation wizard starts the first time that you power on the printer. The wizard prompts you with a series of
questions to help configure basic printer settings.

The System Administrator can configure the following settings:
e language

e Network Connection

e Proxy Server Setup

¢ Date and Time

e Measurements

o | DAP Settings

e Apps Setup

e Security Settings

For more information on configuring the printer settings at the control panel or using the Embedded Web Server,
refer to the System Administrator Guide at www.support.xerox.com.

UPDATING THE PRINTER SYSTEM SOFTWARE

Before installing print driver software, verify that the printer has the latest version of system software loaded. You
can update your device when Xerox releases a new version of printer system software or firmware. To ensure a
successful software update, follow the steps provided with the software files. Printer system software is downloaded
from www.support.xerox.com.

Before you download and install new software, determine the current software version installed on your device.
Print the Configuration Report to compare the system software version with the version available for download. For
instructions about printing a Configuration Report, refer to Printing the Configuration Report.
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Follow the instructions provided with the software to download the files and upgrade your device. You can configure
the device to connect routinely to an FTP directory on your network to update device software automatically. You
can also update the device software manually. For more information about updating system operating software,
refer to the System Administrator Guide at www.support.xerox.com.

INSTALLING THE PRINT DRIVER SOFTWARE

Before installing print driver software, verify that the printer is plugged in, turned on, connected correctly, and has a
valid IP address. If you cannot find the IP address, refer to Finding the IP Address of Your Printer.

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/support/
drivers.

Operating System Requirements

e  Windows 7, Windows 8, Windows 8.1, Windows Server 2008 R2, Windows 10, Windows Server 2012, Windows
Server 2016, and Windows Server 2019.

e macOS version 10.14 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

j’ Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
WWW.XErox.com.

2. Click Xerox Smart Start — Driver Installer (Recommended).
3. At the License Agreement, click Agree.

4. From the list of discovered printers, select your printer.

j’ Note: When you install print drivers for a network printer, if your printer does not appear in the list, click
Don’t See Your Printer?, then enter the IP address for your printer. To install the recommended print driver,
click Continue, then select Install.

5. Click Quick Install.
A message appears that confirms that the installation is successful.

6. To complete the installation and close the Installer window, click Done.

Installing the Windows Print Driver .zip File

You can download print drivers from Xerox.com in a .zip file, then use the Windows Add Printer Wizard to install the
print drivers on your computer.

To install the print driver from the zip file:
1. Download, then extract the required .zip file to a local directory on your computer.

2. At your computer, open the Control Panel, then select Devices and Printers > Add a Printer.
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3. Click The printer that I want isn't listed, then click Add a local printer or network printer with manual
settings.

4. To use a previously established port, select Use an existing port, then from the list, select a Standard TCP/IP
Port.

5. To create a Standard TCP/IP port:
a. Select Create a New Port.
b. For Type of port, select Standard TCP/IP Port, then click Next.
¢. Inthe Hostname or IP address field, type the printer IP address or host name.

d. To disable the feature, clear the check box for Query the printer and automatically select the driver to
use, then click Next.

Click Have Disk.
Click Browse. Browse to, then select the driver.inf file for your printer. Click Open.

Select your printer model, then click Next.
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If a prompt appears because the print driver was installed previously, click Use the driver that is currently
installed (recommended).

10. In the Printer name field, type a name for your printer.
11.  To install the print driver, click Next.

12.  If needed, set the printer as the default printer.
j’ Note: Before you select Share Printer, contact your system administrator.

13. To send a test page to the printer, click Print a test page.
14.  Click Finish.

Installing the Print Drivers for a Windows USB Printer
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
Connect the A end of the USB cable to the USB port on the computer.

If the Windows Found New Hardware Wizard appears, click cancel.

&wN

Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

j’ Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
WWW.XETOX.COM.

5. Click Xerox Smart Start — Driver Installer (Recommended).

6. At the License Agreement, click Agree.

7. From the list of discovered printers, select your printer, then click Quick Install.
A message appears that confirms that the installation is successful.

8. To complete the installation and close the Installer window, click Done.
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Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allows a client to discover and access a remote device and its associated services
across a network. WSD supports device discovery, control, and use.

Installing a WSD Printer Using the Add Device Wizard
1. At your computer, click Start, then select Printers and Scanners.
2. To add the required printer, click Add a Printer or Scanner.

3. Inthe list of available devices, select the device that you want to use, then click Next.

j’ Note: If the printer that you want to use does not appear in the list, click Cancel. To add the printer
manually, use the IP address of the printer. For details, refer to Installing the Windows Print Driver .zip File.

4. Click Close.

Installing the Drivers and Utilities for MacOS

1. Download the latest print driver from www.support.xerox.com.

Open the Xerox® Print Drivers 5.xx.x.dmg or .pkg as needed for your printer.

To run Xerox® Print Drivers 5.xx.x.dmg or .pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click I Agree.
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To accept the current installation location, click Install, or select another location for the installation files, then
click Install.

7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
9. If your printer does not appear in the list of discovered printers:
a. Click the Network Printer Icon.
b. Type the IP address of your printer, then click Continue.
c.  Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB cable is
connected properly.

11.  To accept the print queue message, click OK.
12.  Select or clear the Set Printer as Default and Print a Test Page check boxes.

13. Click Continue, then click Close.

Adding the Printer for MacOS

For networking, set up your printer using Bonjour® (mDNS), or for an LPD, LPR connection, connect using the IP
address of your printer. For a non-network printer, create a desktop USB connection.

For more information, go to the Online Support Assistant at: www.support.xerox.com.
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Adding the Printer Using Bonjour
To add the printer using Bonjour®:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.
The list of printers appears on the left of the window.
3. For the list of printers, click the Plus icon (+).
4. At the top of the window, click the Default icon.

5. Select your printer from the list, then click Add.

j’ Note: If your printer is not detected, verify that the printer is powered on and that the Ethernet cable is
connected properly.

Adding the Printer by Specifying the IP Address

To add the printer by specifying the IP address:

1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.

The list of printers appears on the left of the window.

In the list of printers, click the Plus (+) icon.

Click IP.

From the Protocol list, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Use list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.

Click Add.
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Installing Print Drivers and Utilities for UNIX and Linux

For more information on installing print drivers and utilities for UNIX and Linux, refer to www.xerox.com/support/
drivers.
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More Information

You can obtain more information about your printer from these sources:

RESOURCE LOCATION

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer WWW.SUPPOrt.Xxerox.com

Recommended Media List United States: https://www.xerox.com/downloads/usa/
en/supplies/rml/AltaLink_C8030_C8035_C8045_
C8055_RML.pdf

European Union: https://www.xerox.com/downloads/
europe/r/2017_05_AltalLinkC8030-C8055_Media_List_
Antalis_Xerox_May_2017.pdf

Technical support information for your printer, WWW.SUPPOrt.xerox.com
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.
Order supplies for your printer www.xerox.com/supplies
A resource for tools and information, including www.xerox.com/businessresourcecenter

interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual needs.

Local sales and Technical Customer Support www.xerox.com/worldcontacts
Printer registration www.xerox.com/register
Xerox® Direct online store www.direct.xerox.com/

LOCATING THE SERIAL NUMBER

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print the Configuration Report. You can view the
serial number on the control panel or on the Embedded Web Server home page. The serial number is printed on a
label that is affixed to the printer. To view the label, open the left side door.

For details on how to print the Configuration Report, refer to Information Pages.
To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

60 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide


http://www.support.xerox.com/
https://www.xerox.com/downloads/usa/en/supplies/rml/AltaLink_C8030_C8035_C8045_C8055_RML.pdf
https://www.xerox.com/downloads/usa/en/supplies/rml/AltaLink_C8030_C8035_C8045_C8055_RML.pdf
https://www.xerox.com/downloads/usa/en/supplies/rml/AltaLink_C8030_C8035_C8045_C8055_RML.pdf
https://www.xerox.com/downloads/europe/r/2017_05_AltaLinkC8030-C8055_Media_List_Antalis_Xerox_May_2017.pdf
https://www.xerox.com/downloads/europe/r/2017_05_AltaLinkC8030-C8055_Media_List_Antalis_Xerox_May_2017.pdf
https://www.xerox.com/downloads/europe/r/2017_05_AltaLinkC8030-C8055_Media_List_Antalis_Xerox_May_2017.pdf
http://www.support.xerox.com/
https://www.xerox.co.uk/printer-supplies/
https://www.xerox.com/en-us/small-business/templates
https://www.xerox.com/perl-bin/world_contact.pl
https://www.onlineregister.com/xerox/wv2
http://www.direct.xerox.com

Getting Started

2. Touch Device.
3. Touch About.
The model, serial number, and software version is displayed.

4. To return to the Home screen, press the Home button.
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Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific demands
of your workflows.

. You can customize your apps, hide, or show apps on the Home screen, and rearrange the
.“’. order to suit your job priorities. For each app, you can hide or show individual features and
[T configure default settings to meet the needs of your workgroup. You can save job settings

for repeated use.

Customization enables users to work more productively.

You can create 1-Touch Apps to save and simplify lengthy or frequent workflows. Once
. created, 1-Touch Apps appear on the Home screen. To start a job, touch the app.

Personalization options ensure that the features and functions displayed meet individual
user needs, improving efficiency.
The customize and personalize settings are configured by a system administrator. For details, contact your system

administrator, or refer to the System Administrator Guide at www.support.xerox.com.

System administrators can use the Fleet Orchestrator feature to clone and install 1-Touch Apps on other devices.
For information about Cloning and using the Fleet Orchestrator feature, refer to the System Administrator Guide at
WWW.SUppOrt.xerox.com.
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Customizing or Personalizing the Home Screen

Using the customization options, you can show, hide, or change the display order of apps for the Home screen.

DISPLAYING OR HIDING AN APP ON THE HOME SCREEN

To display or hide an app on the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Touch Customize Home.
5. Todisplay an installed, but hidden app:
a. Touch the Plus (+) icon.
b. Touch the app that you want to appear on the control panel.
6. To hide an installed app:
a. For the required app, touch X.
b. Touch Hide.
7. Touch Done.

8. Verify that only the required apps appear on the Home screen.

REARRANGING APPS ON THE HOME SCREEN

To rearrange apps on the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Scroll to the bottom, then touch Customize.
Touch Customize Home.
Touch and hold the required app, then drag the app to the new location. Release the app.

Touch Done.

N o v =W

Verify that the apps appear in the correct location on the Home screen.
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DELETING AN APP FROM THE HOME SCREEN

To delete an app from the Home screen permanently:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Touch Customize Home.
5. To delete an installed app:

a. For the required app, touch X.

b. At the prompt, touch Delete.
j’ Note: Deletion is permanent. You cannot restore a deleted app.

6. Touch Done.

7. Verify that only the required apps appear on the Home screen.

REMOVING CUSTOMIZATION FROM THE HOME SCREEN

To remove customization from the Home screen:

L
& Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Select an option:

e Remove Home Customization: This option removes all customization from the Home screen.

(D Caution: The Remove Home Customization option removes customization from the Home screen, and
other customized device settings.

e Remove All Customizations: This option removes all customizations for the device.
j’ Note: This option can cause deletion of 1-Touch, EIP, Single Touch, and Weblet apps.

5. At the prompt, touch Remove.

Apps appear in the default location on the Home screen.

6. Touch Done.
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Customizing or Personalizing the Apps

The app customization options enable you to modify the features available, save app default settings, or remove
customized settings applied to an app.

You can customize the Copy, ID Card Copy, Email, Fax, and Scan To apps for your device.

CUSTOMIZING OR PERSONALIZING THE FEATURE LIST

To customize the Features list for an app:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom, then touch Customize.

Touch Customize Feature List.

o v & W

Touch the required option.

e To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is hidden, the Eye
icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify that a feature is visible, the Eye
icon appears with no line across it.

7. To reorder the menu features, touch and drag the features into the appropriate order.

8. To save the current configuration, touch Done.

SHOWING ALL FEATURES IN THE FEATURES LIST
To show all the hidden features for an app:

1. At the printer control panel, press the Home button.
Touch the app required.

Select the job settings.

& W N

Scroll to the bottom, then touch Show Additional Features.

The hidden features list appears.
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SAVING APP DEFAULT SETTINGS
You can use this feature to save a particular combination of app settings as the default settings.

To save the current app settings as default settings:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Select the job settings that you want to save as the default settings.

Scroll to the bottom, then touch Customize.

o v & W

Touch Save Settings as Default.

The new settings override the previous default settings.

REMOVING APP CUSTOMIZATION USING THE CONTROL PANEL

To remove the current app customization settings:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom, then touch Customize.

Touch Remove App Customizations.

o v &= W

At the prompt, touch Remove.
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Creating and Using 1-Touch Apps

You can use 1-Touch Apps to create individual apps for completing frequent jobs or tasks. After you create a 1-
Touch App, the app appears on the printer Home screen. To run the job, load the original documents in the
automatic document feeder or on the document glass, then touch the required 1-Touch App.

System administrators can use the Fleet Orchestrator feature to clone and install 1-Touch Apps on other devices.
For information about Cloning and using the Fleet Orchestrator feature, refer to the System Administrator Guide at
WWW.SUpport.xerox.com.

CREATING A 1-TOUCH APP

To create a 1-Touch App:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.

Select the job settings.

Scroll to the bottom, then touch Create 1-Touch App.

Touch Save as 1-Touch App.

Touch the Enter App Name entry field, then use the keypad to enter a name. Touch Next.
Touch a color scheme option for your 1-Touch App, then touch Next.

Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

© v ® N o v &~ w

Touch the Enter App Instructions entry field, then use the keypad to enter instructions for users. Touch Next.
When the 1-Touch App is selected, the instructions appear at the top of the screen.

11.  Touch the app settings required.

e Allows Editing Quantity: Use this option to allow users to view and update the quantity.

e Show Feature Settings: Use this option to display a summary of the features programmed for the 1-
Touch App.

12. Touch Done.

The 1-Touch App appears on the Home screen.

DELETING OR HIDING A 1-TOUCH APP

To delete or hide a 1-Touch App from the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.
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2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Touch Customize.
4. Touch Customize Home.
5. For the required 1-Touch App, touch X, then touch an option.
e Delete: Use this option to delete the 1-Touch App from the printer permanently.

e Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is still available,
and you can add the app to the Home screen at any time.

6. Touch Done.

USING A 1-TOUCH APP

To use a 1-Touch App:

1. At the printer control panel, press the Home button.

Load the original documents in the automatic document feeder or on the document glass.

Select the 1-Touch App for your job.

&= WN

Do one of the following.

e For Copy Jobs, if you selected Allow Editing Quantity during 1-Touch App setup, update the number of
copies, as required.

e If you selected the Show Feature Settings option during the 1-Touch App setup, update the feature settings,
as required.

5. Touch Start.

6. To return to the Home screen, press the Home button.
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Removing All Customizations

To remove all customizations from the device:

L
& Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.support.xerox.com.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.

4. Touch Remove All Customizations.

(D Caution: The Remove Home Customization option removes customization from the Home screen, and
other customized device settings.

5. At the prompt, touch Remove All.
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Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
www.support.xerox.com.

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps include Xerox®
Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Xerox® App Gallery

XEROX® APP GALLERY OVERVIEW

Use the Xerox® App Gallery to find apps that provide new features or capabilities for
your device. The Xerox® App Gallery provides direct access to apps that can improve
your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the App Gallery
without logging in. The moving banner provides an active display of apps, or you can scroll the full list of apps. To
get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network connection.

j’ Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy exception at the
‘ device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide
available at www.xerox.com/support/xerox-app-gallery.

CREATING A XEROX® APP GALLERY ACCOUNT

With an App Gallery account, you have direct access to all the available Apps for your device. An App Gallery
account allows you to view and acquire Apps, install Apps on your device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or the Xerox ® App Gallery Web portal. For more
information about the Xerox ® App Gallery Web portal, refer to www.xerox.com/support/xerox-app-gallery.

f Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox® App Gallery
Account.

To create an App Gallery account using the Control Panel:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery.
3. Touch Login.
4. Touch Request an Account.
5. To enter a valid email address, use the touch screen keypad, then touch OK.
A message is displayed stating completion instructions have been sent to the email address entered.
6. Touch Close.
7. Access your email account for the email address that you provided to Xerox App Gallery.
8. Open the Xerox App Gallery Account Request email, then click the URL link for creating an account.
9. Review and accept the Terms of Use. To continue creating an account, click the Agree button.
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10. Enter the information required into the appropriate fields:
e UserID
e Password
e Confirm Password
e First and Last Name
e Company Name
e Country
11.  Click OK.
12.  After the account is created, a confirmation message appears.

13. At the printer control panel, log in to your App Gallery Account.

LOGGING IN TO YOUR XEROX® APP GALLERY ACCOUNT

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.

j’ Note: The first time that any user logs in to the Xerox ® App Gallery from the device, the Xerox® App Gallery
software updates automatically. Once the upgrade completes, a message instructs the user to exit and
reselect the Xerox® App Gallery. All future Xerox® App Gallery upgrades are manual and initiated by the user.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.

To enter your Password, use the touch screen keypad.

v B wWN

Touch OK or Enter. The Xerox® App Gallery opens.

INSTALLING OR UPDATING AN APP FROM THE XEROX® APP GALLERY

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox®App Gallery App to
browse and install Apps at your device control panel.

To install an App from the App Gallery:

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.
To enter your Password, use the touch screen keypad.

Touch OK or Enter. The Xerox® App Gallery opens.

o v & W N

Touch the App required, then touch Install. The License Agreement screen appears.

j’ Note: If the App was installed previously and a new version is available, the button is labeled as Update.
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7. Touch Agree. The installation process begins.
If the App does not successfully install, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery App, touch Exit, or press the Home button.

Updating an App from the App Gallery

1. At the printer control panel, press the Home button.

Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.

To enter your Password, use the touch screen keypad.

Touch OK or Enter. The Xerox® App Gallery opens.

Touch the App required, then touch Update. The License Agreement screen appears.
Touch Agree.

When the update is complete, the Update button is labeled as Installed.

© s N o W N

To exit the Xerox® App Gallery App, touch Exit, or press the Home button.
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Device

DEVICE OVERVIEW

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies
information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all of the
Device settings, refer to the System Administrator Guide at www.support.xerox.com.

Device Options

The following Device options are available:

DESCRIPTION

o
©
-
o
A

About The About option provides an overview of your device, the device serial
number, and information about current settings.

Information Pages | Your printer has a set of information pages that you can print. These pages
include configuration and font information, demonstration pages, and more.

Notifications Use the Notifications option to see details of any current alerts or errors on
the device. A Fault History button displays fault codes and the date that
they occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for each
paper tray and the tray-capacity status.

i [ == ]~

Supplies Use the Supplies section to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days left
for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total number
of impressions made by your device.

Tools Use the Tools option to customize settings such as the power-save modes,
date and time, and control panel brightness. You can configure settings
using the device control panel, or by using the Embedded Web Server.

f Note: For details on configuring the printer settings, see the System
Administrator Guide at www.support.xerox.com.

Remote Services Use the Remote Services option to send error and usage information to the
Xerox support team.

(1 BRE

f Note: Your System Administrator must enable this feature using the
Embedded Web Server.
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For details on configuring the printer settings, refer to the System Administrator Guide at www.support.xerox.com.

ABOUT

The About option provides an overview of your device and its current settings and status. You can view the serial
number, model number, and software version.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

NAME DESCRIPTION

Configuration Report The Configuration Report provides printer information
including the serial number, installed options, network
settings, port setup, tray information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

SUPPLY STATUS

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control
panel. You can customize the alerts that appear on the control panel and configure email alert notifications.

To check the supplies status at the control panel:

1. To view status information for the printer supplies, touch Device > Supplies.
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To view details about a specific toner cartridge, including the part number for reordering, touch Cyan,
Magenta, Yellow, or Black.

To view more details, touch Other Supplies. Scroll through the list, then select an option.
To print the Supplies Usage Page, touch Print Supplies Report.

To return to the Supplies screen, touch X.

To return to the Device screen, touch X.

To return to the Home screen, press the Home button.

To check the supplies status and set up alerts, use the Embedded Web Server. For details about configuring all
Device settings, refer to the System Administrator Guide at www.support.xerox.com.

BILLING AND USAGE COUNTERS

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1.
2.

At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

The impression counts are displayed:

e Black Impressions: Total number of pages printed with no color specified.

e Color Impressions: Total number of pages printed that specify color.

e Total Impressions: Total number of color impressions and black impressions.
To view more details, touch Usage Counters, then select an option.

e Impression Counters: This option provides the number of impressions made by the printer. The number of
impressions cannot equal the number of sheets counted, depending on the printer setup. If your printer is
set up to count large sheets as large impressions or as multiple smaller impressions, the number of
impressions can differ.

e Sheet Counters: This option provides the number of impressions made by the printer. Impressions for 2-
Sided sheets are identified as a separate line from1-Sided sheets.

« Images Sent Counters: This option provides the number of images sent using the Fax, Email, or Scan
features.

« Fax Impressions Counters: This option provides the number of images sent using the Fax features. Each
fax feature is identified on a separate line.

e All Usage Counters: This option provides all printer usage information.

After viewing the usage readings, to return to the Home screen, press the Home button.
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REMOTE SERVICES

You can use the Remote Services option to send error and usage information to the Xerox support team to help
them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System
Administrator Guide at www.support.xerox.com.
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Jobs

JOBS OVERVIEW

E— You can use Jobs to view current jobs, print saved and secure jobs, and view details

— about completed jobs. You can pause, delete, print, or view job progress or job details for

- a selected job.

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can
interrupt, pause, or delete jobs that are printing. You can also view job progress or job details for a selected job.

A print job can be held by the printer when it is unable to complete the job. For example, if the printer needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. When you
send a Secure Print job, the job is held until you release it by entering a passcode at the control panel. For more
details, refer to Managing Special Job Types.

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. For more
details, refer to Managing Jobs using the Embedded Web Server.

Interrupting Printing

1. At the control panel, touch the Interrupt button. The printer continues to print while it determines the best
place to pause the spooled print job.

2. Printing stops to allow the printer to complete another job.

3. Toresume printing, touch the Interrupt button again.

Pausing or Deleting a Print Job
1. At the printer control panel, press the Home button.
2. To pause a job that is printing, touch the pause button on the control panel.
3. Select a task.
e To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

4. To return to the Home screen, press the Home button.

Pausing, Promoting, or Deleting a Job Waiting to Print
1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.
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3. Select atask.

f Note: If you do not make a selection, the job automatically resumes after the set timeout period.
e To pause the print job, touch Hold. To resume the print job, touch Release.
e To delete the print job, touch Delete. At the prompt, touch Delete.
e To move the job to the top of the list, touch Promote.
e To view the status of the job, touch Job Progress.
e To view information about the job, touch Job Details, then touch Job Settingsor Required Resources.

4. To return to the Home screen, press the Home button.

j’ Note:

e The system administrator can restrict users from deleting jobs. If a system administrator has restricted
job deletion, you can view the jobs, but cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources
1. At the printer control panel, press the Home button.
Touch Jobs.

From the jobs list, touch the held job name. The resources required for the job appear on the control panel.

&wN

Do one of the following steps.

To print the job, replenish the resources required. The job resumes automatically when the required
resources are available. If the job does not print automatically, touch Resume.

To choose an alternative paper source to enable the job to print, touch Print On Alternate Paper. Select a
paper tray, then touch OK.

e To delete the print job, touch Delete. At the prompt, touch Delete.

j’ Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about the
Print On Alternate Paper option, refer to the System Administrator Guide at www.support.xerox.com.

5. Toreturn to the Home screen, press the Home button.

MANAGING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and stored there for future use. All users can print or delete a Saved
Job.

On the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server,
on the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.
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To print a saved job from the control panel, refer to Printing from Saved Jobs.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Printing deleting, moving, or copying a saved job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v &~ W N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.
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Printing using Secure Print

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job

1. At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

o v &~ W N

Select an option:

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
j’ Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.

After a Sample Set job is printed, it is deleted automatically.
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To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4, Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. Toreturn to the Home screen, press the Home button.

MANAGING JOBS USING THE EMBEDDED WEB SERVER

In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs. You can use
the Embedded Web Server to submit jobs for printing at the device. You can use the Job Submission feature to print
.ps, .pdf, .pcl, and xps files without installing a print driver. You can select jobs for printing from your local computer
hard drive, mass storage devices, or a network drive.

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear on the Saved
Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create and manage folders in which
they are stored.

To manage jobs using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe Embedded Web Server, click Jobs.
3. Click the job name.
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4,

5.

From the menu, select an option.
e To pause the print job, click Pause, then click Go.
e To delete the print job, click Delete, then click Go. At the prompt, click OK.

To return to the Home screen, click Home.

Submitting Jobs for Printing using the Embedded Web Server

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.

Click Print.

For File Name, click Browse or Choose File, then do one of the following steps.

¢ Navigate to the file, then select it.

e Type the path to the file that you want to select.

In the Printing areq, for Copies, select Auto, or enter the number of copies to print.

For Job Type, select an option:

e Normal Print: This option prints a job immediately.

e Secure Print: This option prints a job after you enter your passcode at the printer control panel.

e Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The device holds the
remaining copies in memory until you release them for printing at the control panel.

e Save Job for Reprint: This option saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

e Delay Print: This option prints a job at a specified time up to 24 hours from the original job submission.
As needed, for Paper Selection, select paper size, color, type, and tray.

As needed, select job options.

e 2-Sided Printing

e Collate

e Orientation

e Staple

e Folding

e Output Destination

j’ Note: The available options vary by device.

9.
10.

86

If Accounting is enabled, enter your User ID and Account ID.

Click Submit Job.
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Reprinting Saved Jobs using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

S

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.
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Copy

COPY OVERVIEW

— To make a copy, the device scans your original documents and temporarily stores the

— images. It then prints the images based on the options that you selected. You can

m change settings for individual jobs based on the original documents. You can save
settings that you use for regular jobs and retrieve them for later use.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.support.xerox.
com.

If Authentication or Accounting is enabled on your device, to access Copy features, enter your login details.

For information about all the App features and available settings, refer to Apps Features.

MAKING A COPY

To make a copy:

88 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide


http://www.support.xerox.com/
http://www.support.xerox.com/

1.

A

Xerox® Apps

Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator

LED illuminates.
At the printer control panel, press the Home button.
Touch Copy.
To clear previous app settings, touch Reset.
To enter the number of copies needed, use the numeric keypad.
Adjust copy settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Copying, then select an option.
For details about available features, refer to Apps Features.

Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
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8. If Build Job is enabled, touch Scan, then, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To return to the Home screen, press the Home button.

COPY WORKFLOWS

Note: Some features are hidden from view when the Copy App is installed. For details on configuring and
customizing the Apps, refer to the System Administrator Guide at www.support.xerox.com.

Adjusting Color Settings

Before printing a copy of a color original image, you can adjust the balance of the printing colors between cyan,
magenta, yellow, and black. You can adjust the color of the copy using preset color effects. For example, you can
adjust colors for brightness or coolness. Adjusting the saturation makes the image colors more vivid or pastel.

Select color or black and white output

1. At the printer control panel, press the Home button.

2. Touch Copy.
3. Touch Output Color.
4. For Output Color, touch an option.

e Auto Detect: The device detects the color content in the original document. If the original content is a
color document, the printer makes copies in full color. If the original content is a black and white document,
the printer makes copies in black only.

e Black & White: This option produces copies in black and white only. Colors in the original content are
converted to shades of gray.

e Color: This option copies in full color output using all four printing colors, cyan, magenta, yellow, and black.

e To access the Single Color option, touch More.

Single Color produces shades of a single color. To select a color, touch Color, then select an option. Your
color selection appears on the sample page.
5. Touch OK.

Adjusting the Color Balance
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Color Balance.

f Note: This feature is not available when Output Color is set to Black and White.
4. To adjust the density levels of all four colors:

a. On the Color Balance screen, touch Basic Color.
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b. Move the sliders to adjust the level for each color.
5. To adjust the highlight, midtone, and shadow density levels by color:
a. On the Color Balance screen, touch Advanced Color.
b. Touch the color you want to adjust.
c.  Move the sliders to adjust the levels for highlights, midtones, and shadows.
d. To adjust more colors, repeat the previous two steps.

6. Touch OK.

Adding color effects
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Color Presets.

f Note: This feature is not available when Output Color is set to Black and White.

4. On the Color Presets screen, touch the required preset color effect. The sample images show how the colors are
adjusted.

5. Touch OK.

Adjusting the Saturation

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Saturation.

4. To adjust the saturation, move the slider.

5

Touch OK.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the amount to
erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Edge Erase.

& W N

Select one of the following options.

e All Edges: This option erases all four edges by the same amount. To adjust the amount to erase, move the
slider.

e Individual Edges: This option allows you to specify different amounts to erase from the edges. Touch the
required Top, Bottom, Left or Right field. To enter the amount to erase, use the numeric keypad, or touch
the arrows.
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5. To mirror the same erase amount applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
6. To select a pre-defined amount of erase, use the Presets option.

7. Touch OK.

Specifying the Size of the Original

Use the Original Size feature to set a standard or custom size for scanning, or for the printer to determine the
original size document automatically. You can use this feature to enable mixed-size original document scanning.

To specify the original size:

1. At the printer control panel, press the Home button.

2. Touch Copy.
3. Touch Original Size.
4. Select an option.
e Auto Detect: This option allows the printer to determine the size of the original document.
e Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.
e Custom Scan Area: You can specify the width and length of the area to scan. To specify the original width
or length, touch the appropriate field. To enter the size, use the numeric keypad, or use the arrows.
e Mixed Size Originals: You can scan standard-size originals of varying sizes. To determine which original
sizes can be mixed in the same job, use the diagram on the screen.
5. Touch OK.
Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than the page
size. For image shift to work correctly, position original documents as follows.

¢ Document Feeder: Position original documents face up, long edge entering the feeder first.

e Document Glass: Position original documents face down, in the upper-left corner of the document glass, long
edge to the left.

To change the placement of the image:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Image Shift.
4. Select one of the following options.
e Off: This option is the default setting.
e Auto Center: This option centers the image on the page.

5. To enter a specific amount of image shift, touch More, then touch Margin Shift. Touch the required Up /
Down or Left / Right fields. To enter the amount of shift, use the numeric keypad, or touch the arrows.
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6. To mirror the same image shift applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
7. To select a pre-defined amount of shift, use the Presets option.

8. Touch OK.

Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can use this
feature to copy images for different results.

You can copy either the left or right page onto a single sheet of paper. You can copy both the left and right pages
onto two sheets of paper.

j’ Note: Use the document glass to make copies from books, magazines, or other bound documents. Do not
place bound originals in the document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Book Copying.

&wN

Select one of the following options.
e Off: This option is the default setting.
e Both Pages: This option scans both pages of an open book onto two sheets of paper.

e Left/Right Page Only: This option scans the left or right page of an open book onto a single sheet of
paper.

5. If Binding Edge Erase is required, touch More. Touch the Binding Edge Erase field. To enter the amount to
erase, use the numeric keypad, or touch the arrows. You can erase up to 50 mm (2 in.) from both pages, or 25
mm (1 in.) from one page.

6. Touch OK.

Creating a Booklet

The Booklet Creation feature prints two pages on each side of the paper. The printer reorders and reorients the
pages so that they are in the correct order and orientation when folded. If more finishing options are available, the
pages can be stapled and folded to create a booklet.

To create a booklet:

f Note: In this mode, the printer scans all the original documents before it prints the copies.
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Booklet Creation.
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4. Select one of the following options.
e Off: This option is the default setting.

e On: This option enables Booklet Creation.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

5. To change the Original Input, Paper Supply or finishing options, touch More, then select an option.
e Toscan 1 or 2-sided originals, touch Original Input, then select an option.
e To change the paper source for the booklet, touch Paper Supply, then select an option.
e If your printer has a finisher installed, for Fold & Staple, select a staple or fold option.

6. Touch OK.

Adding Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight paper.
The printer selects the paper from a different tray. The covers can be blank or printed.

To add covers to your copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Covers.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. For Covers Options, select an option.
e Front & Back Same: This option includes front and back covers from the same tray.
e Front & Back Different: This option includes a front and a back cover from different trays.
e Front Only: This option includes a front cover only.
e Back Only: This option includes a back cover only.
5. For Printing Options, select an option.
e Blank Cover: This option inserts a blank cover.

e Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the image on side 2
by 180degrees, touch Rotate Side 2.

Print on Side 2 Only: This option prints on the back of the cover only. To rotate the image on side 2 by
180degrees, touch Rotate Side 2.

Print on Both Sides: This option prints on both sides of the cover.

Rotate Side 2: If covers are 2-Sided, touch this option to rotate the image on side 2 by 180 degrees.
6. For Paper Supply, touch the required tray.

7. Touch OK. The options that you selected appear on the Special Pages screen.
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8. To edit or delete a special page entry, touch the entry in the list. From the menu, touch the required option.

9. Touch OK.

Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. To do this, you specify the
tray that contains the inserts.

To add inserts to a copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special PagesInserts.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. To specify the number of sheets to insert, touch the Insert Quantity field. To enter the number of sheets, use
the numeric keypad, or use the arrows. Touch Enter.

5. To enter a location for the insert, touch the Insert After Page entry box. To enter a page number, use the
numeric keypad. Touch Enter.

6. To specify the paper tray to use for the insert:
a. Touch Paper Supply.
b. Touch the required paper tray.
c.  Touch OK.
7. Touch Add. The insert appears in the list on the Inserts screen. To add more inserts, repeat the previous steps.
8. Touch X. The options that you selected appear on the Special Pages screen.
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

10. Touch OK.

Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If necessary, the
printer leaves one side of the paper blank so that the chapter starts on the specified side of the paper.

To specify chapter start pagination:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Chapter Starts.

4. To specify the chapter start page, touch Page Number. To enter the page number, use the numeric keypad.
Touch Enter.
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5. For Start Chapter, select an option.

e On Right Page: This option specifies the front of the paper.

e On Left Page: This option specifies the back of the paper.

Touch Add. The page is added to the list on the right side of the screen.

To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

© v ® N o

Touch OK.

Specifying Exception Pages

You can specify exception pages to print on paper that is loaded in a different paper tray than the paper for the
rest of the document. Ensure that the paper you use for the exception pages is the same size as the paper that you
use for the rest of the document.

To specify the exception pages:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Exceptions.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. To enter the range of pages to print on different paper:

e To enter the starting page number, touch the first Page Number field. To enter the starting page number,
use the numeric keypad. Touch Enter.

e To enter the ending page number, touch the second Page Number field. To enter the last page number,
use the numeric keypad. Touch Enter.

j’ Note: To specify a single page as an exception, enter that page number as the start and end of the range.

5. To specify the paper to use for the exception pages:

a. Touch Paper Supply.

b. Touch the tray that contains paper to use for the exception pages.

c. Touch OK.

Touch Add. The page range is added to the list on the right side of the screen.
To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

© v ® N o

Touch OK.
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Adding Annotations

You can automatically add annotations such as page numbers and the date to your copies.

j’ Note:

You cannot add annotations to covers, inserts, or blank chapter-start pages.

If Booklet Creation is selected, you cannot add annotations.

To add annotations:

1. At the printer control panel, press the Home button.

& wWN

a.

b.

Touch Copy.
Touch Annotations.

To add page numbers:

Touch Page Number.
Touch On.

Touch the Starting Page Number entry box. To enter a page number, use the numeric keypad, then touch
Enter.

Touch Apply To, then select an option.
To position the page number, touch an arrow. The sample page shows the location of the page number.

Touch OK.

5. Toinsert a comment:

Touch Comment.

Touch On.

For Stored Comments, touch an option in the list.
e Touch an existing comment.

e To create a comment, touch an Available option. To enter the annotation text, use the touch screen
keypad, then touch OK.

e To edit or delete a comment, use the buttons below the Stored Comments list.
Touch Apply To, then select an option.
To position the comment, touch an arrow. The sample page shows the location of the comment.

Touch OK.

6. To insert the current date:

Touch the desired current date location.
Touch Date.
Touch On, then touch the date format that you wish to use.

Touch Apply To, then select an option.
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9.
10.

e. To position the date in the header or footer, touch an arrow. The sample page shows the location of the
date.

f.  Touch OK.

To insert a Bates Stamp:

a. Touch Bates Stamp.

b. Touch On.

c. For Stored Prefixes, touch an option in the list.
e Touch an existing prefix.
e To create a prefix, touch an Available option. To enter text, use the touch keypad, then touch OK.
e To edit or delete a prefix, use the buttons below the Stored Prefixes list.

d. Touch Starting Page Number. To enter the starting page number, use the alphanumeric keypad. You can
use leading zeros to indicate the number of digits required. Touch Enter.

e. Touch Apply To, then select an option.

f. To position the Bates Stamp in the header or footer, touch an arrow. The sample page shows the location
of the Bates Stamp.

g. Touch OK.
To change the text formatting, touch Format & Style, choose the required settings, then touch OK.
To remove all entered annotations, touch Delete All.

Touch OK.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of the paper.

To change the page layout:

1.
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At the printer control panel, press the Home button.
Touch Copy.

Touch Page Layout.

Select one of the following options.

e Pages per Side: This option places a defined number of pages on one or both sides of the paper. Select
the required number of pages per side.

e Repeat Image: This option places a defined number of the same image on one or both sides of the paper.
Select the number of images required. Auto Repeat allows the printer to determine the maximum number
of images that can fit on the currently selected paper size.

To enter a specific number of rows and columns, touch Specify Rows & Columns. Touch the Rows or Columns
field. To enter the number of rows and columns, use the numeric keypad, or touch the arrows. To rotate the
paper, select the check box for Rotate Background.

To change the original orientation, touch Original Orientation. Select Portrait or Landscape.

Touch OK.
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Building a Copy Job

Use this feature to produce complex jobs that include a variety of originals requiring different App settings. Each
segment of the job can have different settings. After all the segments are programmed, scanned, and temporarily
stored in the printer, the job is processed and completed.

To build a job:

1. At the printer control panel, press the Home button.
Touch Copy.

To clear previous App settings, touch Reset.

Touch Build Job.

Split the job into the required segments for scanning.
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Program and scan the first segment:

a. Load the original document for the first segment.
b. Select the options required for the segment.

c.  Touch Scan.

7. Set the required build job display options.

8. Print a Sample segment or delete a segment.

a. To print a sample of the previous segment scanned, touch the segments option, then touch Sample Last
segment.

b. To delete the previous segment scanned, touch the segments option, then touch Delete Last Segment.

c. To delete all the previous segment scanned, touch the segments option, then touch Delete All Segments.
9. Program and scan more segments.

a. Load the originals for the next segment.

b. To change the settings for the next segment, touch Program Next Segment, then select the options
required for the segment.

c. Touch Scan Next Segment.
10. Continue scanning segments until all original documents are scanned.

11. Touch Submit.

Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies. This feature is useful
for complex or high-volume jobs. After you print and inspect the test copy, you can choose to print or cancel the
remaining copies.

To print a sample copy of your job:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Adjust the copy settings as needed.
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Enter the number of copies needed.

Touch the Sample Copy toggle button.

Touch the Start button. The sample copy prints.

Inspect the sample copy, then select one of the following options.

e If the copy is unsatisfactory, touch Delete. Touch Delete to confirm. The job is canceled and no more
copies are printed.

o If the copy is satisfactory, touch Release. The remaining copies are printed.

To return to the home screen, press the Home button.

Saving Current Copy Settings

To use a particular combination of copy settings for future copy jobs, you can save the settings with a name and
retrieve them for later use.

To save the current copy settings:

1.
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At the printer control panel, press the Home button.

Touch Copy.

Change the settings required.

Touch Save Current Settings.

To create a new saved setting, touch any option labeled <Available>.

Enter a name for the saved setting using the touch screen keyboard, then touch OK.

Retrieving Saved Copy Settings

You can retrieve and use any previously saved copy settings for current jobs.

j’ Note: To save the copy settings with a name, refer to Saving Current Copy Settings.

To retrieve saved settings:

1.

- W N

5.
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At the printer control panel, press the Home button.
Touch Copy.
Touch Retrieve Saved Settings.

Touch the saved setting required.

j’ Note: To delete a saved setting, touch the setting, then touch Delete Settings. Touch Delete to confirm.

Touch OK. The saved settings are loaded for the current copy job.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Xerox® Apps

ID Card Copy

ID CARD COPY OVERVIEW

s

onto one side of paper. To copy the card properly, place each side in the upper-left
corner of the document glass. The printer stores both sides of the document, then prints
them side by side on the paper.

B You can use the ID Card Copy App to copy both sides of an ID card or small document

The ID Card Copy App is hidden from view on initial device setup. For details about configuring and customizing the
Apps, refer to the System Administrator Guide at www.support.xerox.com.

For information about all the App features and available settings, refer to Apps Features.

COPYING AN ID CARD

To copy an ID card:

1. Lift the document feeder, then place the original document in the upper-left corner of the document glass.
At the printer control panel, press the Home button.

Touch ID Card Copy.

To clear previous App settings, touch Reset.

Adjust the settings as required.

Touch Scan Front.
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When scanning is finished, lift the document feeder. Place the second side of the original document in the
upper-left corner of the document glass.

8. To scan the second side of the original document and print the copies, touch Scan Back.

9. To return to the home screen, press the Home button.
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Email

EMAIL OVERVIEW

You can use the Email App to scan images and attach them to emails. You can specify
the file name and format of the attachment, and include a subject heading and
message for the email.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at www.support.
XEerox.com.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SCANNED IMAGE IN AN EMAIL

To send a scanned image in an email:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the printer control panel, press the Home button.
3. Touch Email.

4. To clear previous app settings, touch Reset.
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Enter recipients.

V4

To organize the recipients, touch one of the recipient names on the list. From the menu, select To:, Cc:, or Bcc:.

10.
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If the entry screen appears, to enter a recipient, touch an option, or touch X.

To select a contact or group from the Address Book, touch the Device Address Book option. Touch
Favorites or Contacts, then select a recipient. Touch OK.

To select a contact from the Network Address Book, touch the Network Address Bookoption. Enter a
name, touch Search, then select a recipient. Touch OK.

To enter the email address manually, touch Manual Entry. In the Enter Email Address field, enter the email
address, then touch Add.

To add your own email address to the recipient list, touch Add Me. If necessary, enter your login details.

To add more recipients, touch Add Recipient, then repeat the procedure.

Note: The choices available for adding recipients depends on system configuration.

Adjust the email settings as needed.

To change the subject, touch Subject, enter a new subject, then touch OK.

To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format. To create a searchable file or to add password protection, from the file format menu, select
More.

To change the email message, touch Message, enter a new message, then touch OK.

To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

To start the scan, touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

To return to the Home screen, press the Home button.
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ADDING OR EDITING CONTACTS IN THE DEVICE ADDRESS BOOK FROM THE CONTROL PANEL

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:

f Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch
Screen for All Users.

1. Load your original documents.

At the printer control panel, press the Home button.

Touch Email.

To clear previous App settings, touch Reset.

Touch Manual Entry. To enter an email address, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.
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Do one of the following steps.

e To create an entry, touch Create New Contact. To enter contact details, touch a field, then use the touch
screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. In the list, touch a contact. To find a contact,
touch Search.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the email settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.
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Workflow Scanning

WORKFLOW SCANNING OVERVIEW

The Workflow Scanning App allows you to scan an original document, distribute, and
))) archive the scanned image file. The Workflow Scanning feature simplifies the task of

scanning many multi-page documents and saving the scanned image files in one or
more file locations.

w2
/ Note: The system administrator must set up this feature before you can use it. For details, refer to the
System Administrator Guide at www.support.xerox.com.

The Workflow Scanning App enables you to scan documents using pre-defined settings to a range of file
destinations quickly and easily. There are several workflow options:

e Distribution workflows enable you to scan documents to one or more file destinations. File destinations include
an FTP site, a website, and a network server. You can add fax destinations to workflows too.

e Scan to Mailbox enables you to scan documents to public or private mailbox folders on the printer hard drive.
e Scan to Home enables you to scan documents to a personal Home folder on your network.

e Scan to USB enables you to scan documents to a connected USB Flash drive.

f Note:

e To scan original documents to a file destination associated with a contact in the address book, refer to
Scan To.

e To scan original documents to an email address, refer to Email.

For information about all the App features and available settings, refer to Apps Features.

USING WORKFLOW SCANNING

To scan an original document:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

At the printer control panel, press the Home button.
Touch Workflow Scanning.

To clear previous app settings, touch Reset.
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To select a workflow, from the Pick a Workflow screen, touch an option. If necessary, to refresh the workflow list,
touch Update.

f Note: If the Pick a Workflow screen is not displayed automatically, to display the screen, touch Change
‘ Workflow.

6. If needed, enter recipients, workflow destination details, or browse to the location required for the scanned
original documents.
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7.

11.

To add a file destination, touch Add File Destinations. From the list, select a file destination.

f Note: You can add file destinations to a workflow from the predefined list of file repository settings.

e Inthe Embedded Web Server, to create a new workflow, you can add file destinations from the
predefined list.

e In the Workflow Scanning App, for a selected workflow, you can add more file destinations from the
predefined list.

For details, refer to the System Administrator Guide at www.support.xerox.com.
Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

To define what action the device takes when the filename is used already, touch If File Already Exists.
Select an option, then touch OK.

j’ Note: If the Add to pdf folder option is not available, access the Embedded Web Server, then enable the

Filing Option settings. For details, refer to the System Administrator Guide at www.support.xerox.com.

If you are using the document glass, to combine pages into a single scan file, enable the Build Job feature.
To enable the feature, touch the toggle button for Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

To start the scan, touch Scan.

If Build Job is enabled, when prompted, do these steps.

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

To return to the Home screen, press the Home button.

¢ Note:

e For remote scanning, a network connection is required.
e For details about remote scanning, refer to the Help in the Embedded Web Server.

e Print, copy, and fax jobs can print while you are scanning original documents or downloading files from
the printer hard drive.

Distribution Workflows

Distribution Workflows are customized workflows used in the Workflow Scanning App. A workflow contains pre-
programmed settings for a scan job that specify how and where scanned documents are distributed. A workflow
can include one or more file destinations, as well as fax destinations. You can store customized scan settings in each
workflow.
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Using the Embedded Web Server, you can create a workflow using one or more scan destinations. The following
options are available:

e Predefined scan destinations from the list of file repositories.
e New scan destinations such as an FTP site, a website, or an SMB server.
e Fax number destinations.

When you create a workflow, it appears in the list of workflows in the Pick a Workflow screen of the Workflow
Scanning App.

At the printer control panel, when you select a workflow, you can change the scan settings and add more scan
destinations from the predefined list.

Predefined Network File Repositories

A file repository is a predefined file destination that you can use in a workflow. You can use the printer control panel
to add a file repository to a workflow.

The system administrator configures the file repositories available as predefined scanned file destinations. At least
one repository must be set up for the Workflow Scanning feature to be available. For details, refer to the System
Administrator Guide at www.support.xerox.com.

j’ Note: On the Pick a Workflow screen, the DEFAULT workflow is associated with the default file repository.

Creating a New Workflow

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.
2. Click the Scan tab.
3. Inthe Display areq, select Workflows, then select Create New Workflow.
4. For Add Destination to Workflow, select an option:
e To add an existing file destination to the workflow, select Select from a Predefined List.
e To add a file destination to the workflow, select Enter a Scan Destination.
e To add a fax destination to the workflow, select Enter a Server Fax Number.
5. For Select from a Predefined List, select a destination from the File Destination list, then click Add.
6. For Enter a Scan Destination, add these details:
a. Click the Friendly Name field, then enter a name for the scan destination.
b. For Protocol, select an option, then enter the destination address.
e For IP Address, enter the IP Address: Port number.
e For Host Name, enter the Host Name: Port number.
c. Enter the name of the destination folder as needed. In SMB, the destination folder is the shared folder.
d. In Document Path, enter the name of the subfolder within the destination folder. Select a Filing Policy.

e. Enter avalid login name and password.
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f” Note: Use the login name for the computer that holds the destination folder. The login name can include
the domain name, such as domain name\login name.

7. Click Add.
8. To add another destination to the workflow:
e To add a file destination, for File Destinations, click Add.
e To add a fax destination, for Fax Destinations, click Add.
9. Set the scan settings for the workflow as required.

After a workflow is created in the Embedded Web Server, the workflow is added to the list in the Workflow Scanning
App.

Scanning to a Shared Network Folder

You can scan to a shared folder on a network using SMB. The folder can be on a server or computer running SMB
services.

To scan to a shared network folder, create a shared folder with read and write access privileges.

Sharing a Folder on a Windows Computer

—_

Open Windows Explorer.

Right-click the folder you want to share, then select Properties.

Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, then verify that all permissions are enabled.

Click OK.
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_fg Note: Remember the Share name for later use.

8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later
1. From the Apple menu, select System Preferences.
2. From the System Preferences window, select Sharing, then select File Sharing.

3. Under Shared Folders, click the Plus icon ( +). Browse to the folder that you want to share on the network, then
click Add.

4. To modify access rights for your folder, select the folder. The groups activate.
5. From the Users list, click Everyone, then use the arrows to select Read & Write.
6. Click Options, then select a share-folder option.

e To share the folder, select Share files and folders using SMB.

e To share the folder with specific users, next to the user name, select On.
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7. Click Done.

8. Close the System Preferences window.

j’ Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and
‘ subfolders.

Scanning to a Mailbox Folder

Scanning to a folder is the simplest scanning method. This function allows users to scan files to mailboxes, which
are folders created on the printer hard drive. When you scan an image at the printer, the scan file is stored in a
folder on the internal hard drive. You can use the Embedded Web Server to retrieve the stored scan file to save to
your computer.

The default settings create a 1-sided, color, portable document format .pdf file. You can change the default settings
using the printer control panel, or using the Embedded Web Server at your computer. Control panel selections
override the settings in the Embedded Web Server.

Scanning to the Public Mailbox Folder

The printer provides a public mailbox folder to store scanned images. You do not need a password to scan images
to the public mailbox folder, or to retrieve the scanned images. All users can view scanned documents in the public
mailbox folder. You can create a password-protected private mailbox folder. For details, refer to Creating a Private
Mailbox Folder.

To scan an image to the public mailbox folder:
1. Load your original documents.
At the printer control panel, press the Home button.

Touch Workflow Scanning.
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To select a workflow, from the Pick a Workflow screen, touch Default Public Mailbox.

f Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.
5. To add a file destination, touch Add File Destinations, then select a file destination from the list.
6. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

7. To start the scan, touch Scan. The Job Progress screen appears, and the original document is scanned. The
printer stores the scanned image on the printer hard drive.
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8. If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.

Scanning to a Private Mailbox Folder

This feature allows you to scan documents to a private mailbox folder. Private mailbox folders can require a
password.

You can use the Embedded Web Server to create your private mailbox folders. For details, refer to Creating a Private
Mailbox Folder.

To scan to a private mailbox folder:
1. Load your original documents.
At the printer control panel, press the Home button.

Touch Workflow Scanning.

5w

To select a workflow, from the Pick a Workflow screen, select a private mailbox folder.
j’ Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

5. On the Mailbox Password screen, enter the password, then touch OK.
6. To add a file destination, touch Add File Destinations, then select a file destination from the list.
7. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
8. To start the scan, touch Scan.
9. If Build Job is enabled, when prompted, do these steps:
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

10. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.
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Creating a Private Mailbox Folder

If the scan policy to allow additional folders is enabled, you can create a private mailbox folder. The system
administrator can create a private mailbox folder at any time. For details, refer to the System Administrator Guide at
www.support.xerox.com.

To create a private mailbox folder with a password:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.
2. Click the Scan tab.

3. Inthe Display section, select Mailboxes.

j’ Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, refer to the System
Administrator Guide at www.support.xerox.com.

In the Scan to Mailbox section, click Create Folder.
Click the Folder Name: field, then type a name for the folder.
In the Folder Password field, type a password that adheres to the password rules.

In the Confirm Folder Password field, type the password again.
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Click Apply.

Your private mailbox folder appears in the mailbox folder list in the Embedded Web Server and on the printer touch
screen under Pick a Workflow. The contents are stored on the printer hard drive.

Retrieving Scan Files from a Mailbox Folder

You can use the Embedded Web Server to retrieve scan files from a mailbox folder and copy the files to your
computer.

To retrieve your scan files:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.
2. Click the Scan tab.
3. Inthe Display section, select Mailboxes.

4. In the Scan to Mailbox section, click the folder containing the scan.

f Note:
o Fora password protected private folder, click the Folder Password field, type the password, then click
OK.

e If your image file does not appear, click Update View.

Your scan file appears in the Folder Contents window.
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5. Under Action, select an option, then click Go.

e Download saves a copy of the file to your computer. When prompted, click Save, then navigate to the
location on your computer to save the file. Open the file or close the dialog box.

e Reprint prints the file without saving a copy of the file to your computer.

e Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel to cancel
the operation.

f Note: You can also print a mailbox file using the Print From App. For details, refer to Print From.

Scanning to a User Home Folder

Scan to Home allows you to scan documents to a home directory on an external server. The home directory is
distinct for each authenticated user. The directory path is established through LDAP.

The Scan to Home feature is available as the Home workflow in the Workflow Scanning App.
To enable the Home workflow:
e Ensure that LDAP Network Authentication is configured.

e Ensure that Home folder locations are defined for each user in the LDAP directory.

j’ Note: When a user logs in to the printer using network credentials, the Home workflow appears on the Pick a
Workflow screen.

To use the Home workflow:

1. Load your original documents.

To log in to the printer, touch Log In, then log in with your network credentials.
At the printer control panel, press the Home button.

Touch Workflow Scanning.

v W N

From the Pick a Workflow screen, touch the Home workflow.
f Note:

o If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.
o If the Home workflow is not displayed, check that you have logged in with the required credentials.
6. To add a file destination, touch Add File Destinations, then select a file destination from the list.
7. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.
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8. To start the scan, touch Scan.

9. If Build Job is enabled, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

10. To return to the Home screen, press the Home button.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function produces scans
in .jpg, .pdf, .pdf (a), .xps, and tif file formats.

The Scan to USB feature is available as the USB workflow in the Workflow Scanning App.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load your original documents.

&~ W N

At the printer control panel, press the Home button.
Insert the USB Flash drive into the USB memory port.
At the USB Drive Detected screen, touch Scan to USB.

f Note: If the USB Flash drive is inserted in the printer already, touch Workflow Scanning. Touch Change

Workflow, then touch USB.

5. To add a file destination, touch Add File Destinations, then select a file destination from the list.

6. Adjust the workflow scanning settings as needed.

To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

If you are using the document glass, to combine pages into a single scan file, enable Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

7. To start the scan, touch Scan.
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8. If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

& Warning: Do not remove the USB Flash drive while the printer is processing the scan job. If you remove
the Flash drive before the transfer is complete, the file can become unusable and other files on the drive
can be damaged.

9. To return to the Home screen, press the Home button.

Single-Touch Apps

A Single-Touch App enables you to use a workflow without having to use the Workflow Scanning App. Single-Touch
Apps are displayed on the Home screen, and used with a single touch.

You can use the Embedded Web Server to design the app, associate it with a workflow, and assign user rights. For
details about creating Single-Touch Apps for workflow scanning destinations, refer to the System Administrator
Guide at www.support.xerox.com.

116 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



http://www.support.xerox.com/

Xerox® Apps

Scan To

SCAN TO OVERVIEW

You can use the Scan To App to scan documents to multiple destinations and recipients
in a single scan. A Scan To destination can be a USB Flash drive, a shared network folder,
or an SMB network location. A Scan To recipient can be a contact in the device address
book or network address book, an email address, or the logged-in user.

The Scan To App supports the following scanning functions:
e Scan original documents to an email address. For details, refer to Scanning to an Email Address.

e Scan original documents to a USB Flash drive. For details, refer to Scanning to a USB Flash Drive.

e Scan original documents to a folder in a shared network location using SMB transfer protocol. For details, refer
to Scanning to a Shared Folder on a Networked Computer.

e Scan original documents to the email address associated with the logged-in user. For details, refer to Scanning
to the Logged-In User.

To scan documents to one or more file destinations using customized workflows, refer to Workflow Scanning.

For details about configuring and customizing apps, refer to the System Administrator Guide at www.support.xerox.
com.

For information about all app features and available settings, refer to Apps Features.

SCANNING TO AN EMAIL ADDRESS

You can scan a document and send the scanned file to an email address. The Scan To App produces scans in .jpg, -
pdf, .pdf (a), .xps, and .tif file formats.

Before you scan to an email address, ensure that you configure the printer with the email server information. For
details, refer to the System Administrator Guide at www.support.xerox.com.

To scan an image and send it to an email address:

1. Load the original document on the document glass or into the automatic document feeder.

j’ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the control panel, touch Home.
3. Touch Scan To.

4, If the Scan To destination window does not appear, touch Add Destination.
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10.
11.

12.

Add recipients.
e To enter the email address manually, touch Email. Enter an email address, then touch Add.

e To select a contact or group from the Device Address Book, touch Device Address Book. Touch Favorites
or Contacts, then select a recipient.

e Toselect a contact or group from the Network Address Book, touch Network Address Book. In the search
bar, type the name of the contact or group that you want to add, then touch Search. From the list of
results, select a recipient.

f Note: For details about using the Address Book and managing and creating Favorites, refer to the System

Administrator Guide at www.support.xerox.com.
To add another Scan To destination, touch Add Destination, then select the required destination.

To save the scanned document as a specific filename, touch the attachment filename, then enter a new name
using the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

f Note: To make scanned documents searchable, your system administrator can enable the Searchable

feature.
Adjust scanning options as needed.

e To change the email subject line, touch Subject. Enter a new subject line using the touch screen keypad,
then touch Enter.

e To change the email body message, touch Message. Enter a new message, then touch OK.

To scan multiple pages using the document glass, or to change settings for different sections of the job,
touch Build Job.

To begin the scan, touch Scan.

If Build Job is enabled, when prompted, do these steps.

e To change settings for the next segment of the document, touch Program Segment.

e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

To return to the Home screen, press the Home button.

SCANNING TO A USB FLASH DRIVE

You can scan a document and store the scanned file on a USB Flash drive. The Scan To App produces scans in .jpg, -
pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1.
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Load the original document on the document glass or in the automatic document feeder.
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At the printer control panel, press the Home button.
Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

v W N

Insert your USB Flash drive into the USB port on the front of the printer, then touch USB.

j’ Note: If you select USB as the Scan To destination before inserting a USB Flash drive, you will be prompted
to insert it.

6. To add another Scan To destination, touch Add Destination, then select the required destination.

7. To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

9. Adjust scanning features as needed.

10. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

11.  To begin the scan, press Scan.
12. If Build Job is enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new page onto the document glass, then touch Scan Segment.
e To finish, touch Submit.
The printer scans your images to the root folder of the USB Flash drive.

13. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan another page,
touch Add Page.

j’ Note: If you are scanning a document from the automatic document feeder, a prompt does not appear.

(D Caution: Do not remove the USB Flash drive while the device is scanning and processing the job. If you
remove the Flash drive before the transfer is complete, the file can become unusable and other files on
the drive can be damaged.

14.  To return to the Home screen, press the Home button.

SCANNING TO A SHARED FOLDER ON A NETWORKED COMPUTER

You can scan a document and save the scanned file to a folder on a networked computer. The Scan To App
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: To scan to a user home folder, use the Workflow Scanning App. For details, refer to Scanning to a User
Home Folder.

Before You Begin

Before scanning to a folder on a networked computer, perform these steps:
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e Create a shared folder on your computer:
—  For Windows, refer to Sharing a Folder on a Windows Computer.
—  For Macintosh, refer to Sharing a Folder in Macintosh OS X Version 10.7 and Later.
o Configure an SMB Folder. For details, refer to the System Administrator Guide, at www.support.xerox.com.

e Use the Embedded Web Server to associate a Scan To destination with a Device Address Book contact. For
details, refer to Adding a Scan To Destination to an Address Book Entry.

j’ Note: Ensure that the Address Book contains at least one contact with a scan-to destination.

Scanning to a Shared Folder on a Networked Computer
1. Load the original document on the document glass or into the automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan To.
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To specify the destination of the scanned document, select one of the following options.

e To scan to an SMB folder on a networked computer, touch Network. Browse to the required folder, or enter
the network path name, then touch OK.

j’ Note: For information on configuring SMB folders, refer to the System Administrator Guide at www.support.
Xerox.com.

e To scan to a folder associated with a contact in the address book, touch Device Address Book. Select the
required contact, then touch the Scan To location.

f Note: For details on how to associate a networked folder with an address book contact, refer to Adding a
Scan To Destination to an Address Book Entry.

5. To add another Scan To destination, touch Add Destination, then select the required destination.

6. To save the scanned document as a specific filename, touch the attachment filename. Enter a new name using
the touch screen keypad, then touch Enter.

7. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

8. Adjust scanning options as needed.

9. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

10. To begin the scan, press Scan.

11.  If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

12.  To return to the Home screen, press the Home button.
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SCANNING TO THE LOGGED-IN USER

You can use the Add Me function to scan a document and send the scanned file to the email address associated
with a logged-in user.

j’ Note: Only users authenticated through an LDAP server can have an associated email address.

Before scanning to a logged in user, ensure that LDAP user authentication is configured. For details, refer to the
System Administrator Guide at www.support.xerox.com.

The Scan To App produces scans in .jpg, -pdf, .pdf (a), .xps, and tif file formats.

To scan an image and send it to the email address of the logged-in user:

1. Load the original document on the document glass or into the automatic document feeder.
At the control panel, touch Home.

Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

Touch Add Me.
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If you are not logged in, a login screen appears. Enter your LDAP network user name and password, then touch
Done.

7. To add another Scan To destination, touch Add Destination, then select the required destination.

8. To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.

9. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

j’ Note: To make scanned documents searchable, your system administrator can enable the Searchable
‘ feature.

10. Adjust scanning options as needed.

11. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

12. To begin the scan, touch Scan.

13. If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

14.  To return to the Home screen, press the Home button.
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ADDING A SCAN TO DESTINATION TO AN ADDRESS BOOK ENTRY

You can create Address Book contacts using the Embedded Web Server. A contact is a user with an associated email
address, fax number, or scan to destination. If a contact has been set up to include a scan to destination, the
contact is available for selection in the Scan To App. Contacts can be marked as a Favorite.

To create an address book contact and add a scan to destination:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
2. Click Address Book.
3. To add or edit a contact in the address book:
e To add a contact, click Add, then enter the contact information.

e To edit a contact, select the contact, then click Edit.

f Note: If the Add button is unavailable, the address book has reached its limit. The Device Address Book can
contain up to 5000 contacts.

4. To associate a scan destination with this contact, for Scan To Destination, click the Add Destination ( +)
button. Enter the nickname that you want to appear in the Address Book.

5. Under Protocol, select an option, then enter the destination address:
e For FTP, SFTP, or SMB:
e For IP Address, enter the IP Address: Port number.
e For Host Name, enter the Host Name: Port number.
e For Netware, enter the Server Name, Server Volume, NDS Tree, and NDS Context.

6. For SMB, in the Share field, enter the name of the destination folder. For example, to save scanned files to a
shared folder named scans, type scans.

7. In Document Path, enter the name of the subfolder within the destination folder. For example, to save the
scanned files to a folder named colorscans inside the scans folder, type colorscans.

8. Enter avalid login name and password.

j’ Note: Use the login name for the computer that holds the destination folder. For SMB, the login name is
your computer user name.

9. To confirm the validity of the destination details, click Destination Test.

10. Click Save, or select Add Another Contact After Saving, then click Save.

j’ Note: To mark a contact as a Favorite for email, fax, or scan to destination, for the appropriate field, click the
Staricon. If you click the Star icon for Display Name, the contact becomes a Global Favorite.
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Fax

FAX OVERVIEW

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax App
to fax documents to a fax number, an individual contact, or to a group of contacts.

You can use the Fax App to do the following tasks:

e Delay the send of your fax job for up to 24 hours.
e Send a fax from your computer.

e Forward fax documents to an email address.

e Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as FIOS and DSL
are not supported. Before you use the Fax App, configure the Fax Settings to ensure that they are compatible with
your local connection and regulations. The Fax Settings include optional features you can use to configure the
printer for faxing.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

For details about configuring the fax function and customizing the Apps, refer to the System Administrator Guide at
WWW.SUPPOTt.Xerox.com.

For information about all the App features and available settings, refer to Apps Features.

SENDING A FAX

To send a fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the printer control panel, press the Home button.
3. Touch Fax.

4. To clear previous app settings, touch Reset.
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5. Enter recipients:
e If the entry screen appears, to enter a recipient, touch an option, or touch X.

e To select a contact or group from the Device Address Book, touch the Device Address Book option. Touch
Favorites or Contacts, then select a recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

f Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pausemultiple
times.

6. Adjust the fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
7. Touch Send.
8. If Build Job is enabled, touch Scan, then, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To return to the Home screen, press the Home button.
FAX WORKFLOWS

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax job for up to
24 hours.

f Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to the
System Administrator Guide at www.support.xerox.com.

To specify the time to send your fax:
1. Load your original documents.
At the printer control panel, press the Home button, then touch Fax.

Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.
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Touch Delay Send.
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5. Touch Delay send, then set the time to send the fax.
e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
e If your printer is set to display the 12-hour clock, touch AM or PM.

6. Touch OK.

7. Touch Send. The fax is scanned and saved, then sent at the specified time.

Adding a Cover Sheet

You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can add a short
comment to the cover sheet, as well as To and From details.

To include a cover sheet:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.
3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.
4. Touch Cover Sheet > On.
5. To enter the name of the recipient, touch the To field, then use the touch screen keyboard. Touch OK.
6. To enter the name of the sender, touch the From field, then use the touch screen keyboard. Touch OK.
7. To add a comment, do one of the following steps.
e Touch an existing comment.
e Touch an <Available> comment, then touch the Edit icon. To type text, use the touch screen keypad. Touch
OK.
f Note:
e To delete an existing comment, touch the comment, then touch X. To confirm the action, touch Delete.
e To edit an existing comment, touch the comment, then touch the Edit icon. To change the comment,
use the touch screen keypad. Touch OK.
8. Touch OK.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job list until you
enter a passcode. After you enter the passcode, the faxes are released and printed.

j’ Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. For details,
refer to the System Administrator Guide at www.support.xerox.com.

To print a secure fax:

1. At the printer control panel, press the Home button.

2. Touch Jobs.
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To view Secure Print jobs, touch Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.
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Select an option.

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Polling a Remote Fax Machine

Fax Polling allows you to store a fax document on the printer and make it available for other fax machines to poll.
You can also retrieve faxes stored on other fax machines. To use this feature, both the polling printer and the
remote printer must have the Fax Polling feature.

Storing a Fax for Polling

You can store faxes for polling as Non-Secure or Secure. When you select Secure Storage, you create a list of remote
device fax numbers that are allowed to access secure faxes.

Storing a Fax for Non-Secure Polling

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Non-Secure Storage, then touch OK. To confirm, touch Update Setting.
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Touch Send. The original documents are scanned and stored for non-secure polling.

Storing a Fax for Secure Polling

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

Touch Store Polling Files.

Touch Secure Storage.

Touch Enter a Fax Number. To enter the fax number for the remote device, use the keypad. Touch OK.
Touch the + button. The fax number is added to the access list.

Continue to enter fax numbers for all remote devices that require access to the secure documents.
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Touch OK. To confirm, touch Update Setting.
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10. Touch Send. The original documents are scanned and stored for secure polling.

Deleting Documents Stored for Polling

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again.

Touch OK.

Printing Faxes Stored for Polling

To print faxes stored for polling:

1.
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6.
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At the printer control panel, press the Home button, then touch Fax.
If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Print From Polling Device.
To print faxes that are stored for polling on the local device:
a. Touch Local Fax Polling.
b.  Touch Print.
c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty Fax Mailbox.
The local faxes that are stored for polling print.
To print faxes that are stored for polling on a remote device:
a. Touch Remote Fax Polling.
b. Touch Enter Fax Number. To enter the fax number of the remote device, use the keypad. Touch OK.
c. To add a number to the list, touch the + button. Enter more fax numbers as needed.
d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit.
e. To set a specific time to poll the remote device, touch Delay Polling.
e Touch Delay Polling.
e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
e If your printer is set to display the 12-hour clock, touch AM or PM.
e Touch OK.
f. Touch Print.
The faxes that are stored on the remote device for polling print.

Touch X to exit.
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Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, refer to the System
Administrator Guide at www.support.xerox.com.

To store a fax in a local mailbox:

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Store To Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.
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If a passcode is required, touch the Mailbox Passcodefield. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

8. Touch OK. The mailbox appears as the recipient of the fax.
9. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

10. Touch Send. The original documents are scanned and stored in the mailbox.

Printing Local Mailbox Documents

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a Local Mailbox.
To print local mailbox documents:

1. At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.

Touch Print From Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.

A

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

7. Touch Print. The documents in the mailbox print.

8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To confirm,
touch Empty Mailbox.

9. To exit, touch X.

Storing a Fax in a Remote Mailbox

To store a fax in a remote mailbox:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
4. Touch Store To Mailbox.
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9.
10.

Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
numeric keypad. Touch OK.

Touch OK. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

Touch Send. The original documents are scanned and stored in the remote mailbox.

Printing Remote Mailbox Documents

To print remote mailbox documents:

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Print From Mailbox.

Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

Touch Print. The documents in the remote mailbox print.

Touch X to exit.

Adding or Editing Contacts in the Device Address Book from the Control Panel

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:
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f” Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch

Screen for All Users.
Load your original documents.
At the printer control panel, press the Home button.
Touch Fax.
To clear previous App settings, touch Reset.
Touch Manual Entry. To type the fax number, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Xerox® Apps

7. Do one of the following steps.

e To create an entry, touch Create New Contact. Touch each field, then enter the contact details using the
touch screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. Touch a contact in the list, or use the Search
option to find a contact.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the fax settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.

Sending a Fax From Your Computer

You can send a fax to the printer from an application on your computer.

Sending a Fax from Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can send a
confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CTRL+P.

Select the required printer. To open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.

In the Fax window, click the Recipients tab.
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To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.
c.  Click OK.

d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:

a. Click the Add From Phonebook icon.

b. Select the required phonebook from the list.

c.  Select names from the list, or search for a contact using the search bar.

d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e. Click OK.

f.  To add more recipients, repeat this procedure.
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7. Toinclude a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a Cover
Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialog page, click OK.

10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax from Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer to
Installing the Print Driver Software.

To send a fax from Macintosh applications:

1. With the desired document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CMD+P.

2. Select the required printer.
3. To access the fax driver settings, click Preview, select Xerox Features, then from Job Type list, select Fax.
4. To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
5. Type the recipient name and fax number, add other information as needed, then click OK.
6. To add more recipients, repeat this procedure.
7. Toinclude a cover sheet, click the Cover Sheet tab.
8. From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.
9. On the Options tab, select the required options. To save your settings and return to the main print dialog
window, click OK.
10. To send the fax, click Print.
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Server Fax

SERVER FAX OVERVIEW

Server Fax allows you to send a fax over a network to a fax server. The fax server then
sends the fax to a fax machine over a phone line. Before you can send a server fax,
configure a fax filing repository or filing location. The fax server retrieves the documents
from the filing location and transmits them over the telephone network.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at www.support.
Xerox.com.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SERVER FAX

If a fax server is connected to the network, you can send a document to a fax machine without requiring a
dedicated telephone line.

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax server sends
the fax over a telephone line to a fax machine.

Before you can use the server fax, the system administrator is required to enable the server fax app and configure a
fax repository, or filing location.

To send a server fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the printer control panel, press the Home button.
3. Touch Server Fax.

4. To clear previous app settings, touch Reset.
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Enter recipients.
e If the entry screen appears, touch an option, or touch X.

e To select a contact or group from the Device Address Book, touch the Device Address Book option, then
select a recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

f Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pause multiple

times.
Adjust server fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

Touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps.

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

To return to the Home screen, press the Home button.

SENDING A DELAYED SERVER FAX

You can set a time in the future for the printer to send your fax job. The delay can range from 15 minutes through
24 hours.

f Note: Before you use this feature, set the printer to the current time.

To specify the time to send your server fax:

1.

A

Load your original documents.

At the printer control panel, press the Home button.

Touch Server Fax.

Add server fax recipients, then adjust server fax settings as needed. For details, refer to Sending a Server Fax.
Touch Delay Send.

Touch Delay Send, then set the time to send the server fax:

e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.

e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.

e If your printer is set to display the 12-hour clock, touch AM or PM.
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7. Touch OK.
8. Touch Send. The fax is scanned and saved, then sent at the time you specified.

9. To return to the Home screen, press the Home button.
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Internet Fax

INTERNET FAX OVERVIEW

You can use the Internet Fax App to scan images and attach them to emails. You can
specify the file name and format of the attachment, and include a subject heading and
message for the email.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.support.xerox.

com.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SCANNED IMAGE IN AN INTERNET FAX

To send a scanned image in an email:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

]
/ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

At the printer control panel, press the Home button.
Touch Internet Fax.

To clear previous app settings, touch Reset.
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Enter recipients:
e If the entry screen appears, to enter a recipient, touch an option, or touch X.

e Toselect a contact from the Address Book, touch the Device Address Book option. Select a recipient, then
touch OK.

e To enter an Internet fax address manually, touch Manual Entry. In the Enter an Internet Fax Address field,
enter the Internet fax address, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

6. To organize the recipients, touch one of the recipients on the list. From the menu, select To: or Cc:.
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7. Adjust the Internet fax settings as needed:

To change the subject, touch Subject, enter a new subject, then touch OK.

To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

To change the Internet fax message, touch Message, enter a new message, then touch OK.

To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Send.

9. If Build Job is enabled, touch Scan, then, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

10. To return to the Home screen, press the Home button.
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Print From

PRINT FROM OVERVIEW

[ You can use the Print From App to print jobs from various sources. You can print jobs
H stored in a print-ready format from a USB stick. You can also print Saved Jobs and jobs
(=] stored in a Mailbox.

To create a print-ready file, when you print your documents from programs such as Microsoft Word, select the Print
to File option. Check with your specific publishing application for options to create print-ready files.

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
f Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.support.xerox.com.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
6. Adjust the feature settings as needed.
7. Touch Print.
8. When you are finished, remove the USB Flash drive.
9

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.

3. Touch the name of the saved job that you want to print.
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4. Select the options for paper supply, quantity, 2-sided printing, and finishing.
5. Touch Print.
f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. After the job prints, to return to the list of saved jobs, touch Change File.

7. To return to the Home screen, press the Home button.

PRINTING FROM MAILBOX

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mailboxes, then touch the name of the folder containing the document.

j’ Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.support.xerox.com.

Touch the name of the document that you want to print.
Select the options for paper supply, quantity, 2-sided printing, and finishing.
Touch Print.

After the job prints, to return to the mailbox folder, touch Change File.
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To return to the Home screen, press the Home button.
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected to an active
network. Ensure that you have the correct print driver software installed on your computer. For details, refer to
Installing the Print Driver Software.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and type.

3. Access the print settings in your software application. For most software applications, for Windows, press CTRL
+P, or for Macintosh, press CMD+P.

4. Select your printer.

5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or Preferences. For
Macintosh, select Xerox Features. The name of the option can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

8. If you selected a special job type, for example Secure Print or Sample Print, your job is held at the printer and
requires further action to print. To manage jobs at the printer, use the Jobs app.

For further information on managing print jobs, refer to Managing Jobs.

144 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Printing

Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows and
Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality.
Printing options that you set from Printing preferences within the Devices and Printers window become the default
setting. Printing options that you set within the software application are temporary. The application and the
computer do not save the settings after the application is closed.

PRINT DRIVER HELP

Xerox® print driver software Help information is available from the Printing Preferences window. To see the help,
click the Help (?) button in the bottom-left corner of the Printing Preferences window.
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Information about Printing Preferences appears in the Help window. From this window, you can select by topic or
use the search field. In the search field, enter the topic or function required.

WINDOWS PRINTING OPTIONS

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings that are specified in the
Printing Preferences window. You can specify your most common printing options and save the options for reuse so
that you do not have to change the settings each time that you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing
Preferences.
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1. On your computer, navigate to the list of printers:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.
e For Windows 10, click Start > Settings > Devices > Printers & scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

j’ Note: If you are using a custom Start menu application, the application can change the navigation path to
your list of printers.

2. For your printer, select Printing preferences:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printing preferences.

e For Windows 10, click the icon for your printer, then click Manage > Printing preferences.
e For Windows 11 and later, click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

j’ Note: For more information about Windows print driver options, click the Help button (?) in the Printing
Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job
to the printer.

1. With the document open in your software application, access the print settings. For most software applications,
click File > Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print Options,
or Preferences button. The title of the button can vary, depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Properties window of the print driver.
Finishing options allow you to select how your document is delivered. For example, you can select hole-punching,
stapling, folding, or printing in a booklet format.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1. Inthe print driver, click the Printing Options tab.
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2. To select a finishing option, for Finishing, click the arrow.

4

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on the short
edge instead of the long edge, the finisher can insert the staple in the wrong location.

3. To select the output tray, for Output Destination, click the arrow, then select an option:

Automatic: This option determines the output destination based on the number of sets and the stapling
option selected. The printer sends multiple sets or stapled sets to the finisher output tray.

Center Tray: This option selects the output tray that is in the middle of the Offset Catch Tray, or the
selected finisher.

Center Bottom Tray: This option selects the output tray that is on the bottom of the Offset Catch Tray.
Left Tray: This option selects the output tray that is on the left side of the printer or the selected finisher.
Finisher Tray: This option selects the output tray that is on the Global Integrated Office Finisher.

Right Tray: This option selects the output tray that is on top of the Office Finisher.

Right Top Tray: This option selects the output tray that is on top of the Business Ready Finisher.

Right Middle Tray: This option selects the output tray that is in the middle of the Business Ready Booklet
Maker Finisher.

Right Bottom Tray: This option selects the output tray that is on the bottom of the Business Ready
Finisher when the optional Booklet Maker is not installed.

4, To send the job to the printer, click OK, then click Print.

Selecting Printing Defaults in Windows for a Shared Network Printer

1. On your computer, navigate to the list of printers:

4

For Windows Server 2008 and later, click Start > Settings > Printers.

For Windows 7, click Start > Devices and Printers.

For Windows 8, click Start > Control Panel > Devices and Printers.

For Windows 10, click Start > Settings > Devices > Printers & scanners.

For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize > Control Panel Home > Devices and Printers.

2. For your printer, select Printer properties:

For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printing properties.

For Windows 10, click the icon for your printer, then click Manage > Printer properties.

For Windows 11 and later, click the icon for your printer, then click Printing preferences.

3. Inthe printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click Printing Defaults.

5. On the print driver tabs, make your selections as needed, then click Apply.
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6. To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. After you save a set of
print options, they are available for selection from the Saved Settings or Presets list, or the 1-Touch areaq, if
available.

To save a set of printing options:

1. With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the required settings.

In the Printing Properties window, click Saved Settings or Presets, then click Save As.
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Type a name for the saved setting or preset, then choose preset options, if available:
e Choose an icon for the preset.

e To enable the preset as 1-Touch, select 1-Touch Preset.

e To share the preset in all print drivers, select Show this Preset in All Drivers.

6. Click OK.

7. To print with these settings:

e From the Saved Settings or Presets list, select the name of the preset.

e Fora 1-Touch preset, click 1-Touch, then click the required 1-Touch preset.
MACINTOSH PRINTING OPTIONS

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.

3. Inthe Print window, in the print options list, click Xerox Features.

j’ Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. To send the job to the printer, click Print.

Selecting Finishing Options for Macintosh
If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.
To select finishing options in the Macintosh print driver:

1. In the Print window, in the print options list, click Xerox Features.
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2. Toselect a finishing option, click the arrow to the right of the Finishing field, then select an option.
3. To select the output tray, click the arrow to the right of the Output Destination field, then select an option.

e Automatic: This option determines the output destination based on the number of sets and the stapling
option selected. The printer sends multiple sets or stapled sets to the finisher output tray.

e Center Tray: This option selects the output tray in the middle of the Offset Catch Tray, the Office Finisher,
or the Business Ready Finisher.

e Center Bottom Tray: This option selects the output tray on the bottom of the Offset Catch Tray.
e Finisher Tray: This option selects the output tray on the Integrated Office Finisher.

e Left Tray: This option selects the output tray on the left side of the printer.

e Right Tray: This option selects the output tray on top of the Office Finisher.

e Right Top Tray: This option selects the output tray on top of the Business Ready Finisher.

« Right Middle Tray: This option selects the output tray that is in the middle of the Business Ready Booklet
Maker Finisher.

e Right Bottom Tray: This option selects the output tray that is on the bottom of the Business Ready
Finisher when the optional Booklet Maker is not installed.

4. To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.
To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.
/’ Note: To see all printing options, click Show Details.
4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.

6. To print using these options, select the name from the Presets list.

UNIX, LINUX, AND AS/400 PRINTING

To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR port 515 or lp
to port 9100. Xerox printers can communicate using either protocol.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and
Linux environments.

Xerox® Printer Manager allows you to:
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e Configure and check the status of network connected printers.
e Set up a printer on your network and monitor the operation of the printer once installed.
e Perform maintenance checks and view supplies status at any time.

e Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.

Installing Xerox® Printer Manager
Before you begin:
Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

1. Download the appropriate package for your operating system. To locate drivers for your printer, go to www.
support.xerox.com. The available files are:

o Xeroxv5Pkg-AlXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family.

Xeroxv5Pkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations.

Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments.

Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments.

Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments.

Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments.

Xeroxv5Pkg-SunOSi386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems.

Xeroxv5Pkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems.
2. Toinstall the custom driver, log in as root then type the following command:
e AIX: rpm -U Xeroxv5Pkg-AIXpowerpc-X.XX.XXX.XXXX.rpm

e HPUX: swinstall -s Xeroxv5Pkg-HPUXia64-x.xx.xxx.xxxx.depot.gz /*

Linux (RPM based): rpm -U Xeroxv5Pkg-Linuxi686-x.xX.XXX.XXXX.rpm

Linux (Debian based): dpkg -i Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb

Solaris (x86 based): pkgadd -d Xeroxv5Pkg-Sun0Si386-x.xx.xxx.xxxx.pkg

Solaris (SPARC based): pkgadd -d Xeroxv5Pkg-SunOSsparc-x.xx.xxx.xxxx.pkg

The installation creates a Xerox directory in /opt/Xerox/prtsys.

Launching Xerox® Printer Manager
To launch Xerox® Printer Manager:

1. From your computer, access a command window. At the command prompt, log in as root, then type
xeroxofficeprtmgr.

2. Press Enter or Return.

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX Printing
System) print driver. You do not need both drivers.
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Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate drivers for your
printer, go to www.support.xerox.com.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for installing and
building CUPS are contained in the CUPS Software Administrators Manual, written and copyrighted by Easy
Software Products. For complete information on CUPS printing capabilities, refer to the CUPS Software Users
Manual available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation

1. On the Xerox Support website, from the Drivers and Downloads page, download the Xerox® PPD for CUPS
(Common UNIX Printing System).

2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location of the
folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
Open a Web browser, type http://localhost:631/admin, then press Enter or Return.

For User ID, type root. For password, type the root password.

- W N

Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type 1p ~dprinter filename, then press Enter.

2. To print to a specific printer in Berkeley, type 1pr -Pprinter filename, then press Enter.

AS/400

Xerox provides Work Station Customization Object (WSCO) files to support IBM i V6R1 or later. A Work Station
Customization Object is a lookup table that the host print transform (HPT) uses to translate AS/400 commands to
the equivalent PCL code that is specific to a particular printer. A WSCO file can modify many print features,
including: paper input tray, 2-sided printing, characters per inch, lines per inch, orientation, fonts, and margins.

The XTOOLS library provides a source WSCO file for each supported Xerox® printer or device. The library and
installation instructions are available from www.support.xerox.com.

To install the XTOOLS library, select the downloadable files for the IBM AS/400 operating system, unzip the
downloaded XTOOLSxxxx . z1ip file, then follow the instructions to install the library. Download and install the
library only once.

¢ Note:

e The host print transform works only on AFPDS and SCS files. To use the WSCO for printing, convert IPDS-
formatted printer files to AFPDS files.

e Administrator credentials with IOSYSCFG permissions are required to create a device description or a
remote queue.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide 151


http://www.support.xerox.com
http://www.cups.org/documentation.php
https://www.support.xerox.com/

Printing

e For details on AS/400, refer to the IBM AS/400 Printing V, (Red Book), available on the IBM website.

Installing the WSCO Library and Setting Up Print Queues

For detailed instructions on installing the WSCO library and setting up print queues, refer to the installation
instructions that are included with the library.

MOBILE PRINTING OPTIONS

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi
Direct.

For details, refer to Connecting with Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

j’ Note: Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint® for your printer,
refer to Configuring AirPrint.

To print with AirPrint®:
1. Open the email, photograph, webpage, or document that you want to print.
Tap the Action icon.

Tap Print.

& W N

Select your printer, then set the printer options.
Tap Print.

For more information on configuring AirPrint®, refer to the System Administrator Guide at www.support.xerox.com.

Printing from a Mopria-Enabled Mobile Device

Mopria is a software feature that enables users to print from mobile devices without requiring a print driver. You can
use Mopria to print from your mobile device to Mopria-enabled printers.
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j’ Note:

e Mopria and all of its required protocols are enabled by default.

e Ensure that you have the latest version of the Mopria Print Service software installed on your mobile
device. You can obtain a free download of the software from the Google Play Store.

e To connect the printer to Wi-Fi or Wi-Fi Direct, purchase and install the Xerox Wireless Network Adapter.
For more information, refer to the Xerox® Dual Band Wireless Kit Hardware Install and Setup instructions
that are included with the kit.

e To use Wi-Fi Direct, in the Embedded Web Server, enable the Wi-Fi Direct feature. For details on
configuring Wi-Fi Direct, refer to the System Administrator Guide at www.support.xerox.com.

o To configure the Wireless settings, ensure that devices are connected to the same wireless network as the
printer.

e The name and location of your printer appears in a list of Mopria-enabled printers on connected devices.

To print using Moprig, follow the directions that are provided with your mobile device.
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Print Jobs

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job. When you send a secure print job, the job is held
until you release it by typing a passcode at the control panel. For details, refer to Printing Special Job Types

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.

Pausing, Promoting, or Deleting a Job Waiting to Print

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the required print job.

3. Select atask.

V4

Note: If you do not make a selection, the job automatically resumes after the set timeout period.
To pause the print job, touch Hold. To resume the print job, touch Release.
To delete the print job, touch Delete. At the prompt, touch Delete.
To move the job to the top of the list, touch Promote.
To view the status of the job, touch Job Progress.

To view information about the job, touch Job Details, then touch Job Settings or Required Resources.

4. To return to the Home screen, press the Home button.

V4

Note:

e The system administrator can restrict users from deleting jobs. If a system administrator restricts job
deletion, you can view the jobs, but you cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources

1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the control panel.

154

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Printing

4. Do one of the following steps.

To print the job, replenish the resources required. The job resumes automatically when the required
resources are available. If the job does not print automatically, touch Resume.

To choose an alternative paper source to enable the job to print, touch Print On Alternate Paper. Select a
paper tray, then touch OK.

e To delete the print job, touch Delete. At the prompt, touch Delete.

j’ Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about the
Print On Alternate Paper option, refer to the System Administrator Guide at www.support.xerox.com.

5. To return to the Home screen, press the Home button.

PRINTING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents that are sent to the printer and stored there for future use. All users can print or delete a
Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server, in
the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.
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In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v & W N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. To view Secure Print jobs, touch Secure Jobs.
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4. Do one of the following:

e If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the passcode number,
then touch OK. The job prints automatically.

e If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then touch OK.
Select an option:

e To print a single Secure Print job, touch the job required.
e To print all the jobs in the folder, touch Print All
e To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
j’ Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set

1. At the printer control panel, press the Home button.
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2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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Printing Features

SELECTING PAPER OPTIONS FOR PRINTING

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on
the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the
desired paper.

e To locate paper options in Windows, in the print driver, click the Printing Options tab.

e To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Paper/Output.

Select By Tray

Use Select By Tray to print from a specific tray without specifying paper attributes in the print driver or at the printer
control panel. This option prints the job from the selected tray, even when more than one tray contains the correct
paper for the job.

The following options are available:

e Automatically Select: This option prints from any tray that is loaded with the size and type of paper that is
required for the print job.

e Tray X: This option prints from the selected tray.

e Bypass Tray: This option prints from the manual-feed tray. The printer prompts you to remove any other paper
from the tray and load the paper that is required for your job.

j’ Note: Load the Bypass Tray with the correct size and type of paper for the print job.

Scaling
Scaling reduces or enlarges the original document to match the selected output paper size.
e For Windows, the scale options are on the Printing Options tab, in the Paper field.

e For Macintosh, the scale options are in the Print window. To view more printing options, click Show Details.

j’ Note: Not all options described are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or print driver type.

The following scaling options are available:
o Fit to New Paper Size: This option scales the document to fit the new paper size.

e Change Document Size: Use this setting to match the paper size selected in your application. This option does
not change the size of the page image printed on the output paper.

e Automatically Scale: This option scales the document to fit the selected Output Paper Size. The scaling
amount appears in the percentage box below the sample image.

e No Scaling: This option does not change the size of the page image printed on the output paper,and 100%
appears in the percentage box. If the original document size is larger than the output size, the page image is
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cropped. If the original document size is smaller than the output size, extra space appears around the page
image.

e Manually Scale: This option scales the document by the amount entered in the percentage box below the
preview image.

PRINTING ON BOTH SIDES OF THE PAPER

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses
the settings for portrait or landscape orientation from the application for printing the document.

j’ Note: Ensure that the paper size and weight are supported. For more information, refer to Supported Paper.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings
override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on envelopes, labels,
or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long edge of the
paper. The following illustrations show the result for documents with portrait and landscape orientations,
respectively:

12 B

e 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents with portrait
and landscape orientations, respectively:

| 12

f Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Selecting Printing Options.

XEROX BLACK AND WHITE
You can select printing in color or black and white.
e Off (use Document Color): Use this option to print in color.

e On: Use this option to print in black and white.
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PRINT QUALITY
The Windows PostScript driver and the Macintosh drivers provide the highest print-quality modes:

o High Resolution: 1200 x 1200 dpi (1-bit depth). This mode provides the best overall image quality for detailed
line drawings such as CAD files. It is recommended for printing vibrant, saturated, color prints or photos. Print
jobs can take longer to process when printed using High Resolution mode.

e Enhanced: 600 x 600 dpi (8-bit depth). This mode is used for better print quality, and is the best mode to use
for business presentations. Enhanced mode takes longer to process than Standard or Toner Saver.

e Standard: 600 x 600 dpi (1-bit depth). This mode is used for general-purpose printing, and is optimized for
good print quality. Standard quality is suitable for most print jobs.

e Toner Saver: 600 x 600 dpi (1-bit depth). This mode is used for document preview, and is optimized for quickest
print processing. Toner Saver is useful for draft-quality output.

IMAGE OPTIONS

Image options control the way the printer uses color to produce your document. The Windows PostScript print
driver and the Macintosh print drivers provide the widest range of color controls and corrections on the Image
Options tab.

e To locate color options in Windows, in the print driver, click the Image Options tab.

e To locate color options on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Color Options.

Color Correction

Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your computer screen
or a printing press.

Color Correction options:
o Xerox Black and White: This option converts all color in the document to black and white, or shades of gray.

o Xerox Automatic Color: This option applies the best color correction to text, graphics, and images. Xerox
recommends this setting.

There are more Color Correction options, including Vivid RGB and Commercial.

Color by Words

Color By Words allows you to adjust colors by building sentences using common phrases describing how to change
colors.

For more information, refer to the help for your print driver.

Color Adjustments

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include lightness,
contrast, saturation, and color cast.
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j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or driver type.

The following options are available:

e Lightness: The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

e Contrast: You can use the Contrast feature to adjust the variation between light and dark areas of the print job.
e Saturation: The Saturation feature allows you to adjust the color strength and the amount of gray in the color.

o Color Cast: Use the Color Cast settings to adjust the amount of a selected color in the print job and preserve
lightness. The following settings are available:

— The Cyan to Red slider allows you to adjust the color balance between cyan and red. For example, when you
increase the cyan levels, the red levels decrease.

— The Magenta to Green slider allows you to adjust the color balance between magenta and green. For
example, when you increase the magenta levels, the green levels decrease.

— The Yellow to Blue slider allows you to adjust the color balance between yellow and blue. For example, when
you increase the yellow levels, the blue levels decrease.

PRINTING MULTIPLE PAGES TO A SINGLE SHEET

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Toprint 1, 2, 4,6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet.

¢ To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.

e To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

1 | 4

To print a border around each page, select Page Borders.

PRINTING BOOKLETS

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any
paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of paper, two page
images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create
the booklet.

162 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Printing

e To locate booklet creation in Windows, on the Document Options tab, click Page Layout.

e To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Booklet Layout.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.
e QGutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the
thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can
select a value from zero to 1 point.

GUTTER CREEP

—

fo Note: To print a border around each page, select Page Borders.

USING SPECIAL PAGES
The Special Pages options control how covers, inserts, and exception pages are added to your printed document.
e To locate Special Pages in Windows, on the Document Options tab, click Special Pages.

e To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Special Pages.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that are
different from the source used for the body of a document. For example, you can use your company letterhead for
the first page of a document. You can use heavyweight paper for the first and last pages of a report. You can use
any applicable paper tray as the source for printing cover pages.

In the Covers window, the following options are available:

e No Covers or Disabled: This option does not print cover pages. No cover pages are added to the document.
e Front Only: This option allows you to add a blank or printed front cover to your job.

e Back Only: This option allows you to add a blank or printed back cover to your job.

e Front and Back: Same: This option adds a front and back cover to your job, and applies the same printing and
paper settings for both covers.

e Front and Back: Different: This option adds a front and back cover to your job, and allows you to select
different printing and paper settings for each cover.
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After you make a selection for printing the cover pages, you can select the paper for the front and back covers by
size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, or both sides of the
cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated pages within
a document. The addition of an insert after designated pages within a document separates sections, or acts as a
marker or placeholder. Ensure that you specify the paper to use for the insert pages.

In the Inserts window, you can set the location, characteristics, and paper settings for the insert pages:
o Inserts: This option allows you to select where to place the insert.
¢ Quantity: Use this option to specify the number of pages to insert at each location.

e Pages: Use this option to specify where to place the inserts within the job. Separate individual pages or page
ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and
11, type1,6,9-11.

e Paper Settings: This option allows you to select the paper size, color, and type to use for the insert pages. To
use the same paper size, color, or type as the main body of the job, select Use Job Setting.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences, such as
page size, page type, and page color. You can change the side of the paper on which to print as your job requires. A
print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and
the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Exceptions window, you can set the location, characteristics, and paper settings for the exception pages:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages
1,6,9,10,and 11, type 1, 6, 9-11.

e Paper Settings: Allows you to select the paper size, color, and type to use for the exception pages. To print
exception pages on the same paper size, color, or type as the main body of the job, select Use Job Setting.

e 2-Sided Printing: Allows you to select 2-sided printing options for the exception pages. Available options are:
— 1-Sided Print: Prints the exception pages on one side only.

—  2-Sided Print: Prints the exception pages on both sides of the paper and flips the pages on the long edge.
You can bind the job on the long edge of the pages.

— 2-Sided Print, Flip on Short Edge: Prints the exception pages on both sides of the paper and flips the
pages on the short edge. You can bind the job on the short edge of the pages.

— Use Job Setting: Prints the job using the same 2-Sided Printing setting that is selected for the main body
of the job.

j’ Note: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected
results.
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PRINTING ANNOTATIONS FOR WINDOWS

An annotation is special-purpose text or an image that you can print across one or more pages. You can preview
annotations in the Annotations Preview pane.

The annotations setup for your print job appears in the Annotations summary list. From this list, you can select an
annotation to edit or delete.

f Note:

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

To print an annotation:
1. In the print driver, click the Document Options tab.
2. Click the Annotations tab.

3. To add a text annotation, click Add Comment. Enter the text in the field, select the required settings, then click
OK.

4. For a date or time stamp, click Add Time Stamp. Specify the date and time option, select the required settings,
then click OK.

5. To add a picture annotation, click Add Picture. To locate the picture, click the Browse icon. Select the required
settings, then click OK.

6. For each annotation, the following options are available:
e To specify the font, click the Font button.

e For a picture annotation, select the scaling option that specifies the size of the picture in relation to the
original image. Use the arrows to scale the image in increments of 1%.

e To define the angle of the annotation on the page, specify the position option. Or, to rotate the annotation
left or right by increments of 1, use the arrows.

e To define the location of the annotation on the page, specify the position option. Or, to move the
annotation in each direction in increments of 1, use the arrows.

e To adjust the transparency of the annotation, move the slider. To increase transparency, move the slider to
the right, or to decrease transparency, move the slider to the left.

e For Layering, select an option:
— Print in Background: This option prints the annotation behind the text and graphics in the document.
— Print in Foreground: This option prints the annotation over the text and graphics in the document.
e For Pages, select the pages to print the annotation:
— Print on All Pages: This option prints the annotation on all pages of your document.
—  Print on Page 1 Only: This option prints the annotation only on the first page of the document.
7. To save the annotation, click the Save Annotation icon.
8. To load a previously saved annotation, click the Load Annotation icon.

9. Click OK.
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PRINTING WATERMARKS FOR WINDOWS

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word
like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

j’ Note:

e This feature is available only on a Windows computer printing to a network printer.

» Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than one
page is printed on a sheet of paper.

To print a watermark:
1. Inthe print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a
customized watermark. You can also manage watermarks from this menu.

4, Under Text, select an option:
o Text: Enter the text in the field, then specify the font.
e Time Stamp: Specify the date and time options, then specify the font.
e Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.

e Select the scaling option that specifies the size of the picture in relation to the original image. Use the
arrows to scale the image in increments of 1%.

o To define the angle of the image on the page, specify the position option, or to rotate the image left or
right by increments of 1, use the arrows.

e To define the location of the image on the page, specify the position option, or to move the image in each
direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.
e Print in Background prints the watermark behind the text and graphics in the document.

e Blend: This option combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

e Print in Foreground prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:

e Print on All Pages prints the watermark on all pages of your document.

e Print on Page 1 Only prints the watermark only on the first page of the document.
8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.
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ORIENTATION
Orientation allows you to select the direction that the page prints.

e To locate orientation options in Windows, on the Document Options tab, click Orientation.

j’ Note: The orientation setting in your application print dialog box can override the orientation options in the
print driver.

e To locate orientation options on Macintosh, in the Print window, click Show Details.
The following options are available:

e Portrait: Orients the paper so that the text and images print across the short dimension of the paper.

o Landscape: Orients the paper so that the text and images print across the long dimension of the paper.

A

e Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long bottom
side up.

v

f Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check
box.

ADVANCED PRINTING OPTIONS

You can use the Advanced option or tab to set advanced printing options. Advanced printing selections apply to all
jobs that you print with the print driver.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can print the job
identification on a separate banner page or on the pages of your document.

The following options are available:
e Disable Job ID: This option directs the printer not to print a banner page.
e Print ID on a Banner Page: This option prints the job identification on a banner page.

e Print ID in Margins - First Page Only: This option prints the job identification on the first page of the
document in the top-left margin.

e Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on every page of
the document.
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Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Job Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the
name of the job and the name of the printer where it was printed.

f” Note: This feature is only available on a Windows computer that is printing to a network printer.

The following options are available:
* Notify for Completed Jobs: This option provides a notification when the job has completed.

» Notify for Completed, but Altered Jobs: This option provides a notification on all jobs that completed with
restrictions.

» Notify for Failed or Canceled Jobs: This option provides notification of all jobs that failed to print or were
canceled.

o Play Alert Tone: This option sounds an alert tone when a notification appears.

Document Encryption for Windows Print Jobs

You can select encryption for your print job. The print file is encrypted before it is transmitted to the printer. The
print file is decrypted before it is printed.

This feature is available only when Document Encryption is set to Manually Encrypt Documents in the printer
properties of the printer. For details, refer to Setting Encryption Defaults in Windows.

_tf’ Note: This feature is available on a Windows computer that is printing to a network printer. It applies to the
PostScript and PCL print drivers.

Setting Encryption Defaults in Windows

1. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.
e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

f” Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
' Personalize. Select Control Panel Home > Devices and Printers.

2. For your printer, select Printing properties:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printer properties.

e For Windows 10, click the icon for your printer, then click Manage > Printer properties.

e For Windows 11 and later, click the icon for your printer, then click Printing preferences.
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3. Inthe Printer Properties dialog box, click the Administration tab.

4. For Configurations, click Document Encryption, then select an option:
e Disabled: This option disables encryption for all documents that you send to the printer.
e Encrypt All Documents: This option encrypts all documents that you send to the printer.

e Manually Encrypt Documents: This option allows you to set encryption for specific jobs that you send to
the printer.

j’ Note: Manually Encrypt Documents is the default printer setting.

5. Click Apply.

6. To save the settings, click OK.
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Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the
printer. For details, refer to Supported Paper.

DEFINING CUSTOM PAPER SIZES

To print on custom paper sizes, define the custom width and length of the paper in the print driver software and on
the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the
tray. Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you
print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver
Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.
For details on supported paper sizes for each tray, refer to Supported Paper.

For further details about creating and saving custom paper sizes in the print driver, click the Help (?) button in the
bottom-left corner of the printer settings window.

Creating and Saving Custom Sizes for the Windows V3 Print Driver
1. Inthe print driver, click the Printing Options tab.
For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > New.

In the New Custom Paper Size window, enter the height and width of the new size.

& wWN

To specify the units of measurement, at the bottom of the window, click Measurements, then select Inches or
Millimeters.

5. Tosave, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for the Windows V4 Print Driver
1. From Windows Control Panel, select Devices and Printers.
Select the printer, then click Print server properties.

On the Forms tab, for Create a new form, click the check box.

For Form name, type a name for the new paper size.

v &wN

In the Form description (measurements) areq, enter the settings:

e For Units, select Metric or English.

e For Paper size, enter measurements for Width and Height.

e For Printer area margins, enter measurements for Left, Right, Top, and Bottom.
j’ Note: Ensure that the measurements that you specify are within the supported ranges for the device.
6. Click OK.

The new paper size is added to the paper size list.
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Creating and Saving Custom Sizes for Macintosh

1. Inthe application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign ( +).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

o v &~ W N

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User Defined
margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from Tray 5. If Trays 1 and 2 are set to Fully Adjustable mode, you can print
custom-size paper from Trays 1 and 2. Custom-size paper settings are saved in the print driver and are available for
you to select in all your applications.

j’ Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Tray
Settings.

1. Open the paper tray, then load the custom-size paper.
Close the tray.
At the control panel, to define the new paper size, touch Size, then touch Custom.

In the Custom Paper Size window, enter the height and width of the new paper size, then touch OK.

v &wN

To confirm the settings, touch Confirm.

PRINTING ON CUSTOM-SIZE PAPER

f Note: Before you print on custom-size paper, define the custom width and length of the paper in the print
driver software and on the printer control panel. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom-Size Paper from the Windows V3 Print Driver

j’ Note: Before you print on custom-size paper, define the custom size in the Printer Properties. For details, refer
to Creating and Saving Custom Sizes for the Windows V3 Print Driver.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.

Select any other required options, then click OK.

o v & W N

In the Print dialog box, click Print.
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Printing on Custom-Size Paper from the Windows V4 Print Driver

j’ Note: Before you print on custom-size paper, define and save the custom paper size as a Form. For details,
refer to Creating and Saving Custom Sizes for the Windows V4 Print Driver.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select Other Size.

To select a custom paper size, select Fit to New Paper Size, then select the custom paper size.

Select any other required options, then click OK.

N o v & W N

In the Print dialog box, click Print.

Printing on Custom-Size Paper from Macintosh

1. Load the custom-size paper. For details, refer to Loading Paper.
In the application, click File > Print.

From the Paper Size list, select the custom paper size.

Click Print.

& W N
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Print From

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.support.xerox.com.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
Adjust the feature settings as needed.
Touch Print.

When you are finished, remove the USB Flash drive.

0 N o

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.

v &~ W N

Touch Print.

f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add Document, touch
Saved Jobs, then navigate to the job required.

7. Toreturn to the Home screen, press the Home button.
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PRINTING FROM A MAILBOX

The print from mailbox feature allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mailboxes, then touch the name of the folder that contains the document.

f Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.support.xerox.com.

Touch the name of the document that you want to print.
Select the options for paper supply, quantity, 2-sided printing, and finishing.

Touch Print.

o v & W

To select another job in the mailbox, touch the current job name, then touch Remove. Touch Add Document,
touch Mailboxes, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PRINTING FROM THE EMBEDDED WEB SERVER

You can print .pdf, .ps, .pcl, and .xps files directly from the Embedded Web Server without need of another
application or the print driver. The files can be stored on a local computer hard drive, mass storage device, or
network drive.

To print from the Embedded Web Server:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, refer to Finding the IP Address of Your Printer.
2. Inthe Embedded Web Server, click the Print tab.

3. To select the file from a local network or remote location, for File Name, click Browse, select the file, then click
Open.

4. For Printing, select the desired options for the job.
e Normal Print prints a job immediately.
e Secure Print prints a job after you enter your passcode at the printer control panel.

e Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining copies at
the printer.

e Save Job for Reprint saves a print job in a folder on the print server for future printing. You can specify a
job name and folder.

Delay Print prints a job at a specified time up to 24 hours from the original job submission.
5. If Accounting is enabled, enter your User ID and account information.

6. Click Submit Job.
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j’ Note: To ensure that the job was sent to the queue, wait for the job submission confirmation message to
appear before you close this page.
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Paper and Media Overview

The printer has five paper trays:

Tray 1 is an adjustable paper tray for loading a range of paper sizes.
For the 3-Tray configuration, Trays 2, 3, and 4 are adjustable trays similar to Tray 1.

For the Tandem Tray configuration, Tray 2 is an adjustable paper tray, and Trays 3 and 4 are high-capacity trays
that can hold A4, Letter, JIS B5, and Executive size paper.

Tray 5 is designed for loading small amounts of special paper.

The optional Envelope Tray can replace Tray 1. Tray 6 is an optional high-capacity paper tray holding A4, Letter, JIS
B5, or Executive size paper.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed, cardstock,
labels, transparencies, and envelopes. Ensure that you use the correct media for the tray that you are loading. You
can load all types of media in Tray 5.

Labels inside each tray show the correct orientation for loading certain types of media. The MAX label shows the
maximum fill line for the tray.
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Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid
jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

RECOMMENDED MEDIA
A list of paper and media recommended for your printer is available at:

e https://www.xerox.com/downloads/usa/en/supplies/rml/AltaLink_C8030_C8035_C8045_C8055_RML.pdf
Recommended Media List (United States)

e https://www.xerox.com/downloads/europe/r/2017_05_AltalLinkC8030-C8055_Media_List_Antalis_Xerox_May_
2017.pdf Recommended Media List (Europe)

ORDERING PAPER

To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/supplies.

GENERAL PAPER LOADING GUIDELINES

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

PAPER THAT CAN DAMAGE YOUR PRINTER

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer.
Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled
e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
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Padded envelopes
Plastic media

Iron on transfer paper

@ Caution: The Xerox® Warranty and Service Agreement do not cover damage caused by the use of
unsupported paper or special media.

PAPER STORAGE GUIDELINES

Storing your paper and other media properly contributes to optimum print quality.

Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

Reduce the exposure of paper to strong lights for long periods of time.

Maintain constant temperatures and relative humidity.

Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
Store paper flat, either on pallets, cartons, shelves, or in cabinets.

Avoid food or drinks in the area where paper is stored or handled.

Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in
the original packaging. The paper wrapper protects the paper from moisture loss or gain.

Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are
ready to use it. Keep unused media in the bag and reseal it for protection.

SUPPORTED PAPER TYPES AND WEIGHTS

Trays 3 and 4 of the 3-Tray Module | Custom

TRAYS PAPER TYPES WEIGHTS
Trays 1 and 2 Bond 60-105 g/m?

Hole-punched
Letterhead
Plain
Pre-printed
Recycled

Transparency

Labels 106-169 g/m?
Lightweight Cardstock

Lightweight Glossy Cardstock

Cardstock 170-256 g/m?
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PAPER TYPES

Cardstock Reloaded
Glossy Cardstock
Glossy Cardstock Reloaded

Paper and Media

WEIGHTS

Trays 3 and 4 of the Tandem Tray
Module

Tray 6

Bond
Custom
Hole-punched
Letterhead
Plain
Pre-printed
Recycled

Transparency

60-105 g/m?

Labels
Lightweight Cardstock

Lightweight Glossy Cardstock

106-169 g/m?

Cardstock

Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded

170-256 g/m?

Tray 5

Bond
Custom
Hole-punched
Letterhead
Plain
Pre-printed
Recycled

Transparency

55-105 g/m?

Envelopes

75-90 g/m?

Labels
Lightweight Cardstock

Lightweight Glossy Cardstock

106-169 g/m?
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TRAYS

PAPER TYPES

Cardstock

Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded

WEIGHTS
170-256 g/m?

Heavyweight Cardstock
Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

257-280 g/m?

Envelope Tray

Envelopes

75-90 g/m?

f Note:

e Reloaded paper is paper that was previously printed or copied on the printer. Use reloaded media for
manual 2-sided printing of media types that cannot be used for automatic 2-sided printing.

e Pre-cut tabs are not supported.

SUPPORTED STANDARD PAPER SIZES

TRAY NUMBER
Trays 1 and 2
Trays 3 and 4 of the 3-Tray Module

EUROPEAN STANDARD SIZES
A5 (148 x 210 mm, 5.8 x 8.3in.)
A4 (210x 297 mm, 8.3 x 11.7 in.)
A3 (297 x 420 mm, 11.7 x 16.5in.)
B5 (176x250 mm, 6.9 x 9.8 in.)

B4 (250 x 353mm, 9.8 x 13.9 in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

JISB4 (257 x 364 mm, 10.1 x 14.3
in.)

NORTH AMERICAN STANDARD
SIZES

Statement (140x216 mm, 5.5 x 8.5
in.)

Executive (184 x 267 mm, 7.25 x
10.51in.)

Letter (216 x 279 mm, 8.5x 11in.)

US Folio (216 x 330 mm, 8.5x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)
Tabloid (279 x 432 mm, 11 x 17 in.)

Tray 2
Trays 3 and 4 of the 3-Tray Module

SRA3 (320 x 450 mm, 12.6 x
17.7in.)

12x18 (305 x 457 mm, 12x 18
in.)

Trays 3 and 4 of the Tandem Tray
Module

A4 (210x 297 mm, 8.3 x 11.7in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

Letter (216 x 279 mm, 8.5x 11in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)
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TRAY NUMBER

EUROPEAN STANDARD SIZES

Paper and Media

NORTH AMERICAN STANDARD
SIZES

Tray 5 A6 (105 x 148 mm, 4.1 x 5.8 in.) Postcard (89 x 140 mm, 3.5 x
5.5in.
A5 (148 x 210 mm, 5.8 x 8.3 in.) in.
Postcard (102 x 152 ,Ax6in.
AL (210 297 mm, 83 x 1171y | Losteard (102x152mm, 4x61in.)
5x7(127x178 ,5x7in.
A4 Oversized (223 x 297 mm, x7 L X mm, 5 x 71in.)
8.8x11.7in.) Statement (140x216 mm, 5.5 x 8.5
215X 315 (215 x 315 mm, in.
8.5x12.4in.) Executive (184 x 267 mm, 7.25 x
10.5in.
A3 (297 x 420 mm, 11.7 x 16.5 in.) in.
8 x 10 (203 x 254 ,8x10in.
B6 (125x176 mm, 4.9 x 6.9 in.) x10(203x 254 mm, 8 x101n.
Letter (216 x 279 ,85x 11 in.
BS (176x250 mm, 6.9 x 9.8 in.) etter (216 x 275 mm, 8.5 x 11 in.)
9x11(229x 279 ,9x 11 in.
B4 (250 x 353 mm, 9.8 x 13.9 in.) x11(229x 279 mm, 9x 11 in.
US Folio (216 x 330 ,85x13
JISBS (182 257 mm, 7.2x10.1 | - olio (216 x 330 mm. 8.5 x
in.) '
8.5x13.4(216 x 340 ,8.5
JIS B4 (257 x 364 mm, 101 x 143 x 134 (216 x 340 mm, 8.5 x
) 13.41n.)
SRA3 (320 x 450 mm. 12.6 x 17.7 Legal (216 x 356 mm, 8.5 x 14in.)
in.) Tabloid (279 x 432 mm, 11 x 17 in.)
DL envelope (110x220 mm, 12x18 (305 x 457 mm, 12x 18
4.33x8.66 in.) in.)
C6 envelope (114 x 162 mm, 12x19 (305 x 483 mm, 12x 19
4.5x6.38 in.) in.)
C5 envelope (162 x 229 mm, 6.4x9 | Envelope (152 x 228 mm, 6 x 9 in.)
in) Envelope (228 x 305 mm, 9 x 12
C4 envelope (229 x 324 mm, in.)
9x12.8 in.
X in.) Monarch envelope (98 x 190 mm,
3.9x7.5in.)
No. 9 envelope (98 x 225 mm, 3.9 x
8.9in.)
No. 10 envelope (105 x 241 mm,
4.1x9.5in.)
Tray 6 A4 (210 x 297 mm, 8.3 x 11.7in.) Letter (216 x 279 mm, 8.5x 11in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)
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SUPPORTED PAPER SIZES AND WEIGHTS FOR AUTOMATIC 2-SIDED PRINTING

EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

A5 (148 x 210 mm, 5.8 x 8.3 in.) Statement (140x216 mm, 5.5 x 8.5 in.)
A4 (210 x 297 mm, 8.3 x 11.7in.) Executive (184 x 267 mm, 7.25 x 10.5in.)
A3 (297 x 420 mm, 11.7 x 16.5in.) Letter (216 x 279 mm, 8.5x 11in.)
JISB5 (182 x 257 mm, 7.2 x 10.1in.) US Folio (216 x 330 mm, 8.5x 13 in.)
JISB4 (257 x 364 mm, 10.1 x 14.3in.) Legal (216 x 356 mm, 8.5 x 14in.)
Tabloid (279 x 432 mm, 11 x 17 in.)

In addition to the standard sizes, you can use custom-size paper within the following ranges for 2-sided printing:
e Minimum size 128 x 140 mm (5 x 5.5in.)
e  Maximum size 320 x 483 mm (12.6 x 19 in.)

Paper weights from 60 g/m? through 220 g/m? are supported for automatic 2-sided printing.

j’ Note: Do not use transparencies, envelopes, labels, or reloaded paper for automatic 2-sided printing.

SUPPORTED PAPER SIZES FOR THE ENVELOPE TRAY

EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

DL (110 x 220 mm, 4.33 x 8.66 in.) Envelope (152 x 228 mm, 6 x 9 in.)

C6 (114 x 162 mm, 4.5x 6.38in.) Monarch (98 x 190 mm, 3.9 x 7.5 in.)

C5(162x 229 mm, 6.4 x 9 in.) No. 9 (98 x 225 mm, 3.9 x 8.9 in.)
No. 10 (105 x 241 mm, 4.1 x9.5in.)

SUPPORTED CUSTOM PAPER SIZES

TRAY NUMBER PAPER SIZES

Tray 1 Minimum: 140 x 182 mm (5.5 x 7.5 in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)

Tray 2 Minimum: 140 x 182 mm (5.5 x 7.5 in.)
Trays 3 and 4 of the 3-Tray Module Maximum: 320 x 457 mm (12.5x 18 in.)
Trays 3 and 4 of the TandemTray Module Standard sizes only:

A4 (210x 297 mm, 8.3 x 11.7 in.)
Letter (216 x 279 mm, 8.5x 11in.)
JISB5 (182 x 257 mm, 7.2 x 10.1 in.)
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TRAY NUMBER PAPER SIZES

Executive (184 x 267 mm, 7.25 x 10.5in.)

Tray 5 Minimum: 89 x 98 mm (3.5x 3.9 in.)
Maximum: 320 x 483 mm (12.6 x 19 in.)

Tray 6 Standard sizes only:

A4 (210x 297 mm, 8.3 x 11.7in.)

Letter (216 x 279 mm, 8.5x 11in.)
JISB5 (182 x 257 mm, 7.2 x 10.1in.)
Executive (184 x 267 mm, 7.25x 10.5in.)

Envelope Tray Minimum: 98 x 148 mm (3.9 x 5.8 in.)

Maximum: 162 x 241 mm (6.4 x 9.5 in.)
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Paper Tray Settings

CONFIGURING TRAY SETTINGS

The system administrator can set trays to Fully Adjustable or Dedicated mode. When a paper tray is set to Fully
Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type and color.

To configure the tray settings:
1. At the printer control panel, touch Device.
2. Touch Tools, then touch Device SettingsPaper Management.
3. Touch Tray Settings, then select a tray.
e To set the mode, touch Fully Adjustable or Dedicated.

o To specify the paper settings for a dedicated tray, touch Edit, then set the paper size, type, and color. Touch
OK.

e To configure the printer to select the tray automatically, for Auto Selection, touch Enabled.

e To set the priority for each tray, touch the number field. To enter a number, use the alphanumeric keypad,
or touch the plus icon ( +) or the minus icon (-). The printer uses paper from the Priority 1 tray first. If that
tray is empty, the printer uses paper from the Priority 2 tray.

4, Touch OK.
5. To close Tray Settings, touch X.

6. To close Tools, touch X.

f Note: To access the Paper Management menu, log in as the system administrator. For details, refer to the
System Administrator Guide at www.support.xerox.com.

CHANGING PAPER SIZE, TYPE, AND COLOR

When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When you close the tray, the control panel prompts you to set the paper size, type, and color of paper loaded.

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type, and
color. If you move the guides to load a different paper size, the control panel displays an error message.

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Tray Settings.
To set the paper size, type, or color when a tray is set to Fully Adjustable:
1. Open the paper tray, then load the required paper.
2. Close the tray.
3. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e To select a new paper type, touch Type.

e To select a new paper color, touch Color.
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4. To confirm the settings, touch Confirm.

To set the paper size, type, or color when a tray is set to Dedicated, refer to Configuring Tray Settings.
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Loading Paper

LOADING PAPER IN TRAYS 1-4

The system administrator can set Trays 1-4 to Fully Adjustable or Dedicated mode. Each time a tray is opened and
closed, the paper settings appear on the control panel:

e The Fully Adjustable mode allows you to confirm or change the media settings. The tray guides detect
automatically the size of paper loaded.

e The Dedicated mode displays the media settings for the tray. A warning message appears on the control panel
when the wrong media is loaded, and the tray guides are set incorrectly.

f Note: Only the system administrator can change the media settings for a Dedicated tray.

A warning message appears on the control panel when the paper in the tray is in short supply, and when a tray is
empty.

To load Trays 3 and 4 of the Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray.

1. Pull out the tray until it stops.

2. Ensure that the paper-guide locks are set in the correct position for the standard or custom-size paper that you
are loading. For details, refer to Adjusting the Paper Guides in the 520-Sheet Adjustable Trays.

3. Remove any paper that is a different size or type.
4. To move out the length and width guides:

a. Pinch the guide lever on each guide.

b. Slide the guides outward until they stop.

c. Release the levers.
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5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This
procedure separates any sheets that are stuck together and reduces the possibility of jams.

fo Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
6. Load paper in the tray. Position the paper against the left side of the tray.

e For long-edge feed, insert letterhead and pre-printed paper face down with the top edge toward the front
of the tray. Load hole-punched paper with the holes to the left.

e For short-edge feed, insert letterhead and pre-printed paper face down with the top edge to the left. Load
hole-punched paper with the holes toward the rear of the printer.

fc Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

7. Adjust the length and width guides until they touch the edges of the paper.
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8. Close the tray.

;

9. At the control panel, if a prompt appears, select the correct paper size, type, and color.
e To select a new paper size, touch Size.

e To select a new paper type, touch Type. For letterhead paper, select Letterhead. For pre-printed paper,
select Pre-Printed. For hole-punched paper, select Hole Punched.

e To select a new paper color, touch Color.

f Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.support.xerox.com.

10. To confirm the settings, touch Confirm.

f Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Tray
Settings.

ADJUSTING THE PAPER GUIDES IN THE 520-SHEET ADJUSTABLE TRAYS

You can adjust the paper guides in Trays 1-4 to accommodate standard or custom paper sizes. In the standard
position, the guides move into the supported standard paper settings. In the custom position, the guides move in 1-
mm (0.04 in.) increments.

To move the paper guides from the standard to the custom paper-size position:

1. Pull out the tray until it stops.
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2. Remove any paper from the tray, pinch the guide levers, and move the guides outward until they stop.

5. Load the custom-size paper in the tray.

6. To engage the fine-adjustment block, pinch the levers and slide the guides inward. The tray guides move in
increments of Tmm.
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LOADING PAPER IN TRAYS 3 AND 4 OF THE TANDEM TRAY

The Tandem Tray Module holds larger amounts of paper for fewer printing interruptions. It contains three trays.
Tray 2 holds paper sizes up to SRA3/12 x 18 in. Trays 3 and 4 hold A4-size (210 x 297 mm), Letter-size (8.5 x 11 in.),
JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper only.

The control panel displays a warning message when the paper in the tray is in short supply, or when a tray is empty.
To change the paper size, refer to Configuring Trays 3 and 4 of the Tandem Tray Module.

To load Tray 2, refer to Loading Paper in Trays 1—4.

1. Pull Tray 3 or Tray 4 out until it stops. Wait for the tray to lower and stop.

2. The control panel displays the paper tray settings. Ensure that you load the correct paper type.

f Note: Do not load custom-size paper into Tray 3 or Tray 4 of the Tandem Tray Module.

3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any sheets of paper
that are stuck together and reduces the possibility of paper jams.

f Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

4. Stack the paper against the left rear corner of the tray as shown.
e Insert letterhead and pre-printed paper face down with the top edge toward the front of the tray.

e Load hole-punched paper with the holes to the left.

fo Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

5. Close the tray.
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LOADING PAPER IN TRAY 5

Tray 5 supports the widest variety of media types. You can use the tray for small-quantity jobs that use special
paper, such as labels, transparencies, and envelopes. The tray extension provides support for larger paper sizes.

f Note:

e Use Tray 5 to load heavyweight paper types (257-280 g/m?).

e For faster print speeds, load paper 320 mm (12.6 in.) or shorter with the long edge going into the printer.
e Load paper longer than 320 mm (12.6 in.) with the short edge going into the printer.

e To load labels, refer to Loading Labels in Tray 5.

e To load transparencies, refer to Guidelines for Printing on Transparencies.

1. Open Tray 5, then for larger paper sizes, pull out the extension tray. If Tray 5 is already open, remove any paper
that is a different size or type.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This
procedure separates any sheets that are stuck together and reduces the possibility of jams.

w2
/ Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
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4. Load the paper in the tray.

e For long-edge feed, insert letterhead and pre-printed paper face up with the top edge toward the front of
the tray. Load hole-punched paper with the holes leading into the printer.

e For short-edge feed, insert letterhead and pre-printed paper face up with the top edge leading into the
printer. Load hole-punched paper with the holes toward the rear of the printer.

fo Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

5. Adjust the width guides until they touch the edges of the paper.

6. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.

e To select a new paper type, touch Type. For letterhead paper, touch Letterhead. For pre-printed paper,
touch Pre-Printed. For hole-punched paper, touch Hole Punched.

e To select a new paper color, touch Color.
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7. To confirm the settings, touch Confirm.

LOADING PAPER IN TRAY 6

Tray 6 is an optional high-capacity, dedicated paper tray. It is on the left side of the printer. The tray feeds A4 (210
x 297 mm), Letter (8.5 x 11 in.), JIS B5 (182 x 257 mm), or Executive (7.25 x 10.5 in.) paper. The tray capacity is
2000 sheets.

The control panel displays a warning message when the paper in the tray is in short supply, or when the tray is
empty.

To change the paper size, refer to Configuring Tray 6.
1. Pull out Tray 6 from the feeder until it stops.

2. Open the side gate until it stops.

3. The control panel displays the paper settings. Ensure that you load the correct paper type in the tray.
f Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. This procedure separates any sheets of paper
that are stuck together and reduces the possibility of paper jams.

f Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.
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5. Load the paper against the right side of the tray.
e Insert letterhead and pre-printed paper face up with the top edge toward the front of the tray.
e Load hole-punched paper with the holes toward the right side of the tray.

fo Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Close the tray.
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Printing on Special Paper
To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/supplies.
For reference:

https://www.xerox.com/downloads/usa/en/supplies/rml/AltaLink_C8030_C8035_C8045_C8055_RML.pdf :
Recommended Media List (United States)

https://www.xerox.com/downloads/europe/r/2017_05_AltalLinkC8030-C8055_Media_List_Antalis_Xerox_May_
2017 .pdf : Recommended Media List (Europe)

ENVELOPES

You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can print envelopes
from Tray 1.

Guidelines for Printing Envelopes
e Use only paper envelopes.
e Do not use envelopes with windows or metal clasps.

e Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try
another envelope brand.

e Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality
and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.

e Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of the
envelopes.

e In the print driver software, select Envelope as the paper type.
e Do not use padded envelopes. Use envelopes that lie flat on a surface.
e Do not use envelopes with heat-activated glue.

e Do not use envelopes with press-and-seal flaps.

Loading Envelopes in Tray 5
1. Open Tray 5. Remove any paper or envelopes that are a different size or type.

2. Move the width guides to the edges of the tray.
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3. Load envelopes in the tray.

e For envelopes with the flap on a long edge, load envelopes with the flaps closed, flaps up, and flaps on the
leading edge, toward the right.

e For envelopes with the flap on a short edge, load envelopes with the flaps closed, flaps up, and flaps on the
leading edge, toward the right.

4. Center the stack of envelopes. Adjust the guides so that they touch the edges of the envelopes.
5. At the control panel, select the correct paper size, type, and color.

e To select an envelope size, touch Size. To specify a custom envelope size, touch Custom, then specify the
dimensions of the envelope.

e For a custom envelope size, touch Type, then touch Envelope.
e To select a new envelope color, touch Color.

f Note: When you select an envelope size from the list, the paper type is set to Envelope.

6. To confirm the settings, touch Confirm.

Loading the Envelope Tray

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray holds the following envelope sizes:
e Envelope 6 x 9, Monarch, No. 9, and No.10

e DL, C5,and C6
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1. Pull out the Envelope Tray until it stops.

2. Load envelopes in the tray.

e For envelopes with the flap on a long edge, load envelopes with the flaps closed, flap-side down, and the
flaps on the left side of the tray.

e For envelopes with the flap on a short edge, load envelopes with the flaps closed, flap-side down, and the
flaps on the left side of the tray.
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3. Adjust the paper guides so that they rest lightly against the edges of the envelopes.

Ensure that the envelope stack height is less than 43 mm (1.7 in.) or that there are no more than 60 envelopes
loaded in the tray.

Close the tray.
At the control panel, if a prompt appears, select the correct envelope size and color.
e To select a new envelope size, touch Size.

e To select a new envelope color, touch Color.

¢ Note:

e Ifa prompt does not appear and you have changed the envelope size or color, update the Required
Paper Policies. For details, refer to the System Administrator Guide at www.support.xerox.com.

e When the Envelope Tray is installed, the paper type is set to Envelope.

7. To confirm the settings, touch Confirm.

LABELS

You can print labels from any tray.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until
ready to use. Return any unused sheets of labels to the original packaging and reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in
extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the
printer.

In the print driver software, select Label as the paper type.
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e Before loading labels, remove all other paper from the tray.

! Caution: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.
[t could damage the printer.

Loading Labels in Trays 1-4
1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.

3. Ensure that the guide locks are set in the correct position for the size labels that you are loading. For details,
refer to Adjusting the Paper Guides in the 520-Sheet Adjustable Trays.

f Note: Trays 1-4 can print labels 106—169g/m?.

4. Load labels in the tray.

e For long-edge feed, load labels face up, with the top edge toward the front of the tray.
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5. Close the tray.

6. At the control panel, if a prompt appears, select the correct paper size, type, and color.
e Ensure that the paper type is set to Labels. To select a new paper type, touch Type.
e To select a new paper size, touch Size.

e Toselect a new paper color, touch Color.

f Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.support.xerox.com.

7. To confirm the paper settings, touch Confirm.

Loading Labels in Tray 5

1. Open Tray 5, then for larger sizes, pull out the extension tray. If Tray 5 is already open, remove any paper that
is a different size or type.

A

2. Move the width guides to the edges of the tray.

WL
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3. Load the labels in the tray:
e For long-edge feed, load labels face down with the top edge toward the front of the tray.

e For short-edge feed, load labels face down with the top edge to the left.

fc Note:
e Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
e Do not print on label media after a label has been removed from a sheet.
e To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

4. Adjust the width guides until they touch the edges of the paper.
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5. At the control panel, select the correct paper size, type, and color:
e Ensure that the paper type is set to Labels. To select a new paper type, touch Type.
e To select a new paper size, touch Size.
e To select a new paper color, touch Color.

6. To confirm the paper settings, touch Confirm.

GLOSSY MEDIA

You can print glossy paper, up to 256 g/m2, from any tray. You can print heavyweight glossy paper from Tray 5 only.

j’ Note: For best results, load Glossy Cardstock, and Glossy Cardstock Reloaded paper into Tray 5.

Guidelines for Printing on Glossy Paper

» Do not open sealed packages of glossy paper until you are ready to load them into the printer.

e Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until ready to use.
e Remove all other paper from the tray before loading glossy paper.

e Load only the amount of glossy paper that you are planning to use. Do not leave glossy paper in the tray when
you are finished printing. Reinsert unused paper in the original wrapper and seal.

e Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam
in the printer.

e In the print driver software, select the desired glossy paper type or select the tray loaded with the desired paper.

Loading Gloss Paper in the Bypass Tray
1. Before you load glossy paper, remove all other paper from the tray.
Load only the amount of paper you plan to use.

Load the paper with the glossy side or print side down.

& W N

At the control panel, select the correct paper size, type, and color:

e Ensure that the paper type is set to Glossy. To select a new paper type, touch Type.
e To select a new paper size, touch Size.

e To select a new paper color, touch Color.

5. To confirm the settings, touch Confirm.

TRANSPARENCIES

Transparencies can be printed from trays 1-5. For best results, use only recommended Xerox® transparencies.

(D Caution: The Xerox® Warranty and Service Agreement do not cover damage caused by the use of
unsupported paper or special media.
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Guidelines for Printing on Transparencies
e Before you load transparencies in the tray, remove all paper.
e Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print quality.
e Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.
e For clear or non-strip transparencies:

— Load transparencies face up into Trays 1-4.

— Load transparencies face down into the Bypass Tray.
e For striped transparencies:

— Load transparencies into Trays 1-4 with the strip face down on the right trailing edge.

— Load transparencies into the Bypass Tray with the strip face up on the left trailing edge.
¢ Do not fan transparencies.
e After you load transparencies, on the control panel, change the paper type to Transparency.

e In the print driver software, for the paper type, select Transparency.
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General Precautions

& Warning:

Internal parts of the printer can be hot. Use caution when doors and covers are open.
Keep all cleaning materials out of the reach of children.

Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain
explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray
cleaners increases the risk of fire and explosion.

Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any
parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not
described in the documentation supplied with your printer.

(D Caution:
L
e When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not
pour fluids directly into any area. Use supplies and cleaning materials only as directed in this
documentation.
e Do not place anything on top of the printer.
e Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light
exposure can damage the drum cartridges.
e Do not open covers and doors during printing.
e Do not tilt the printer while it is in use.
e Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.
e Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CLEANING THE PRINTER EXTERIOR
Regular cleaning keeps the touch screen and control panel free from dust and dirt.
To clean the printer exterior:

1. To avoid activating buttons and menus when cleaning the printer, press the Power/Wake button, then touch
Sleep.

2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft, lint-free cloth.

3. Toreturn the printer to Ready mode, press the Power/Wake button.

4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas of your
printer.
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Cleaning the Scanner

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with streaks,
smears, and other marks that transfer from the glass while scanning documents.

1. Slightly dampen a soft, lint-free cloth with water.
Remove any paper or other media from the output tray.

Open the document cover.

- W N

Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

f Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks.

6. Close the document cover.

Cleaning the Document Feed Rollers

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best performance, clean the
document feed rollers once a month.
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1. Lift the lever and open the top cover of the document feeder.

2. While turning the rollers, wipe them with a clean, lint-free cloth moistened with water.

@ Caution: Do not use alcohol or chemical cleaners on the document feed rollers.

3. Close the document feeder top cover.

Cleaning the Second-Side Scanning Lens Assembly

The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single pass of the
original. The assembly is on the left side of the document cover and includes a mirrored glass strip, a metal strip, a
white-plastic strip, and rollers.

f Note: Xerox recommends that you clean all parts of the second-side scanning lens assembly regularly.

To clean the second-side scanning lens assembly:

1. To access the second-side scanning lens assembly, lower the lever under the left side of the document cover.
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2. Toseparate the left end of the document cover from the lens assembly, continue to lower the lever.

3. Using a soft cloth moistened with water, wipe the mirrored glass, metal strip, both sides of the white-plastic
strip, and the rollers. If dirt is difficult to remove, moisten a soft cloth with a small amount of neutral detergent.
Then wipe the parts dry with a soft cloth.

@ Caution: To prevent damage to the film around the glass, do not press heavily on the mirrored glass.

LA TTTTTIENNNS

4. Return the document cover to its original position, ensuring the lever is locked in place. If you touch the
document cover with your bare hands, clean the cover before closing the document feeder.
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CLEANING THE PRINTER INTERIOR

Cleaning the Printhead Lenses

The printer is constructed with four printhead lenses. Clean all lenses as described in the following procedure.

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

3.
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4. Each of the four printheads has its own cleaning tool. Slowly pull out the LED printhead cleaner until the three
dots are visible.

‘fc Note: The LED printhead cleaner does not detach from the printer.

6. Repeat Steps 4 and 5 for each printhead.

7. Close the drum cartridge cover.
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9. Close the printer front cover.
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Supplies

CONSUMABLES

Consumable supplies are printer supplies that become depleted during the operation of the printer. Consumable
supplies for this printer include the following supplies:

e Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.
e Staple Cartridges and Staple Refills for the Optional Integrated Office Finisher.

e Staple Cartridges and Staple Refills for the Optional Office Finisher LX or the Office Finisher LX with Booklet
Maker.

e Staple Cartridges and Staple Refills for the Optional Business Ready Finisher or the Business Ready Finisher with
Booklet Maker.

f Note:

e Each consumable includes installation instructions. To replace consumables, refer to the instructions
included with the consumable supply.

e Only install new toner cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed can be inaccurate.

e To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined
point.

(D Caution: Use of toner other than genuine Xerox®Toner can affect print quality and printer reliability.
Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for
specific use with this printer.

ROUTINE MAINTENANCE ITEMS

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer-replaceable parts.

j’ Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Waste Toner Container

e Drum Cartridges

e Transfer Belt Cleaner

e Second Bias Transfer Roller

e Hole-Punch Waste Container
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ORDERING SUPPLIES

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to
your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/supplies.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox® Warranty and Service Agreement
do not cover damage, malfunction, or degradation of performance caused by the use of non-Xerox
supplies, or the use of Xerox supplies not specified for this printer.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control
panel.

You can customize the alerts that appear on the control panel and configure email alert notifications using the
Embedded Web Server.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System Administrator
Guide at www.support.xerox.com.

To check the supplies status at the control panel:
1. At the printer control panel, press the Home button.
2. To view status information for the printer supplies, touch Device > Supplies.

3. To view details about a specific toner cartridge, including the part number for reordering, touch Cyan,
Magenta, Yellow, or Black.

To return to the Supplies screen, touch X.
To view more details, touch Other Supplies. Scroll through the list, then select an option.
To return to the Supplies screen, touch X.

To print the Supplies Report, touch Print Supplies Report.

G N o v b=

To return to the Device screen, touch X.

TONER CARTRIDGES

& Warning:

e When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with
clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child
spit out the toner, and rinse out their mouth with water. Consult a physician immediately.
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& Warning: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner,
contact your local Xerox representative.

Warning: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch
fire and cause burn injuries or an explosion.

Replacing the Toner Cartridges

When it is time to replace a toner catridge, the printer displays a message on the control panel.
f Note: Each toner cartridge includes installation instructions.

To replace a toner cartridge:

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

2.
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3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and right 10
times.

6. Close the printer front cover.
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WASTE TONER CONTAINER

Replacing the Waste Toner Container
A message appears on the control panel when the waste toner container must be replaced.

When replacing the waste toner container, clean the printhead lenses. For details, see Cleaning the Printhead
Lenses.

® Caution: Spread paper on the floor to catch possible toner spills.

& Warning: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum cleaner
to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

)
& Note: Each waste container includes installation instructions.

To replace the waste toner container:

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.
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3. Pull the used waste toner container out slowly while supporting it with your other hand.

@/ /)

4. Place the used waste toner container in the plastic bag, then seal it firmly using the zipper.

5. Place the used waste toner container in the empty box.

7. Clean the printhead lenses. For details, refer to Cleaning the Printhead Lenses.

8. Close the front cover.
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DRUM CARTRIDGES

Replacing the Drum Cartridges

A message appears on the control panel when a drum cartridge must be replaced.
j’ Note: Each drum cartridge includes installation instructions.

To replace a drum cartridge:

@ Caution: Do not perform this procedure when the printer is copying or printing.

Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. Do
not touch or scratch the surface of the drum.

1. Open the front cover of the printer.

3. Pull the drum cartridge cover down until it clicks into the open position.
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4. Grip the orange handle of the drum cartridge as shown, then pull the drum cartridge straight out of the printer.
Place the used drum cartridge in the plastic bag and place in the box.

& Warning: Do not touch any toner adhering to the drum cartridge.

5. Remove the packing material from the end of the new drum cartridge.

6. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Load the cartridge in
the direction of the arrow on the top of the shield.

7. With the guides inserted in the slot, to remove the black paper sheet, pull it in the direction shown. Remove the
tape from the top of the cartridge shield.

8. Hold the shield, then use the orange handle to push the cartridge into the printer.
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9. Continue to push the orange handle until it stops.

11.  Close the drum cartridge cover.

13. Close the printer front cover.

14. Dispose of the protective shield and tape as normal office waste.
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TRANSFER BELT CLEANER

Replacing the Transfer Belt Cleaner

A message appears on the control panel when the transfer belt cleaner must be replaced.

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.
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4. Pullthe transfer belt cleaner straight out of the printer.

& Warning: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the transfer belt
cleaner or toner could spill.

5. Remove the new transfer belt cleaner from the packaging. Retain the packaging.

6. Place the used transfer belt cleaner in the plastic bag.

7. Remove the protective cover from the new transfer belt cleaner.

@ Caution: Do not touch the surface of the transfer belt cleaner. Doing so could deteriorate image quality.
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9. Push the orange knob in, then turn it clockwise until snug.

11.  Close the printer front cover.

SECOND BIAS TRANSFER ROLLER

Replacing the Second Bias Transfer Roller
When the second bias transfer roller needs to be replaced, a message appears on the control panel.

1. Remove paper from the left tray, then fold up the tray.
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2. To open Door A, open Tray 5, then lift the release lever and open Door A.

& Warning: The area around the fuser can be hot. To avoid injury, use caution.

Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality.

3. Remove the new transfer roller from the packaging. Retain the packaging.

4, Push the orange lever in the direction shown.
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5. Lift the used transfer roller out of the printer.

j’ Note: Do not touch any toner that adheres to the transfer roller.

6.

7.

9. To close Door A, push the door up firmly until it clicks into place, then close Tray 5.
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STAPLE CARTRIDGES AND STAPLE REFILLS

When a staple cartridge is empty, a message appears on the control panel.

Replacing Staples in the Integrated Office Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher front door.

\\/\Jf

Q
Z
b../

3. Check inside the finisher for any loose staples and remove them.

4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

N

Replacing Staples in the Office Finisher LX

Replacing Staples in the Main Stapler of the Office Finisher LX

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.

3. Push the stapler assembly to the right as shown.
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6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

clicks.

8. Close the finisher front door.

Replacing Staples in the Booklet Maker of the Office Finisher LX

& Warning: Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.
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2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide
them to the center.

4. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in the finisher.

f Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the
‘ cartridge.

fo Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple cartridges
contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the finisher side cover.
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Replacing Staples in the Business Ready Finisher

Replacing Staples in the Main Stapler of the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready finisher.
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4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

clicks.

7. Return the staple cartridge assembly to its original position.

Replacing Staples in the Booklet Maker of the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the front door of the Business Ready finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on the top edge
of the device.

3. Toremove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as shown, then
pull the cartridge out and up.

4. Turn over the staple cartridge.
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5. To permit the staple cartridge handle to open out and away from the staple pack, press in the green tabs, then
pull back the handle.

7. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.
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9. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the cartridge
handle as shown.

10.

Replacing Staples in the Convenience Stapler

1. Lift the lever at the rear of the convenience stapler, then gently rotate the staple head toward you.
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2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.
4. Install the new staple cartridge in the convenience stapler. The staple cartridge clicks into place.

5. Release the lever at the front of the convenience stapler, then gently rotate the staple head away from you.

EMPTYING THE HOLE PUNCH WASTE CONTAINER

A message appears on the control panel when the hole punch waste container is full.

Emptying the Hole Punch Waste Container in the Office Finisher LX

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Lift the finisher transport top cover, then open the front transport cover.
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2. Pull out the hole-punch waste container.

5. Close the finisher front transport cover, then close the top cover.

Emptying the Hole Punch Waste Container in the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the front door of the Business Ready finisher.

2. Remove the hole-punch waste container from its slot near the top left of the finisher.
yo Note:
e When you remove the hole punch waste container, wait 10 seconds before you reinsert it into the
printer. The hole punch counter resets after 10 seconds.

e If you remove the hole punch waste container before the device instructs you to, empty the container
before you reinsert it into the finisher.

3. Empty the container.
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Insert the container all the way into the finisher.

L

Close the front door of the Business Ready finisher.

RECYCLING SUPPLIES

For information on Xerox® supplies recycling programs, go to www.xerox.com/recycling .

Supplies include a prepaid return label. Please use it to return used components in their original boxes for recycling.

RESETTING SUPPLY LIFE COUNTERS

You must reset the supply life counters when you replace some supplies.

1.

o 0 N oo v W

At the printer control panel, press the Home button.

Touch the Log In button, enter the system administrator login information, then touch Done. For details, refer
to the System Administrator Guide at www.support.xerox.com.

Touch Device > Tools > Device Settings > Supplies.

Touch Supply Counter Reset.

To select an item to reset, touch the supply item in the list, then touch Reset Counter.
On the confirmation screen, touch Reset.

To return to the Tools screen, touch X, then touch X again.

To return to the Home screen, press the Home button.

Touch the Log In button, then touch Logout.
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Managing the Printer

VIEWING THE METER READING

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

j’ Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. Refer to the System Administrator
Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

To view more details, touch Usage Counters, then select an option.

After viewing the usage readings, to return to the Device screen touch X, then touch X again.

v W N

To return to the Home screen, press the Home button.

PRINTING THE BILLING SUMMARY REPORT

The Billing Summary Report provides information about the device and a detailed listing of the billing meters and
sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
Touch Device > Information Pages.

Touch Billing Summary, then touch Print.

& W N

To return to the Home screen, press the Home button.
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Moving the Printer

e Always power off the printer, then wait for the printer to shut down. To power off the printer, verify that there
are no jobs in the queue, press the Power/Wake button, then touch Power Off. After 10 seconds, the touch
screen goes dark and the printer powers down. Open the printer front door, then power off the main power
switch. For details, refer to Restarting, Placing in Sleep Mode, or Powering Off the Printer.

e Unplug the power cord from the electrical outlet, then disconnect the power cord from the back of the printer.

e To avoid spilling toner, keep the printer level.

j’ Note: When you move the printer over a long distance, to prevent toner from spilling, remove the drum
cartridges and toner cartridges. Pack the printer inside a box.

(D Caution: Failure to repackage the printer properly for shipment can result in damage not covered by the
Xerox® Warranty or Service Agreement. The Xerox® Warranty and Service Agreement do not cover
damage to the printer caused by improper moving.
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General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply
restarting the printer.

RESTARTING THE PRINTER

The printer has two power switches. The main power switch, located behind the front door, controls the main power
to the printer. The secondary power switch is the Power/Wake button on the control panel. The Power/Wake button
controls power to the printer electronic components, and when powered off, initiates a software-controlled
shutdown. The preferred method to power on and off the printer is to use the Power/Wake button.

To operate the printer, power on both switches:
1. Power on the main power switch.

2. At the control panel, press the Power/Wake button.

3. Torestart the printer:

a. At the control panel, press the Power/Wake button, then touch Restart. A message appears on the control
panel that warns you that the printer is restarting.

b. If the printer does restart after several minutes, open the front door, then power off the main power
switch. To restart the printer, power on the main switch, then press the Power/Wake button on the control
panel.

c. Close the front door.

If restarting the printer does not resolve the issue, see the table in this chapter that best describes the problem.
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PRINTER HAS TWO POWER SWITCHES

Troubleshooting

PROBABLE CAUSES SOLUTIONS

The printer has two power switches and one is not
powered on.

Power off the printer.
e Press the Power/Wake button on the control panel.

e Open the front door and power off the main power
switch.

Power on the printer.

e Open the front door, then power on the main
power switch.

e At the printer control panel, press the Power/Wake
button. For details, refer to Powering On the Printer
or Exiting Sleep Mode.

PRINTER DOES NOT POWER ON

PROBABLE CAUSES ‘ SOLUTIONS

The power switch is not switched on.

e Open the front door and check that the main power
switch is in the On position.

e At the printer control panel, press the Power/Wake
button. For details, refer to Powering On the Printer
or Exiting Sleep Mode.

The power cord is not plugged into the outlet correctly.

Power off the printer, then plug the power cord into the
outlet securely. Use the bracket provided with the
printer to secure the power cord in place.

Something is wrong with the outlet connected to the
printer.

e Plug another electrical appliance into the outlet
and check if it operates properly.

e Try a different outlet.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in the
Electrical Specifications.

@ Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. Do not use a
power strip. If necessary, contact a licensed electrician to install a properly grounded outlet.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide

249



Troubleshooting

PRINTER RESETS OR POWERS OFF FREQUENTLY

PROBABLE CAUSES SOLUTIONS

The power cord is not plugged into the outlet correctly. | Power off the printer. Confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer.

A system error occurred. Power off the printer, then power on again. If the error
persists, contact your Xerox representative.

The printer is connected to an uninterruptible power Only use an extension cord designed to handle the
supply (UPS), extension cord, or power strip. electrical current capacity of the printer. For details,
refer to Electrical Specifications.

A network configuration problem exists. Unplug the network cable. If the problem is not
resolved, contact your system administrator to
reconfigure your network installation.

The printer is connected to an outlet with a voltage or | Use a power source with the specifications listed in
frequency that does not match the printer Electrical Specifications.
specifications.

PRINTER DOES NOT PRINT

PROBABLE CAUSES SOLUTIONS

The printer is in Power Saver mode. On the control panel, press the Power/Wake button.

The printer has an error. If the Status LED is blinking amber, to clear the error,
follow the instructions on the control panel. If the error
persists, contact your Xerox representative.

The printer is out of paper. Load paper into the tray.

A toner cartridge is empty. Replace the empty toner cartridge.

A drum cartridge has reached end of life. Replace the drum cartridge.

No control panel indicators are lighted. Power off the printer, confirm that the power cord is

plugged in correctly to the printer and the outlet, then
power on the printer. If the error persists, contact your
Xerox representative.

The printer is busy. e If the Status LED is flashing blue, a previous print
job could be the problem.

1 At your computer, use the printer properties to
delete all print jobs in the print queue.

2 At the control panel, touch Jobs, then delete all
pending print jobs.

e Load the paper in the tray.
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PROBABLE CAUSES SOLUTIONS

e [f the Status LED does not flash once after you
send a print job, check the connection between the
printer and the computer. Power off the printer,
then power on.

The printer cable is disconnected. If the Status LED does not flash once after you send a
print job, check the connection between the printer
and the computer.

There is a wireless or network connectivity issue. To test the printer, print an Information Page, such as
the Configuration Report. If the page prints, there
could be a wireless or network connectivity issue.

Contact your system administrator or refer to the
System Administrator Guide at www.support.xerox.com.

Incorrect print driver. Check that you have the latest print driver installed. For
details, go to www.support.xerox.com.

PRINTING TAKES TOO LONG

PROBABLE CAUSES SOLUTIONS

The printer is set to print on a paper type that requires | Certain paper types, like heavyweight paper and

slower printing. transparencies, take more time to print. Ensure that the
print driver and control panel are set to the proper
paper type.

The printer is in Power Saver mode. Wait. It takes time for printing to start after the printer

exits Power Saver mode.

The way the printer was installed on the network could e Determineifa print Spoo[er ora Computer Shqring

be an issue. the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the speed of the printer, print multiple
copies of an information page, such as a demo
page. If the page prints at the rated speed of the
printer, there could be a network or printer
installation issue. For additional help, contact the
system administrator.

The job is complex. Wait. No action needed.
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DOCUMENT FAILS TO PRINT

PROBABLE CAUSES SOLUTIONS

Selected tray has wrong paper size loaded, or paper
type or color is not available.

To view the Job Status for a failed print on the touch

screen:

1 At the printer control panel, press the Home
button.

Touch Jobs.

3 From the jobs list, touch the held job name. The
resources required for the job appear on the control
panel.

4 Do one of the following:

e To print the job, replenish the resources
required. The job resumes automatically when
the required resources are available. If the job
does not print automatically, touch Resume.

e To choose an alternative paper source to enable
the job to print, touch Print On Alternate
Paper. Select a paper tray, then touch OK.

e To delete the print job, touch Delete. At the
prompt, touch Delete.

f Note: The Print On Alternate Paper option
is enabled using the Embedded Web
Server.

5 To return to the Home screen, press the Home
button.

Incorrect network settings.

To reset network settings, contact your system
administrator or refer to the System Administrator
Guide at www.support.xerox.com.

The way the printer was installed on the network could
be an issue.

e Ensure that the printer is connected to the network.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the printer, print an information page, such
as the Configuration Report. If the page prints,
there could be a network or printer installation
issue. For help, contact the system administrator.

Application and print driver have conflicting tray
selections.

For details, see Document Prints from Wrong Tray.
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DOCUMENT PRINTS FROM WRONG TRAY

PROBABLE CAUSES SOLUTIONS
Application and print driver have conflicting tray 1 Check the tray selected in the print driver.
selections. 2 Access the page setup or printer settings of the

application from which you are printing.

3 Set the paper source to match the tray selected in
the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver installed.
For details, go to www.support.xerox.com.

f Note: To have the print driver select the tray, set
the tray used as the paper source to Auto
Selection Enabled.

PRINTER IS MAKING UNUSUAL NOISES

PROBABLE CAUSES ‘ SOLUTIONS

One of the trays is not installed correctly. Open and close the tray from which you are printing.

There is an obstruction or debris inside the printer. Power off the printer and remove the obstruction or
debris. If you cannot remove the obstruction, contact
your Xerox® service representative.

The printer beeps at each touch on the control panel. Check the Alerts setting. For details, refer to the System
Administrator Guide at www.support.xerox.com.

AUTOMATIC 2-SIDED PRINTING PROBLEMS

PROBABLE CAUSES SOLUTIONS

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use
transparencies, envelopes, labels, or reloaded paper for
automatic 2-sided printing. For details, see Supported
Paper Sizes and Weights for Automatic 2-Sided
Printing.

Incorrect setting. On the print driver Printing Options tab, select 2-Sided
Print.
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DATE AND TIME ARE INCORRECT

PROBABLE CAUSES SOLUTIONS

The Date and Time Setup is set to Manual (NTP To change the Date and Time to Automatic, in the
Disabled). Embedded Web Server, enable NTP. For details, refer to
the System Administrator Guide at www.support.xerox.
com.

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details,
refer to the System Administrator Guide at www.
Support.xerox.com.

SCANNER ERRORS

PROBABLE CAUSES SOLUTIONS

Scanner is not communicating. Power off the printer, and check the scanner cable.
Wait two minutes and power on the printer again.

If the problem is not resolved, contact your Xerox®
service representative.
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Paper Jams

LOCATING PAPER JAMS

& Warning: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of paper is
wrapped around the inside of the fuser, do not try to remove it immediately. Power off the printer
immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled.
If the error persists, contact your Xerox representative.

® Caution: Do not attempt to clear any paper jams using tools or instruments. This can permanently
damage the printer.

The following illustration shows where paper jams can occur along the paper path:

—_

Door D

Tray 5

Doors A and B

Door C

Duplex Automatic Document Feeder
Document Output Tray

Finisher Areas

o N o v & W N

Paper Trays 1-4
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MINIMIZING PAPER JAMS

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can
cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path. To avoid
damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it
normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload
paper that has jammed.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver.

e Using damaged paper.

e Using unsupported paper.

e Loading paper incorrectly.

e Overfilling the tray.

e Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

e Use only supported paper. For details, refer to Supported Paper.

e Follow proper paper handling and loading techniques.

e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

e To separate the sheets before loading into the tray, fan the paper.
e Observe the paper tray fill line; never overfill the tray.

e Remove transparencies from the output tray immediately after printing.

e Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause
poor print quality, misfeeds, skewed prints, and printer damage.

e After loading the trays, select the correct paper type and size on the control panel.
e When printing, select the correct type and size in the print driver.

e Store paper in a dry location.

e Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

e Polyester coated paper that is designed especially for inkjet printers.

e Highly glossy or coated paper.

e Paper that is folded, wrinkled, or excessively curled.

e Fanning transparencies before loading in the paper tray.

e Loading more than one type, size, or weight of paper in a tray at the same time.

e Loading hole punched paper or paper with folded corners or staples in the document feeder.

e Overfilling the paper trays.
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¢ Allowing the output tray to overfill.

e Allowing the output tray to fill with more than a few transparencies.

CLEARING PAPER JAMS

To clear jams, watch the video and follow the instructions on the control panel. To resolve the error that appears on
the control panel, remove all paper from the areas shown. If the error does not clear, check the jam areas again to
ensure that all paper has been removed. Ensure that all levers, covers, and doors have been closed correctly.

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same
direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do
not reload paper that has jammed.

f Note: Do not touch the printed side of the paper when removing it. The printed side of jammed pages could
smudge, and the toner could stick to your hands. Avoid spilling any toner inside the printer.

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

Clearing Jams in the Document Feeder

1. Lift the release lever and open the top cover of the document feeder as shown.

2. If the original document is not caught in the entry to the document feeder, pull the document straight out in
the direction shown.
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3. If the message on the control panel instructs you to turn the green wheel, turn it in the direction shown.
Turning the green wheel moves the original document out of the feeder.

4. If the control panel message instructs you to open the inner cover, lift the lever with the green tab to open the
inner cover.

5. To move the original document out of the feeder, turn the green wheel in the direction shown. Carefully remove
the jammed document.

6. Close the inner cover, then close the top cover of the document feeder, pressing it down until it clicks into place.

7. If the original document is not visible when the document feeder top cover is opened, lift the document feeder
and remove the original document from the document glass.
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8. If the original document is not visible when the document feeder is opened, close the document feeder. Lift up
the document feeder tray, then remove the paper.

9. Lower the document feeder tray.

10. If the original document is not wrinkled or torn, load it into the feeder again, following the instructions on the
control panel.

f Note: After clearing a document feeder jam, reload the entire document, including the pages already
scanned. The printer automatically skips the scanned pages and scans the remaining pages.

® Caution: Torn, wrinkled, or folded originals can cause jams and damage the printer. To copy torn,
wrinkled, or folded originals, use the document glass.

Clearing Jams at Trays 1-4

1. Before you remove any tray from the printer, view the paper jam message on the control panel. Remove the
jam shown on the control panel, then remove other paper jams.

2. Pull out the tray until it stops.

3.
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4. If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of paper.
5. Reload the tray with undamaged paper, then push the tray in until it stops.
6. At the control panel, if a prompt appears, select the correct paper size, type, and color.

e To select a new paper size, touch Size.

e To select a new paper type, touch Type.

e To select a new paper color, touch Color.

e To confirm the settings, touch Confirm.

f Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.support.xerox.com.

7. Toreturn to the Home screen, press the Home button.

Clearing Jams at Tray 5 (Bypass Tray)

1. Remove the jammed paper from the tray. Make sure that the paper feed entrance where the tray connects to
the printer is clear.

2. If the paper is torn, check inside the printer for torn pieces of paper.
3. Fan the paper that you removed and make sure that all four corners are aligned.

4. Insert the paper into tray 5 with the printing side face down. The leading edge of the paper should lightly
touch the paper feed entrance.
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5. At the control panel, select the correct paper size, type, and color:

e To select a new paper size, touch Size.
e To select a new paper type, touch Type.
e To select a new paper color, touch Color.

6. To confirm the settings, touch Confirm.

Clearing Jams at Door A

1. Remove paper from the left tray, then close the tray.

3.
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4, Open Door A as shown.

£
%

& Warning: The area around the fuser can be hot. Use caution to avoid injury.

Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality.
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6. If paperis jammed in the fuser, to open the fuser exit gate, pull the green lever A1.

w2
f Note: If the paper is torn, remove all torn pieces from the printer.

8. If the paper is jammed at the bottom entry of the fuser, remove it as shown.

M=
e
; '.--',",'..;-J. | | IIII""%-._'.'-'- -
f-};"-»_l?/ 1 I -
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9. Return the green lever A1 to its locked position.

10. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

f Note: Toner can adhere to the transfer roller. The toner that does adhere to the transfer roller does not
affect print quality.

11.
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Clearing Jams at Door B

1. To open Door B, open Tray 5, then lift the release lever and open Door B.

w2
& Note: If the paper is torn, remove all torn pieces from the printer.

3. Close door B, then close Tray 5.

Clearing Jams at Door C

1. Pullthe release lever and open Door C.
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2. Remove the jammed paper from the Door C upper and lower areas.

.L/ e

fo Note:

e [f the paper is torn, remove all torn pieces from the printer.
e If the paper is inaccessible, see Clearing Jams at Door A.
3. For paper jammed in the paper tray, open the tray and remove the paper.

4. Close Door C.

Clearing Jams at Door D

1. Remove paper from the left tray, then close the tray.
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2. To open Door A, open Tray 5, lift the release lever, then open Door A.

& Warning: The area around the fuser can be hot. Use caution to avoid injury.

Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality.

3.
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4. Remove the jammed paper as shown.

f Note: If the paper is torn, remove all torn pieces from the printer.
5. Close Door D.

6. Close Door A, then close Tray 5.
TROUBLESHOOTING PAPER JAMS

Multiple Sheets Pulled Together

PROBABLE CAUSES SOLUTIONS

The paper tray is too full. Remove some of the paper. Do not load paper past fill
line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload it.

The paper is moist from humidity. Remove the paper from the tray, and replace it with

new dry paper.

Too much static electricity is present. e Try anew ream of paper.

e Do not fan transparencies before loading in tray.

Using unsupported paper. Use only Xerox approved paper. For details, refer to
Supported Paper.

Humidity is too high for coated paper. Feed paper one sheet at a time.

Jams in the Document Feeder

PROBABLE CAUSES SOLUTIONS

Unsupported paper of the wrong size, thickness, or Use only Xerox-approved paper. For details, see
type. Supported Paper.
Originals are torn, previously stapled, bent, or folded. Ensure that the originals are not torn, bent, or folded. If

previously stapled, remove all staples and separate the
sheets by fanning them.
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PROBABLE CAUSES SOLUTIONS

The documents loaded in the document feeder exceed
the maximum capacity allowed.

Place fewer documents in the document feeder.

Improperly adjusted document feeder guides.

Adjust the paper guides to fit snugly against the paper
loaded in the document feeder.

Paper Misfeeds and Paper Size Jams

PROBABLE CAUSES SOLUTIONS

The paper is not correctly positioned in the tray.

e Remove the misfed paper and reposition it properly
in the tray.

e Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the
fill line.

The paper guides are not correctly adjusted to the
paper size.

1 Remove the paper.

2 Adjust the paper guides in the tray to match the
size of the paper.

3 Replace the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still
misfeeds, do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type.

Use only Xerox approved paper. For details, refer to
Supported Paper.

Label and Envelope Misfeeds

PROBABLE CAUSES SOLUTIONS

The label sheet is facing the wrong way in the tray.

Load label sheets according to the instructions from
the manufacturer.

e Load labels face up in trays 1-4.
e Load labels face down in tray 5.

Envelopes are loaded in the wrong tray.

Use tray 5 to print envelopes.
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PROBABLE CAUSES SOLUTIONS

Envelopes are loaded incorrectly in tray5.

To load envelopes in tray 5:

e For envelopes with the flap on a long edge, load
envelopes with the flaps closed, flaps up, and flaps
on the leading edge, toward the right.

e For envelopes with the flap on a short edge, load
envelopes with the flaps closed, flaps up, and flaps
on the leading edge, toward the right.

e Load C4 and custom-size envelopes longer than
320 mm (12.6 in.) short-edge feed, with the flaps
closed, flaps up, and flaps on the leading edge,
toward the right. For custom-size envelopes, define
a custom size on the control panel.

Envelopes are loaded incorrectly in the envelope tray.

To load the envelope tray:

e For envelopes with the flap on a long edge, load
envelopes with the flaps closed, flaps down, and
the flaps on the left side of the tray.

e For envelopes with the flap on a short edge, load
envelopes with the flaps closed, flaps down, and
the flaps on the left side of the tray.

Paper Jam Message Stays On

PROBABLE CAUSES ‘ SOLUTIONS

Some paper remains jammed in the printer.

Recheck the media path and make sure that you have
removed all of the jammed paper.

One of the printer doors is open.

Check the doors on the printer. Close any door that is
open.

f Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

PROBABLE CAUSES SOLUTIONS

Using paper of the wrong size, thickness, or type.

Use paper of the correct size, thickness, or type. For
details, see Supported Paper Sizes and Weights for
Automatic 2-Sided Printing.

Paper type is set incorrectly in the print driver.

Ensure that the paper type is set correctly in the driver
and that the paper is loaded in the correct tray. For
details, see Supported Paper.
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PROBABLE CAUSES SOLUTIONS

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For
details, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

CLEARING FINISHER JAMS

Clearing Jams in the Integrated Office Finisher
1. Locate the Integrated Office Finisher under the scanner and control panel, then open the top cover as shown.
2. Rotate the green knob in the direction shown.

3. Toremove the paper, pull it in the direction shown.

‘&Q Note: If the paper is torn, remove all torn pieces from the printer.

4. Close the top cover of the Integrated Office Finisher.

Clearing Jams in the Office Finisher LX

Clearing Jams Under the Office Finisher Top Cover

1. Pull up the lever on the top cover.
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2. Open the top cover by rotating it to the left.

3. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.

4. Close the top cover of the finisher.

Clearing Jams in the Office Finisher LX Transport

1. Lift the handle of the center tray straight up to open the transport cover.
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2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the transport cover.

Clearing Jams in the Business Ready Finisher

Clearing Jams in the Center Tray

1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.
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Clearing Jams in the Finisher Transport

1. Open the finisher transport cover.

2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the finisher transport cover.

Clearing Jams at 3a in the Finisher

1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown.
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2. Open the front door of the Business Ready finisher.

3. Lift green handle 3a.

4. Carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.
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5. Return green handle 3a to its original position.

Clearing Jams at 3c in the Finisher

1. Open the front door of the Business Ready finisher.
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2. Move green lever 3c to the left.

3c

3. Carefully remove the paper.

j’ Note:

e If the paper is torn, remove all torn pieces from the finisher.

o If the paper is inaccessible, or if the control panel prompts you, to release the paper, turn green knob 3b
in the direction shown.

4. Return green lever 3c to its original position.
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5. Close the front door of the Business Ready finisher.

Clearing Jams at 3d in the Finisher

1. Open the front door of the finisher, then locate green lever 3d.
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3. Carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.

4. Return green lever 3d to its original position.
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Clearing Jams at 4 in the Finisher

1. Open the front door of the Business Ready finisher.

3. Toremove the jammed paper, turn green knob 4 in either direction as shown.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.
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4. Return unit 4 to its original position.

Clearing Jams in the Booklet Tray

1. Open the front door of the Business Ready finisher.
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2. To release the jammed paper, turn green knob 4 in the direction shown.

=
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3. Toremove the paper, pull it in the direction shown.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.
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Clearing Jams in the CZ Folder

Clearing Jams at 2a in the CZ Folder

1. Open the front door of the CZ folder.

2. Lift green handle 2a.

3. Carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces from the folder.

4
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4. Return green handle 2a to its original position.

1

Clearing Jams at 2b in the CZ Folder

1. Open the front door of the CZ folder.

=
—

St o S
o
L 0
]
1 I
T
3
)

),

284 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Troubleshooting

2. Move green lever 2b to the left.

3. Carefully remove the paper.

f Note: If the paper is torn, remove all torn pieces from the folder.
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5. Close the front door of the CZ folder.

Clearing Jams at 2e in the CZ Folder

1. To access lever 2e, open the front door of the CZ folder, then open the Folder tray 2d.

1
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3. Carefully remove the paper.

f Note: If the paper is torn, remove all torn pieces from the folder.

4.

e
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Clearing Jams at 2f in the CZ Folder

1. To access lever 2f, open the front door of the CZ folder, then open the Folder tray 2d.

3. Carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces from the folder.
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4. Return green lever 2f to its original position.

EE—
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Clearing Jams at 2g in the CZ Folder
1. Open the front door of the CZ folder.
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2. Move green lever 2g to the right.

3. Carefully remove the paper.

f Note: If the paper is torn, remove all torn pieces from the folder.
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5. Close the front door of the CZ folder.

Clearing Staple Jams

Clearing Staple Jams in the Integrated Office Finisher

1. Open the finisher front door.

b../

2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples and remove them.
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4. Pull the staple cartridge clamp firmly in the direction shown to open it.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

6. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler until it clicks.

N
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Clearing Staple Jams in the Office Finisher LX

& Warning: Do not perform this procedure while the printer is printing.

1. Open the front door of the Office Finisher.

2. Reach into the finisher cabinet and pull the stapler assembly toward you until it stops.

3. Push the stapler assembly to the right as shown.

5. Check inside the finisher for any loose staples and remove them.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide 293



Troubleshooting

6. Pull the staple cartridge clamp firmly in the direction shown to open it.

7. Remove the jammed staples by pulling them in the direction shown.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

10. Close the front door of the Office Finisher.
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Clearing Booklet Staple Jams in the Office Finisher LX

& Warning: Do not perform this procedure while the printer is printing.

1. Open the side cover of the Office Finisher.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide
them to the center.
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4. Remove the jammed staples by pulling them in the direction shown.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

5. Hold the tabs on both sides of the staple cartridge and insert it into the original position in the finisher.

f Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the
‘ cartridge.

fo Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple cartridges
contain staples.

6. Starting at Step 2, repeat the procedure for the other staple cartridge.

7. Close the side cover of the Office Finisher.

Clearing Main Staple Jams in the Business Ready Finisher

1. Open the front door of the Business Ready Finisher.
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2. Locate and hold the stapler assembly by the orange lever R1, then push it to the right.

3. Toremove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

H_Hx\:1 ._.-"Jtﬁf

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.
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6. To close the staple clamp, push the clamp in the direction shown until it snaps into the locked position.

clicks.

8. Return the staple cartridge assembly to its original position, then close the finisher door.

Clearing Staple Jams in the Business Ready Finisher Booklet Maker

1. Open the front door of the Business Ready finisher.
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2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on the top edge
of the device.

3. Toremove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as shown, then
pull the cartridge out and up.

)
—_— o

4. Turn over the staple cartridge.

5. To permit the staple cartridge handle to open out and away from the staple pack, press in the green tabs, then
pull back the handle.

fo Note: If you do not see the staple jam, remove the staple case.
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6. Toremove the staple case, press the rear of the case as shown.

C

fo Note: If you can see the staple jam, open the staple cartridge clamp.

7. To open to the staple cartridge, pull it firmly in the direction shown.

8. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the locked position.

9. Return the staple cartridge to the booklet maker, then return the booklet maker to its original position.

Clearing Hole Punch Jams

Clearing Hole Punch Jams in Office Finisher LX

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For details, refer
to Emptying the Hole Punch Waste Container.

After emptying the hole-punch waste container, locate and remove any paper jams.
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Print, Copy, and Scan Problems

IDENTIFYING PRINT, COPY, AND SCAN PROBLEMS

Problems with the output quality of your printer can be a print-related, copy-related, or scan-related problem. A
quick test can help you to identify where a problem lies.

To identify if a problem is print-related or scan-related, do the following:
1. Print the Getting Started guide.

a. At the printer control panel, press the Home button.

b. Touch Device, then touch Information Pages.

c. Touch Getting Started, then touch Print.

d. Toreturn to the Home screen, press the Home button.
2. Check the quality of the printed output.

3. If the print quality appears poor, the problem is print-related. Check for the symptom in the Solving Print
Quality Problems table.

4. If the print quality is good, the problem is likely to be scanner-related.
a. Copy the Getting Started guide that you have printed.
b. Check the quality of the copy output.

c.  For any symptom of poor print quality, refer to the Copy and Scan Problems table.

PRINT-QUALITY PROBLEMS

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.support.xerox.com.

(D Caution: The Xerox® Warranty and Service Agreement do not cover damage caused by the use of
unsupported paper or special media.

¢ Note:

e To ensure consistent print quality, the toner, print, and drum cartridges for many devices are designed to
cease functioning at a predetermined point.

e Grayscale images printed with the composite black setting increment the color pages counter, because
color consumables are used. Composite black is the default setting on most printers.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use
paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the
guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. For details, see Environmental Specifications.
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Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best
print quality and to avoid jams:

e Use only Xerox approved paper. For details, refer to Supported Paper.

e Use only dry, undamaged paper.

(D Caution: Some paper and other media types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

¢ Plastic media

e Iron-on transfer paper

e Ensure the paper type selected in your print driver matches the paper type on which you are printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the
print driver.

e Do not load more than one type, size, or weight of paper in the tray at a time.

e Store your paper and other media properly for optimum print quality. For details, refer to Paper Storage
Guidelines.

Print-Quality Modes

Select the correct print-quality setting for your print job from the print driver. For instructions on setting the print
quality, see Printing. To control the print quality:

e Use the print-quality settings in the print driver to control print quality. If the print quality is not suitable, adjust
the print-quality setting to an higher level.

e Use only Xerox approved paper. For details, refer to Supported Paper.

Color Corrections and Color Adjustments

For best printing results of mixed text, graphics, and images on a range of supported paper, set the Color Correction
to Xerox Automatic Color. For instructions on setting the Color Correction, refer to Image Options. Follow these
guidelines to control the Color Corrections and Color Adjustments:
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e For best results on most paper, ensure that the Color Correction in the print driver is set to Xerox Automatic
Color. This is the recommended setting.

¢ To produce more vivid results, select a mode of Color Correction. For example, when printing graphics in which
the sky does not look blue enough, for a more vibrant blue sky, select Vivid Color.

e To match the color output to another output device, select a custom Color Correction.

e To apply different Color Corrections to Text and Graphics and Images, select Custom Automatic Color. This
feature provides custom color corrections using color systems such as RGB Color, CMYK Color, Spot Color, or CIE
Color.

e To adjust particular characteristics of the printed color, such as Lightness, Contrast, Saturation, and Color Casts,
select Color Adjustments.

Solving Print-Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.support.xerox.com.

(D Caution: The Xerox® Warranty and Service Agreement do not cover damage caused by the use of
unsupported paper or special media.

j’ Note: To enhance the print quality, the toner cartridges, print cartridges, and drum cartridges for many
models are designed to cease functioning at a predetermined point.
Printing the Troubleshooting Print-Quality Pages
1. At the printer control panel, press the Home button.
Touch Device.

Touch Information Pages.

5 WeN

To print procedures on resolving print-quality problems, touch Troubleshooting Print Quality Page, then
touch Print.

5. Compare your print-quality problems to the examples on the pages.

Eliminating the Paper or Media as the Problem

Damaged or unsupported paper or media can cause print-quality problems even when the printer, application, and
print driver are working perfectly. Use the following guidelines to eliminate the paper as the source of the print-
quality problem:

e Make sure that the printer supports the paper or media.

e Macake sure that the printer is loaded with undamaged, dry paper.

e If the condition of the paper or media is in doubt, replace it with new paper or media.

» Make sure that you have the proper tray selected in the print driver and from the control panel.

e Make sure that you have the correct paper type selected in the print driver and in the control panel of the
printer.
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Isolating the Problem to the Printer or to the Application

When you are sure that the paper is supported and in good condition, use the following steps to isolate the
problem:

1.

From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see Printing the
Troubleshooting Print-Quality Pages.

e If the pages printed properly, the printer is working properly and the print-quality problem is an application,
print driver, or print server problem.

e If the pages still have print-quality problems, the problem is in the printer.

If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print
Server.

If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems in the
Printer .

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server

If the printer is printing properly from the control panel but you still have print-quality problems, the application,
print driver, or print server could be the cause.

To isolate the problem:

1.
2.

3.

4,

304

Print a similar document from another application and look for the same print-quality problems.

If the document has the same print-quality problem, it is probably a print driver or print server problem. Check
the print driver used for the print job.

a. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners. Scroll to
Related settings, then click Devices and printers.

j’ Note: If you are using a custom Start Menu application, it can change the navigation path to your list of

printers.
b. Right-click on the name of the printer.
c.  From the drop-down list, select Properties.
e Ensure that the model name in the middle of the driver matches the model name of the printer.
e If the names do not match, install the proper print driver for the printer.
If the print driver is correct, to set the Print Quality Mode and Color Correction, refer to Printing Features.
e Set the Print-Quality mode to Standard or Enhanced.
e Set the Color Correction to Xerox® Automatic Color.

If the problem persists, delete then reinstall the print driver.
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If the document printed without a print-quality problem, the application is probably the cause. Restart your
printer, restart the application, then print the document again. For more information, see Restarting, Placing in
Sleep Mode, or Powering Off the Printer.

If the problem still persists, ensure that you are not printing through a print server. If the problem persists, for
online support information, go to www.support.xerox.com.

Troubleshooting Print-Quality Problems in the Printer

If you have print-quality problems when printing a Demo Page or the Configuration Report from the control panel,
the problem is in the printer.

To find the source of the problem:

1.

At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the Troubleshooting
Print-Quality Pages.

If the prints are too light to see print details, verify the following:
e The printer is loaded with undamaged, dry supported paper.
e The toner levels of one or more of the toner cartridges is not too low.

If the pages are printed with a solid color, one or more of the drum cartridges could be defective. Correct the
problem before continuing.

If the colors of the pages do not match your expectations, run the control panel Print Calibration.

Compare the print-quality problems in your document to each of the examples in the Troubleshooting Print-
Quality Pages.

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the action to take to
resolve the problem.

If the problem persists, for online support information, go to www.support.xerox.com.

Performing the Print Calibration Procedure

1.

v &~ WN

At the printer control panel, press the Home button.

Touch Device.

Touch Tools.

Touch Troubleshooting > Calibration > Print Calibration > Next.

Follow the onscreen instructions to run the Print Calibration procedure.
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Print-Quality Problems and Solutions

Use the following table to find solutions to print-quality problems.

f Note: At the printer control panel, press the Home button. Touch Device > Information Pages >
Troubleshooting Print Quality Page > Print.

PROBLEM SOLUTION
Smears, Smudges, and Streaks Run a print job consisting of several blank pages
, through the printer to remove toner accumulated on
Dark or light marks appear on your output.
the fuser.
If the problem persists, print the test pages to help
) ik g
. determine which component is causing the image-
| quality problem.
‘ l: i e If the defect occurs in one color only, replace the
s corresponding imaging unit.

e [f the defect occurs in all colors and is visible on all
the test pages, replace the fuser.

Repeating Spots or Lines 1 To identify the part of the printer that is causing
the problem, print the Repeating Defects page. At
the control panel, press the Home button, then
touch Device > Tools > Troubleshooting >
Support Pages > Repeating Defects Page >
Print.

2 To identify the part responsible for the repeating
spots or lines, follow the instructions on the
Repeating Defects page.

Spot or lines appear at regular intervals on the prints.

3 To correct the problem, replace the printer part
identified on the Repeating Defects page.

Colors Look Wrong 1 Verify that the printer is on a solid, level, and flat

Colors are off or look drastically wrong. surface.

2 Perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device > Tools > Troubleshooting > Calibration
> Print Calibration > Next, then follow the

@ instructions.

Colors Too Light or Too Dark 1 Verify that the paper you are using is the correct
type for the printer and is loaded properly. For
details, see Supported Paper.

The print or color density is too light, missing, or the

background is foggy.
2 Verify that the paper loaded in the tray matches

the paper type selected at the control panel and in
the print driver.
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PROBLEM SOLUTION

3 To print procedures on resolving print-quality
problems, at the control panel, press the Home
button. Touch Device > Information Pages >
Troubleshooting Print Quality Page > Print.

If the Color Reference page looks correct, the
printer is printing properly. Your application or
incorrect settings in the print driver can be causing
the print-quality problems.

4 If the Color Reference page did not print correctly,
perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device > Tools > Troubleshooting > Calibration
> Print Calibration > Next, then follow the
instructions.

Vertical White Lines or Streaks - One Color

Lines or streaks appear in one color of your output.

Print the test pages to identify the affected color.

2 To clean the printhead lenses for the affected color,
pull out the cleaning rod until it stops, then move it
all the way in. Repeat three more times. Then
repeat this procedure for each affected color. For
details, see Cleaning the Printhead Lenses.

j’ Note: To print procedures on resolving print-
quality problems, at the control panel, press the
Home button, then touch Device >
Information Pages > Troubleshooting Print
Quality Page > Print.

Toner Missing or Easy to Rub Off

Toner appears to be missing from the print or is easy to
rub off.

1 Verify that the paper you are using is the correct
type for the printer and is loaded properly. For
details, see Supported Paper.

2 Perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device > Tools > Troubleshooting > Calibration
> Print Calibration > Next, then follow the
instructions.

3 At the control panel, select a heavier paper.

j’ Note: Papers from lightest to heaviest are:

e For uncoated paper: Plain, Lightweight
Cardstock, Cardstock, and Heavyweight
Cardstock

e For coated paper: Lightweight Glossy
Cardstock, Glossy Cardstock, and
Heavyweight Glossy Cardstock.
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COPY AND SCAN PROBLEMS

If the copy or scan quality is poor, refer to the following table.

SYMPTOMS SOLUTIONS

Lines or streaks only present in copies made from the
document feeder.

There is debris on the document glass. When scanning,
the paper from the document feeder passes over the
debris, creating lines or streaks. Clean all glass surfaces
with a lint-free cloth.

Spots present in copies taken from the document glass.

There is debris on the document glass. When scanning,
the debris creates a spot on the image. Clean all glass
surfaces with a lint-free cloth.

The reverse side of the original document is showing
on the copy or scan.

Turn on Background Suppression.

Image is too light or too dark.

Adjust the Lighten/Darken or Contrast settings.

Colors are inaccurate.

Copy: Adjust the Color Balance settings.

Scan: Confirm the correct Original Type is set.

If the problem persists, for online support information, go to www.support.xerox.com.
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Fax Problems

Troubleshooting

If your printer cannot send and receive faxes, ensure that the printer is connected to an approved analog telephone
line. The fax machine cannot send or receive faxes when it is connected directly to a digital telephone line without

the use of an analog filter.

f Note: If the fax connection is poor, transmit the fax at a lower rate. For the Starting Rate, select Forced

(4800 bps).

PROBLEMS SENDING FAXES

SYMPTOMS

The document is not feeding
properly through the document
feeder.

PROBABLE CAUSES

The document is too thick, too thin,

or too small.

SOLUTIONS

Use the document glass.

The document is scanned at an
angle.

The document feeder width guides
are not adjusted to fit the width of
the document.

Adjust the document feeder width
guides so that they fit against the
document.

The fax received by the recipient is
blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with one of the
fax machines.

Make a copy to verify that the
printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

If using the document feeder, place
the original document face up.

If using the document glass, place
the original document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax feature is not installed or is

Ensure that the fax feature is
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SYMPTOMS

PROBABLE CAUSES

not enabled.

SOLUTIONS

installed and enabled.

Server fax is enabled.

Ensure that server fax is disabled.

An access number is required to
connect to an outside line.

If the printer is connected to a PBX
system, it could be necessary to
enter a number to access the
outside telephone line.

The fax number needs a pause
between the prefix for an outside
line and the telephone number.

To insert a pause, touch the Dial
Pause button. A comma ()
appears in the corresponding
location.

If the problem persists, for online support information, go to www.support.xerox.com.

PROBLEMS RECEIVING FAXES

SYMPTOMS

The fax received by the recipient is
blank.

‘ PROBABLE CAUSES

There is a problem with the
telephone connection or with the
fax machine of the sender.

‘ SOLUTIONS

Verify that the printer can make
clean copies. If it can, have the
sender fax the document again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call but
does not print the fax.

The memory is full.

To increase available memory,
delete stored jobs and wait for the
existing jobs to complete.

The received fax size is reduced in
size.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents, then load the
appropriate paper size in the
printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to receive faxes
automatically.

The memory is full.

If the printer is out of paper, faxes
and print jobs can deplete the
printer of memory. Load paper and
print the jobs stored in the memory.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.
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SYMPTOMS PROBABLE CAUSES

There is a problem with the fax
machine of the sender.

Troubleshooting

SOLUTIONS

Make a copy to verify that the

printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.support.xerox.com.

PRINTING FAX REPORTS

You can print the following fax reports from the printer control panel:

Activity Report

Protocol Report

Fax Address Book Report
Options Report

Pending Jobs Report

To print a fax report:

1.

o N o &~ W N

At the printer control panel, press the Home button.

Touch Device.

Touch Tools.

Touch App Settings > Fax App.

Touch Print Fax Reports.

Touch the required report, then touch Print.

To return to the Device screen, touch X, then touch X again.

To return to the Home screen, press the Home button.

If the Print Fax Reports feature does not appear, contact your system administrator or refer to the System
Administrator Guide at www.support.xerox.com.
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Getting Help

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

VIEWING ERROR AND ALERT MESSAGES ON THE CONTROL PANEL

When an error or warning condition occurs, the printer alerts you of the problem. A message appears on the control
panel and the LED status light on the control panel flashes amber or red. Alerts inform you about printer conditions,
such as low supplies or open doors that require your attention. Error messages warn you about printer conditions
that prevent the printer from printing or degrade printing performance. If more than one condition occurs, only one
appears on the control panel.

To view a complete list of active error and alert messages:
1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Faults & Alerts, Alerts, or Faults.

To view details, touch a fault or alert.

To exit the Notifications screen, touch X.

N o v W N

To return to the Home screen, press the Home button.

VIEWING THE ERROR HISTORY ON THE CONTROL PANEL

When errors occur on the device, they are logged into an error history file by date, time, and associated fault code.
You can use this list to identify trends and resolve problems.

To view the error history:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Fault History.

To exit, touch X.

To exit the Notifications screen, touch X.

N o v &~ W N

To return to the Home screen, press the Home button.

THE EMBEDDED WEB SERVER

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:

312 Xerox® EC8036/EC8056 Color Multifunction Printer User Guide



Troubleshooting

e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ONLINE SUPPORT ASSISTANT

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your
printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and
more.

To access the Online Support Assistant, go to www.support.xerox.com.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

NAME DESCRIPTION

Configuration Report The Configuration Report provides printer information
including the serial number, installed options, network
settings, port setup, tray information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

MORE INFORMATION

You can obtain more information about your printer from these sources:
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RESOURCE LOCATION

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer WWW.SUPPOrt.xerox.com

Recommended Media List United States: https://www.xerox.com/downloads/usa/
en/supplies/rml/AltaLink_C8030_C8035_C8045_
C8055_RML.pdf

European Union: https://www.xerox.com/downloads/
europe/r/2017_05_AltaLinkC8030-C8055_Media_List_
Antalis_Xerox_May_2017.pdf

Technical support information for your printer, WWW.SUPPOrt.Xxerox.com
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.
Order supplies for your printer www.xerox.com/supplies
A resource for tools and information, including www.xerox.com/businessresourcecenter

interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual needs.

Local sales and Technical Customer Support www.xerox.com/worldcontacts
Printer registration www.xerox.com/register
Xerox® Direct online store www.direct.xerox.com/

Locating the Serial Number

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print the Configuration Report. You can view the
serial number on the control panel or on the Embedded Web Server home page. The serial number is printed on a
label that is affixed to the printer. To view the label, open the left side door.

For details on how to print the Configuration Report, refer to Information Pages.
To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch About.

The model, serial number, and software version is displayed.
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4, To return to the Home screen, press the Home button.
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Printer Configurations and Options

STANDARD FEATURES

The printer provides the following features:

Copy, Print, Email, Scan, Internet Fax, and Server Fax
Scan to USB and Print from USB mass storage devices
Scan to Mailbox, Scan to Network, Scan to Home, Single Touch Scan

Searchable PDF, Single or Multiple-Page PDF, XPS, or TIFF, Encrypted or Password-Protected PDF, and Linearized
PDF or PDF/A file formats

Copy speed of up to 55 ppm for color or black and white on A4 (210 x 297 mm) or Letter (8.5 x 11 in.) paper
1200 x 2400-dpi HiQ LED imaging and copying quality

Copy document sizes up to A3 (297 x 420 mm) or Tabloid (11 x 17 in.)

Print document size, with short-edge feed, up to SRA3 (320 x 450 mm) or 12 x 19 in.

Automatic 2-sided printing

Duplex Automatic Document Feeder

Color touch screen control panel

Trays 1-2 each with 520-sheet capacities

Tray 5 (Bypass Tray) with 100-sheet capacity

3-Tray Module (Trays 2—-4) each with 520-sheet capacities

High-Capacity Tandem Tray Module (Trays 3—4) with total 2000 A4 (210 x 297 mm) or Letter (8.5x 11 in.)
sheet capacity

2-GB memory plus 1-GB page memory

Internal 250-GB hard drive

Ethernet 10/100/1000Base-TX

High-Speed USB 2.0 direct print

Adobe® PostScript® and PCL® fonts and support

Xerox® Global Print Driver and Xerox® Pull Print Driver support

Automated supplies replenishment and management using Xerox® MeterAssistant®, Xerox® SuppliesAssistant®,
and Maintenance Assistant

Remote driver installation

Remote Control Panel and Configuration Cloning
Bonjour, SSDP, and SAP device discovery

Unified Address Book

Xerox® Standard Accounting

Encrypted Secure Print, Secure Fax, Secure Scan, Secure Email
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e McAfee data security

e HDD Overwrite, AES 256-bit Encryption that is FIPS 140-2 compliant, SHA-256 Hash Message Authentication
e Xerox® Extensible Interface Platform

e Xerox® Earth Smart Driver Settings

e Embedded Web Server

o Xerox® CentreWare® Web

e Email Alerts

e Support for mobile printing, mobile printing connectivity, and mobile apps
o Xerox® App Gallery supported

e Xerox® Copier Assistant

e NFC printing

e Support for Mopria

e Support for AirPrint

e Support for Google Cloud Print™

OPTIONS AND UPGRADES

e Integrated Office Finisher

o Office Finisher LX

¢ Booklet Maker for Office Finisher LX

e Hole Punch for Office Finisher LX

e Business Ready Finisher with 2/3 or 2/4 hole punch

e Business Ready Booklet Maker Finisher with 2/3 or 2/4 hole punch
e (CZfolder for Business Ready Finisher or Business Booklet Maker Finisher
e Swedish Hole Punch

e Envelope tray

e High-Capacity Feeder (Tray 6) with 2000-sheet capacity

e Convenience stapler and work surface

e One-Line and Dual-Line Fax Kits

e Fax forward to Email or SMB

o EFI" Fiery® Network Server

e Embedded PDL support for XPS

e Xerox Secure Access Unified ID System

e Xerox® Common Access Card Enablement Kit

o Xerox® Network Accounting Enablement
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e Wireless Network Adapter

e Wi-Fi Direct with optional Wireless Network Adapter

e Foreign Device Interface

e McAfee Integrity Control Enablement Kit and McAfee enhanced security features

e XPS Print Option Kit

e Smart Card Enablement Kit

o Xerox® Integrated RFID Card Reader E1.0

e Unicode print

e Xerox® Scan to PC Desktop® Professional

FINISHING OPTIONS

FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
Left Tray 100 sheets All supported sizes All supported NA
weights
Stacking Tray 250 sheets All supported sizes All supported NA
weights

Integrated Office Stacking: 500 sheets | 89 x 98 mm to A3 60-256 g/m? Single stapling: 50
Finisher A4, 85x 11 in.or 79%83in.t0 11 sheets A4, 85x 11

250 sheets A3, 11 x 1‘7 _X = Into X in. or 30 sheets of

17 in. in. 80 g/m? Legal, B4,

A3,11x17in.

Office Finisher LX Stacking: 2000 182 x 210 mm to 60-256 g/m? Multiple-position

sheets unstapled, A3 stapling: 50 sheets

1000 sheets single-

seets singie 35x39in.to 11 x Hole Punch:
stapled, or 250 ) )
sheets dual-stapled 17 in. Optional 2-3 or 2-4
P Hole Punch

Office Finisher LX Stacking: 2000 182 x 210 mm to 60-256 g/m? Multiple-position
with Booklet Maker | sheets unstapled, A3 stapling: 50 sheets

1000 sheets single-
stapled, or 250
sheets dual-stapled

35x39in.to 11 x
17 in.

Booklet Tray: 40
booklets, 2-15
sheets per booklet

A4 SEF (Short-Edge
Feed), Letter SEF, B4
SEF, Legal SEF, A3

SEF, 11 x 17 in. SEF

Hole Punch:
Optional 2-3 or 2-4
Hole Punch

Saddle-stapling: 2—
15 sheets of 60-90
g/m?

Score/Crease: 1-15
sheets unstapled
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FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
Business Ready Top Tray: 500 sheets | Stacking: A6—A3 60-300 g/m? Single-position and
Finisher . 4.25x5.85in.to 11 multiple-position
Stacking: 3000 x 17 in. stapling: 50 sheets
sheets unstapled,
200 sets single- Stapling: B5-A3 Hole Punch:
position stapled or | 5c . 105N to 11 Optional 2-3, 2-4,
100 sets multiple- x.1 7in T or Swedish 4-Hole
position stapled ’ Punch
sheets, dual-stapled
Business Ready Offset Catch Tray: Stacking: A6-A3 60-300 g/m? Single-position and
Finisher with Booklet | 500 sheet: ltiple-positi
Stacking: 1500 x 17 in. ping:
sheets unstapled, o Hole Punch:
200 sets single- Stapling: B>-A3 Optional 2-3, 2-4,
position, dual, or 4- | 7.25x 10.5in.to 11 or Swedish 4-Hole
position stapled or x 17 in. Punch
100 stapled sets A3
or 11 x17in.
CZ Fold Unit 40 sheets C-Fold, Z-Fold: A4, 64-90 g/m? C-Fold, Z-Fold, and
Letter SEF Z-Half Fold
Z-Half Fold: A3, 11 x
17in
Convenience Stapler | NA Any supported size | Any supported 50 sheets
weight

‘&Q Note: Sheet quantities for tray capacities and finishing options are based on 80 g/m? Quantities are
reduced for heavier media and must be within the specified weight range.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide

321



Specifications

Physical Specifications

BASE CONFIGURATION

e Width: 640 mm (25.2 in.)

e Depth: 732 mm (28.8 in.)

e Height: 1149 mm (45.2 in.)
e Weight: 151.9 Kg (334.8 Ib.)

CONFIGURATION WITH INTEGRATED OFFICE FINISHER
e Width: 705 mm (27.8 in.)

e Depth: 732 mm (28.8in.)

e Height: 1149 mm (45.2 in.)

e  Weight: 158 Kg (348.3 Ib.)

CONFIGURATION WITH OFFICE FINISHER LX AND BOOKLET MAKER
e Width: 1242 mm (48.8 in.)

e Depth: 732 mm (28.8 in.)

e Height: 1149 mm (45.2 in.)

e  Weight: 183 Kg (403.4 Ib.)

CONFIGURATION WITH BUSINESS READY FINISHER
e Width: 1302 mm (51.3 in.)

e Depth: 732 mm (28.8 in.)

e Height: 1149 mm (45.2in.)

e Weight: 195.6 Kg (430.4 |b.)

CONFIGURATION WITH BUSINESS READY FINISHER AND BOOKLET MAKER
e Width: 1431.4 mm (56.4in.)

e Depth: 732 mm (28.8 in.)

e Height: 1149 mm (45.2in.)

e Weight: 212.3 Kg (467.1 Ib.)

CONFIGURATION WITH BUSINESS READY FINISHER, BOOKLET MAKER, AND CZ FOLDER
e Width: 1664.2 mm (65.5in.)
e Depth: 732 mm (28.8 in.)
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e Height: 1149 mm (45.2 in.)
e Weight: 264.4 Kg (581.7 |b.)

Specifications

CONFIGURATION WITH BUSINESS READY FINISHER, BOOKLET MAKER, CZ FOLDER, AND HIGH-

CAPACITY FEEDER

e Width: 1978.2 mm (77.9in.)
e Depth: 732 mm (28.8 in.)

e Height: 1149 mm (45.2in.)

e Weight: 297.5 Kg (654.5 |b.)

CLEARANCE REQUIREMENTS

Clearance Requirements for Base Configuration

100 cm

1981 cm (39in)
(780in) \77
2067 cm

(81.4in)

742 cm \,/

(29.2in) 307 cm

1614 cm (121in)
(635in)
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Clearance Requirements for Configuration with Office Finisher LX and Booklet Maker

5cm
(2in)

Y\
-
(=1
3

) / 656 cm
\ (25.8in.)
(39in)

2013 cm

206.7 cm (793 in)

(814 in) 742 cm

Clearance Requirements for Configuration with Business Ready Finisher and Booklet Maker

/

=
&
— (=1
1981 cm 8 = Bgem
(780in) "7
2067 cm
(814in)
742 cm \z
(29.2in) 1045 cm
(412in)
2352 cm
(926in)
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Clearance Requirements for Configuration with Business Ready Finisher, Booklet Maker, and CZ Folder

/

-3
&
— (=]
1981 cm Z e
(780in) "7
206.7 cm
(81.4in)
742 ecm
(29.2in) 233cm
(9.1in) 1045 an
2585 cm (412in)
(101.8in)

Clearance Requirements for Configuration with Business Ready Finisher, Booklet Maker, CZ Folder, and

High-Capacity Feeder

/

&
— (=)
100cm
1981 cm = ;
(78.0in) — E‘gljn)r
2067 cm
(81.4in)
74.2 cm \Z
(23.2in) 1045 cm
2585 cm (41.2in)
(1018in)
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Environmental Specifications

TEMPERATURE

Operating: 10-28°C (50-83°F)

RELATIVE HUMIDITY

Operating: 15% to 85% (non-condensing)

ELEVATION

For optimum performance, use the printer at elevations below 2500m (8200ft.).
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Electrical Specifications

POWER SUPPLY VOLTAGE FREQUENCY CURRENT REQUIRED
110-127 VAC +/-10% 50 Hz +/- 3 Hz 15A
60 Hz +/- 3 Hz
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Performance Specifications

PRINTING RESOLUTION

Maximum Resolution: 1200 x 1200 dpi

PRINT SPEED

Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x 11.69 in.) or Letter
(216 x 279 mm, 8.5 x 11 in.) Bond 60-105 g/m? (18-28 I|b.) paper from any tray except for tray 5.

Several factors affect print speed:

e Paper orientation: For faster print speeds, you can load paper long-edge feed.

e Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.

e Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.

e Paper type: Plain prints faster than Glossy.

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge feed.

The slowest print speed is approximately 13 ppm when you print from tray 5 using large size, Heavyweight Glossy
Cardstock.
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Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact in
the United States and Canada: 1-800-ASK-XEROX (1-800-275-9376).

For product safety information in the United States and Canada, go to www.xerox.com/about-xerox/environment/

enus.html.
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to
mitigate interference caused or received by this printer in a typical office environment.

UNITED STATES FCC REGULATIONS

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate
this equipment.

j’ Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

EUROPEAN UNION LOT 19 ON LIGHT SOURCES

According to the European Commission Ecodesign Directive, the light source contained within this product or its
components is intended to be used for Image Capture or Image Projection only, and is not intended for use in
other applications.

ENVIRONMENTAL BENEFITS OF DUPLEX PRINTING

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the
setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided
printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the
environmental impact of your work. However, should you require simplex/1-sided printing, you may change the
print settings in the print driver.
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PAPER TYPES

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m?), which contains
less raw material and thus saves resources per print, may be used in certain applications. We encourage you to
check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to reduce environmental impact. Details
on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the
following website: www.energystar.gov.

ENERGY STAR

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States,
European Union, and Japanese governments and the office equipment industry to
promote energy-efficient copiers, printers, fax, multifunction printers, personal computers,
and monitors. Reducing product energy consumption helps combat smog, acid rain, and
long-term changes to the climate by decreasing the emissions that result from generating
electricity.

POWER CONSUMPTION AND ACTIVATION TIME

The amount of electricity that a device consumes depends on the way the device is used. This device is designed
and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device
transitions to Ready mode. In this mode, the device can print again immediately. If the device is not used for a
specified period, the device transitions to Sleep mode. In these modes, to enable reduced-power consumption, only
essential functions remain active. The device takes longer to produce the first print after it exits the Power Saver
modes than it takes to print in Ready mode. This delay is the result of the system waking up and is typical of most
imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, you can
configure the mode as follows:

e Always Allowed: The device powers off automatically after the specified time and the Sleep mode timeout has
elapsed.

¢ Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts have
elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have not been
activated.

To change the Power Saver settings, refer to the User Guide. For further assistance, contact your System
Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator
Guide.
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To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/about-xerox/
environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.

f Note: Changing the default Power Saver activation times can result in an overall higher energy consumption
of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in
device power consumption.

DEFAULT POWER SAVER SETTINGS

This device is ENERGY STAR ®-qualified under the ENERGY STAR Program Requirements for Imaging Equipment.
The transition time from Ready mode to Sleep mode can be set up to 30 minutes. The default value is O minutes.

To change the Power Saver settings, refer to the User Guide. For further assistance, contact your System
Administrator, or refer to the System Administrator Guide.

REGULATORY INFORMATION FOR 2.4 GHZ WIRELESS NETWORK ADAPTER

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the requirements
specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user's
authority to operate this equipment.

OZONE RELEASE

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume.
Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-
ventilated room.

For more information in the United States and Canada, go to www.xerox.com/about-xerox/environment/enus.html.
In other markets, please contact your local Xerox representative or go to www.xerox.co.uk/about-xerox/
environment/engb.html.
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Copy Regulations

UNITED STATES

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties
of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
e Certificates of Indebtedness.
¢ National Bank Currency.
e Coupons from Bonds.
o Federal Reserve Bank Notes.
o Silver Certificates.
e (Gold Certificates.
e United States Bonds.
e Treasury Notes.
e Federal Reserve Notes.
e Fractional Notes.
e Certificates of Deposit.
e Paper Money.
e Bonds and Obligations of certain agencies of the government, such as FHA and so on.

e Bonds. United States Savings Bonds may be photographed only for publicity purposes in connection with
the campaign for the sale of such bonds.

e Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled
revenue stamp, this may be done provided the reproduction of the document is performed for lawful
purposes.

e Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed,
provided the reproduction is in black and white and is less than 75 % or more than 150 % of the linear
dimensions of the original.

e Postal Money Orders.
e Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

e Stamps and other representatives of value, of whatever denomination, which have been or may be issued
under any Act of Congress.

e Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls
within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these
provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for
Circular R21.
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Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.
Passports. Foreign Passports may be photographed.
Immigration papers.

Draft Registration Cards.

© N o b

Selective Service Induction papers that bear any of the following Registrant’s information:
e Earnings or Income.

e Court Record.

e Physical or mental condition.

e Dependency Status.

e Previous military service.

e Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various
Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the head of such
department or bureau).

Reproducing the following is also prohibited in certain states:
e Automobile Licenses.

e Drivers’ Licenses.

e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt,
consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress, Washington, D.C.
20559. Ask for Circular R21.

CANADA

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances.
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

e Current bank notes or current paper money
e Obligations or securities of a government or bank
e Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of
law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to
purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)

e Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province,
the government of a state other than Canada or a department, board, Commission, or agency established by
the Government of Canada or of a province or of a government of a state other than Canada
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Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province
or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing certified
copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its
completeness or accuracy. In case of doubt, consult your solicitor.

OTHER COUNTRIES

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on
those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner

Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact
your legal counsel.
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Fax Regulations
UNITED STATES

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device, including a fax machine, to send any message unless such message clearly contains in a margin
at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent
and an identification of the business or other entity, or other individual sending the message and the telephone
number of the sending machine or such business, other entity, or individual. The telephone number provided may
not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System Administrator
Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information,
a product identifier in the format US:AAAEQ#H#TXXXX. If requested, this number must be provided to the Telephone
Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with
the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular
plug is provided with this product. It connects to a compatible modular jack that is also compliant. See installation
instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the compliant
telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a
telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices
that can be connected to a line, as determined by the RENSs, contact the local Telephone Company. For products
approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products,
the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in the
following list:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

(D Caution: Ask your local Telephone Company for the modular jack type installed on your line. Connecting
this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox,
assume all responsibility and/or liability for any damage caused by the connection of this machine to an
unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily
discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone
Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service,
they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the
operation of the equipment. If the Telephone Company changes something that affects the operation of the
equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted
service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or
warranty information. Contact information is contained in the Device app on the printer and in the back of the
Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the
Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make repairs to the
printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the
remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact
the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the
installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified
installer.

CANADA
This product meets the applicable Innovation, Science and Economic Development Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations
made by the user to this device, or device malfunctions, could cause the telecommunications company to request
you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power
utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This
precaution could be vital in rural areas.

(D Caution: Do not attempt to make such connections yourself. Contact the appropriate electric inspection
authority, or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be connected to a
telephone interface. The termination of an interface may consist of any combination of devices subject only to the
requirement that the sum of the RENs of all the devices not exceed five. For the Canadian REN value, please refer to
the label on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.
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Safety Certification

This device is certified by the following agencies using the following safety standards.

AGENCY STANDARD

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to North America: www.xerox.com/safety-data.

For the Customer Support Center phone numbers, go to www.xerox.com/worldcontacts.
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This appendix contains:

Al COUNLTIES. . et 344
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OO COUNLTIES ..ottt et e et e e e 347
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury,
perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The
presence of these materials is fully consistent with global regulations applicable at the time that the product was
placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material:
This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may
apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-
XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental
programs, visit www.xerox.com/about-xerox/environment, or for recycling and disposal information, contact your
local authorities.
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Recycling and Disposal

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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This appendix contains:

| DESCRIPTION

Warning:

(%)
=<
<
v
©)
=

Indicates a hazard that can result in serious injury or death if not avoided.

Hot Surface:

Hot surface on or in the printer. To avoid personal injury, use caution.

Warning:

Moving parts. To avoid personal injury, use caution.

Caution:

Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer.

Do not touch this part of the printer.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the item.

Do not burn the toner cartridges.

Do not burn the drum cartridges.

Do not burn the toner waste cartridge.

DD HRIGOPPP
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SYMBOL DESCRIPTION

Pinch Hazard:

To avoid personal injury, use caution in this area.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Do not remove the paper forcefully.

Hot Surface:

Before handling, wait for the time indicated.

On

Off

Standby

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not reload paper that is used or printed previously.

Do not use postcards.

@R O
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SYMBOL DESCRIPTION

@ Do not use envelopes.
Do not copy money.
5-@

"«l' Add paper or media.

=]
0 Paper jam
o
9 Lock
a Unlock
mj Paper clip
ﬁ Cooling
. D Elapsed time
’

Supply paper

1-Sided original document

Y |l

Hole-punched paper

Transparency

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide 351



Product Symbols

SYMBOL DESCRIPTION

Load letterhead face up.

Load letterhead face down.

Load labels face down.

USB:

Universal Serial Bus

LAN:

Local Area Network

Telephone Line

Weight

Home button

This item can be recycled.

P& e T
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This appendix contains:
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Apps Features

SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

Output Color Use Output Color to control the | e . . o .
color rendering of the output
image or print.

2-Sided Copying You can use the 2-Sided options | e . . . . .
and 2-Sided to set the device to scan one or
Scanning both sides of an original

document. For Copy jobs, you
can specify 1-Sided or 2-Sided

output.
— Paper Supply Use Paper Supply to specify the | .
— size, type and color of the paper

required, or the Paper Tray to
use. If Auto is selected, the
printer chooses the paper tray
based on the original document
size and the selected settings.

Collation You can collate multiple-page .
copy jobs automatically. For
example, when making three
1-Sided copies of a six-page
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

document, the copies are
printed in this order:

1,2,3,4,56;1,2,3,4,5,6; 1,
2,3,4,5,6.

Finishing If finishing options are available, | o
use this option to choose the

finishing options required for
your printed output.

7 Reduce / Enlarge You can reduce the image toas | e 3
little as 25 % of its original size

or enlarge it as much as 400 %.
Use Proportional % to maintain
original proportions when
resizing, or use Independent %
to adjust the width and length
of the image by different
percentages.

Original Type The printer optimizes the image | o . . . . . .
quality of the copies based on
the type of images in the
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

original document and how the
original was created.

to adjust the variation between
light and dark areas of the
image.

@ Contrast You can use the Contrast feature | e . . . . .

Lighten / Darken Use the Lighten/Darken slider to | e . . . . o .
make the output image or print
lighter or darker.

Sharpness Use this option to sharpen the . . . . .
output image or print. For best
results, sharpen text images and
soften photos.

Saturation Saturation allows you to adjust | e . . .
the color strength and the

amount of gray in the color.

f Note: This feature is not
available when Output
Color is set to Black and
White or Grayscale.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

copy using preset color effects.
For example, you can adjust
colors to be brighter or cooler.

m Color Presets You can adjust the color of the .

Color Balance If you have a color original .
” -I- image, you can adjust the
balance of the printing colors
between cyan, magenta, yellow,
and black before printing your

copy.

Original You can use the Original . . . . .
Orientation Orientation option to specify the
layout of the original images
that you scan. The printer uses
the information to determine if

images require rotation to
produce the desired output.

Image Shift Image Shift allows you to .
modify the location of the
image on the page. You can
shift the printed image along
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

the X and Y axes of each sheet

of paper.
Auto Background Use the Auto Background . . . o . o .
Suppression Suppression setting to reduce

the sensitivity of the printer to
variations in light background
colors.

Edge Erase You can erase content fromthe | e . .
edges of your images using the
Edge Erase feature. You can
specify the amount to erase on
the right, left, top, and bottom
edges.

Original Size To ensure that you are scanning | e . . . o .
the correct area of the
documents, specify the original
document size.

L

Book Copying You can use the Book Copying .
feature to copy books,
magazines, or other bound
documents.

B
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COPY
Mirror Image Use Mirror Image to reverse the | o
image and text on the page.
Negative Image Negative Image reverses the .
light and dark areas in your

document, and print it as
though it were a photo negative.
Printing a negative image is
useful for documents that have
a substantial amount of dark
background or light text and

images.
E‘ Special Pages Special Pages is used to add .
m covers and inserts to your job.

You can specify exception pages
to print on different paper than
the main body of the job. You
can also program Chapter start
pages.

Annotations You can add Annotations, such .
as page numbers and the date,

to your copies.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

prints two pages on each side of
the paper. The pages are
reordered so that they are in
numerical order when folded.

1] 2 Page Layout You can print the selected .
EH number of pages on one side of
a sheet of paper. Selecting
multiple pages per sheet saves
paper and provides a way to

review the layout of a
document.

m Booklet Creation The Booklet Creation feature .

r Sample Job Sample Job allows you to printa | e
Fo test copy of a job to inspect

before printing multiple copies.
This feature is useful for
complex or high-volume jobs.
After you print and inspect the
test copy, you can choose to
print or cancel the remaining
copies.

Xerox® EC8036/EC8056 Color Multifunction Printer User Guide

360



9PIND 185 131Ul UOIDUNIINIA J0]0D 9G08D3/9E08DT §X0IOX

L9€

SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY
Transparency Use Transparency Separators to | e
Separators add blank sheets of paper

between each printed
transparency. The size and
orientation of the separators
must be the same as the
transparencies.

Build Job Use Build Job for jobs that . . . . . .
x include a variety of original

documents requiring different
settings, or for scanning
multiple-page jobs from the
document glass. The job is
scanned in segments. After all
the segments are scanned, the
job is processed and completed.

[E Save Current To use a particular combination | e

Settings of copy settings for future copy
jobs, you can save the settings
with a name and retrieve them
for later use.
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FEATURE

Retrieve Current

DESCRIPTION

You can retrieve and use any

m Settings previously saved copy settings
for current jobs.

Quantity Use this option to enter the
number of required ID card
copies.

Resolution Resolution determines how fine

or grainy graphic images
appear. Image resolution is
measured in dots per inch (dpi).

Remove Blank
Pages

Remove Blank Pages configures
the printer to ignore blank
pages.

K Ed

From

Use the From option to specify
the originator of the email.

f Note: The system
administrator can preset
this option to populate
automatically with your
user account details.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

Reply To Use the Reply To option to . .
include an email address you
want the recipient to reply to.
This option is useful if you want
the recipient to reply to your
email address rather than to the
device.

P
& Note: The system
administrator can preset

this option.
Message Use Message to enter . .
information to accompany the
email.
o Quality / File Size The Quality/File Size option lets . . .
A you choose from three settings

that balance the quality of the
image and the size of the file.
Higher quality images result in
larger file sizes, which are not
ideal for sharing and
transmitting over the network.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

File Format Use the File Format option to . . .
"'ﬂ specify the format of the saved

image or to define a searchable
image. You can add a password
to protect the image or choose
to combine multiple images into

a single file.
If File Already Use the If File Already Exists .
Exists option to define what action the

device takes when the file name
is used already.

File and Use the File and Attachment . . .
n Attachment option to specify a name for the
file containing the scanned
images.
E Acknowledgement | You can request to print a report .
Report to confirm that each recipient

has received the scanned file.
The report contains delivery
status information.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

f Note: The report
depends on recipient
response time.

Update Workflows | Use Update Workflows to .
c refresh the list of workflows

displayed at the control panel.

Add File Use this option to choose more .
Destinations destinations for filing the
scanned images.

Book Faxing You can use the Book Faxing .
feature to scan images from
books, magazines, or other

bound documents for faxing.

B

Reduce / Split Use the Reduce/Split option to .
specify how your faxed
document is printed on the
receiving fax machine. If the
image is too large to fit on the
paper size, you can reduce the

A
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

image to fit or split across
multiple pages.

Confirmation You can request a report to .
Report confirm if your fax has been
received. To receive a
Confirmation Report only if an

error occurred during
transmission, choose Print on

Error Only.
@ Starting Rate Select the highest starting rate .
3 for transmitting the fax, unless

the destination for the fax you
are sending has special
requirements. Forced (4800 bps)
is the recommended setting for
lines that may have transmission
interference.

Cover Sheet You can use the Cover Sheet .
option to add an introduction
page to the beginning of your
fax. You can add a short
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

comment to the cover sheet,
and To and From details.

Send Header Text | It is unlawful to send a message .
from a fax machine without the
proper Transmission Header
Text. Ensure that the name and
telephone number of the
sender, and the date and time
of the transmission are included
on all faxes.

Delay Send You can set a time in the future . .
(4 ) .
- for the printer to send your fax
job. You can delay the sending
of your fax job for up to 24
hours.
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SERVER | INTER- ID CARD
FEATURE DESCRIPTION FAX NET FAX COoPY

Polling Fax Polling allows you to store a .
((.)) fax document on the printer and
make it available for other fax
machines to poll. You can
retrieve faxes stored on other
fax machines. To use this
feature, both the polling printer
and the remote printer must
have the Polling feature.

D Mailboxes Use the Fax Mailboxes option to .
——— stor.e faxes that have been
retrieved from a remote fax
machine, or to store faxes for
retrieval by a remote fax
machine. The mailbox number is
required to access a mailbox.
You can set a passcode to secure
confidential documents.
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